SIEMENS

SIMATIC

Windows Logic Controller
WinLC RTX
Overview

User Manual

Edition 11/2000
A5E00083518-01

Preface, Contents

Product Overview

Setting Up the WIinLC RTX
Software

Connecting SIMATIC Client
Software to WinLC RTX

Running the WIinLC RTX
Software

Operations of WinLC RTX

Configuring the PROFIBUS-DP
Network

Appendices

System Status List (SZL)

Instruction List

Panel Control

Index

()RR G RER SRR GO RN\

>



Safety Guidelines

This manual contains notices which you should observe to ensure your own personal safety, as well as to
protect the product and connected equipment. These notices are highlighted in the manual by a warning

triangle and are marked as follows according to the level of danger:

Danger

indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.
Warning

indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.
Caution

used with the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may

result in minor or moderate injury.

Caution

used without the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may

result in property damage.

Notice

NOTICE used without the safety alert symbol indicates a potential situation which, if not avoided, may

result in an undesirable result or state.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are
defined as persons who are authorized to commission, to ground, and to tag circuits, equipment, and
systems in accordance with established safety practices and standards.

Correct Usage
Note the following:

Warning

This device and its components may only be used for the applications described in the catalog or the
technical descriptions, and only in connection with devices or components from other manufacturers
which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed cor-
rectly, and operated and maintained as recommended.

Trademarks

SIMATICO, SIMATIC HMIO and SIMATIC NETO are registered trademarks of SIEMENS AG.

Some of other designations used in these documents are also registered trademarks; the owner’s rights
may be violated if they are used by third parties for their own purposes.

Copyright © Siemens AG 2000 Al rights reserved

The reproduction, transmission or use of this document or its
contents is not permitted without express written authority.
Offenders will be liable for damages. All rights, including rights
created by patent grant or registration of a utility model or design, are
reserved.
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Disclaimer of Liability
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improvementare welcomed.
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Preface

The Windows Logic Controller (WinLC RTX) provides the functionality of a
programmable logic controller (PLC) in a real-time, PC-based environment.
WinLC RTX uses the VenturCom Real-time extensions (RTX) to Windows NT and
is fully compatible with the SIMATIC product family. You can use any of the
SIMATIC products, such as the Windows Control Center (WinCC), with WinLC

RTX.

WiInLC RTX communicates over PROFIBUSDP to control the distributed 1/0, such
as ET 200M. WinLC RTX can communicate to STEP 7 or other programming
software on another computer over PROFIBUSDP, Ethernet, or MPI networks.

Audience

This manual is intended for engineers, programmers, and maintenance personnel
who have a general knowledge of PLCs.

Scope of the Manual

This manual describes the features and the operation of WinLC RTX.

Other Manuals

You can find information in the online help for STEP 7 and for WinLC RTX. For
more information, refer to the following manuals:

Title

Content

System Software for
S7-300 and S7-400
Program Design
Programming Manual

S7-300 and S7-400
System and Standard
Functions Reference
Manual

This manual provides basic information on the structure of the
operating system and of a user program of the WinLC RTX. Use
this manual when creating a user program with the STEP 7
automation software.

WinLC RTX includes integrated system functions and
organization blocks, which you can use when programming. This
manual provides you with descriptions of the system functions,
organization blocks, and loadable standard functions.

Windows Logic Controller WinLC RTX Overview
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Title

Content

STEP 7 User Manual

SIMATIC NET
PROFIBUS User
Manual

This manual explains the main usage and the functions of the
STEP 7 automation software. This manual provides you with an
overview of the procedures used to configure and program the
WinLC.

This manual provides information about PROFIBUSDP
communications and setting up PROFIBUS networks.

Additional Assistance

If you have any questions not answered in this or one of the other STEP 7
manuals, if you need information on ordering additional documentation or
equipment, or if you need information on training, please contact your Siemens
distributor or sales office.

To contact Customer Service for Siemens in North America:

» Telephone:

e E-mail:

* Internet:

(609) 7346500
(609) 7343530

ISBU.Hotline@sea.siemens.com

simatic.hotline@sea.siemens.com

— http://www.aut.sea.siemens.com/winac/

— http://www.aut.sea.siemens.com/simatic/support/index.htm

— http://iwvww.ad.siemens.de/support/html_76/index.shtml

To contact Customer Service for Siemens in Europe:

» Telephone: ++49 (0) 911 895 7000

+ Fax ++49 (0) 911 895 7001
e E-mail: simatic.support@nbgm.siemens.de
* Internet: http://www.ad.siemens.de/simaticcs

For information about VenturCom Real-Time extensions (RTX):

* Internet: http://www.vcc.com

Windows Logic Controller WinLC RTX Overview
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Product Overview 1

WinLC RTX provides real-time process control from your computer. As part of the
SIMATIC family of automation products, WinLC RTX is fully compatible with any of
the SIMATIC products, such as the STEP 7 programming software and the
Windows Control Center (WinCC). The SIMATIC family of automation tools helps
to make the WIinLC RTX controller a powerful solution for your automation needs.

WinLC RTX can communicate to STEP 7 remotely over PROFIBUS, Ethernet, or
MPI networks. WinLC RTX controls distributed 1/O, such as ET 200M over

PROFIBUS-DP.
Section Description Page
11 Controlling Your Process with the WinLC RTX 1-2
1.2 Additional Features for WinLC RTX 1-4
1.3 Understanding How WinLC RTX Operates if Windows NT 1-4
Crashes
14 Storing the Date 1-4
15 Differences from the Windows NT Version of WinLC 1-5
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Product Overview

11 Controlling Your Process with WinLC RTX

WiInLC RTX uses the VenturCom Real-time extensions (RTX) to the Windows NT
operating system to provide a real-time, computer-based solution for your
automation projects. As shown in Figure 1-1, WinLC RTX connects a PC-based
controller over a PROFIBUS network to the distributed 1/O that connect to the
process or automation project. You can also use the following standard SIMATIC
products with WinLC RTX:

» STEP 7 automation software allows you to design, download, test, and monitor
the user program that runs on WinLC RTX.

* WiInCC provides a human-machine interface (HMI) for monitoring your process.

il aalll

PROFIBUS

Figure 1-1  Components of WinLC RTX RT

Operational Features of WinLC RTX

WinLC RTX is a PC-based logic controller in the family of S7 controllers (S7-300
and S7-400). This controller is fully compatible with the automation tools provided
by the SIMATIC family of products, such as the STEP 7 programming software
and WinCC.

The WinLC RTX controller has four accumulators and supports distributed 1/0O over
a PROFIBUS-DP network. For more information about the operational features of
the WIinLC RTX, see Chapter 5.

Windows Logic Controller WinLC RTX Overview
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Product Overview

System Requirements

To run WIinLC RTX, your computer must meet the following criteria:

A personal computer (PC) with the following:

Pentium processor running at 400 MHz or faster (recommended)
128 Mbytes RAM (recommended)
512 Kbytes level 2 cache

Microsoft Windows NT version 4.0 (or higher), with service pack 6 (or
higher) required

A color monitor, keyboard, and mouse or other pointing device (optional) that
are supported by Microsoft Windows NT

A hard drive with 10 Mbytes of free space

At least 1 Mbyte free memory capacity on drive C for the Setup program (Setup
files are deleted when the installation is complete.)

An installed CP 5613 card connected to a PROFIBUS-DP network for
distributed 1/O communication.

Windows Logic Controller WinLC RTX Overview
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Product Overview

1.2

1.3

1.4

1-4

Additional Features for WinLC RTX

WinLC RTX is a real-time PC-based controller that includes the following features:

*  WiInLC RTX communicates with STEP 7 and SIMATIC Computing over
PROFIBUS, MPI, or Ethernet networks. SIMATIC HMI products are also
supported. The recommended version of STEP 7 is STEP7 V5.0 SP3 or higher,
but WinLC RTX can be used with earlier versions of STEP 7. For more
information, see Section 4.2.

* WiInLC RTX is uses the communications processor CP 5613 for communicating
with the distributed 1/0. Purchase the CP 5613 card card separately.

» If you are using STEP7 V5.0 SP3 or higher, configure WinLC RTX as a PC
station.

* For improved deterministic behavior and isolation from NT failures, WinLC RTX
executes the user program in the real-time subsystem.

How WiInLC RTX Operates if Windows NT Crashes

WinLC RTX supports OB84 (CPU Hardware Fault), which allows you to initiate the
shutdown of your process in case Windows NT detects an unrecoverable fault or
STOP error while WinLC RTX is running. See Section 5.4 for more information.

Storing the Date

WinLC RTX stores dates in a two-digit format (for example, 1999 is stored as “99").
WinLC RTX correctly interprets “00” as being 2000. Years are stored from 84 (for
1984) to 83 (for 2083).

Windows Logic Controller WinLC RTX Overview
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Product Overview

1.5 Differences from the Windows NT Version of WinLC

Some of the operations of WinLC RTX differ from the Windows NT version of
WinLC:

» Initial values of non-retentive memory areas after shutting down and restarting
WinLC:

— WinLC running on Windows NT: When you shut down the controller, WinLC
saves the values of the non-retentive memory areas. These values are
restored when you restart the controller.

— WinLC RTX: When you shut down the controller, WinLC does NOT save the
values of the non-retentive memory areas. When you restart the controller,
the non-retentive memory ares are set to their initial values.

» Support for external connections through the CP 5613 card:

— WinLC running on Windows NT: You can configure access points (WinLC_0
to WIinLC_8) to use the drivers of the CP 5613 card.

— WinLC RTX: The Real-time (RTX) drivers for the CP 5613 card that were
installed with WinLC RTX do not support the use of access points. To
configure external access points for WinLC RTX, you must use a second CP
card (such as a CP 5611).

Windows Logic Controller WinLC RTX Overview
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Setting Up the WInLC RTX Software 2

Chapter Overview

To use WiInLC RTX for process control, you must install and authorize the WinAC
RTX software on your computer. In addition, you must have installed a
communications processor CP 5613 card in your computer.

Note

The Setup program for WinAC RTX allows you to install WinLC RTX as an NT
service.

The Setup program for WinLC RTX configures the CP 5613 card in your computer
as the access point for WinLC RTX. Chapter 6 provides guidelines for planning the
PROFIBUS network. For more information about distributed I/O and PROFIBUS
networks, refer to the SIMATIC NET PROFIBUS User Manual and to the
documentation for the distributed 1/0.

Section Description Page
2.1 Overview of the WIinLC RTX Installation 2-2
2.2 Installing the WinLC RTX Software 2-3
23 Running WIinLC RTX as an NT Service 2-5
2.4 Uninstalling the WinLC RTX Software 2-6
25 Authorizing the WinAC RTX Software 2-7
2.6 Special Notes for Installing the CP 5613 Card 2-9
2.7 Troubleshooting the Installation of WinLC RTX 2-11
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Setting Up the WinLC RTX Software

2.1

2-2

Overview of the WIinLC RTX Installation

As shown in Figure 2-1, you must install the following components:

» CP 5613 card (purchased separately)

* VenturCom Real-time extensions (RTX) for Windows NT

* WiInLC RTX software (and other elements of WinAC RTX)

The WIinLC RTX comes with new real-time drivers for the CP 5613 card.

You install these products on your computer and connect WinLC RTX to the
distributed 1/O over your network.

o —
—
O —

]
]

C T T avbwedio ]
il |
= = :
I

PROFIBUS Network

Figure 2-1 Installing the Components for WinLC RTX

Each component must be installed separately on your computer. Refer to the
documentation for each component for the specific instructions for installing that
component. If you are installing the STEP 7 software (or another SIMATIC
software package), refer to the installation procedures for that product.

You must perform the following tasks to install the components of WinLC RTX:

* You must install the CP 5613 card in your computer; however, do not install the
SIMATIC NET software. For information about installing the CP card, refer to
the documentation for the CP 5613 and to Section 2.6.

* You must use the Setup program for WinAC RTX to install WinLC RTX. The
device drivers for the CP 5613 card are included during the installation. See
Section 2.2 .

* You must authorize WIinAC RTX for use on your computer. See Section 2.5.

Note

The Setup program configures the first CP 5613 card in your computer as the
access point for WinLC RTX. You do not use the Setting the PG/PC Interface
application to configure the CP 5613 card for WinLC RTX.

Windows Logic Controller WinLC RTX Overview
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Setting Up the WinLC RTX Software

2.2 Installing the WinLC RTX Software

WinAC RTX includes a Setup program which executes the installation
automatically. The screen prompts guide you step by step through the installation
procedure. This Setup program allows you to install any or all of the elements of
WinAC RTX. To install only WinLC RTX, deselect the other components of
WinAC RTX and select to install only WinLC RTX.

During installation, the program checks to see whether an authorization is installed
on the hard disk. If no authorization is found, a message notifies you that the
software can be used only with an authorization. If you wish, you can run the
authorization program immediately or continue the installation and execute the
authorization later. See Section 2.5. for a description of how to run the
authorization program.

Starting the Installation Program

The Setup program guides you step by step through the installation process. You
can switch to the next step or to the previous step from any position.

Note

Before installing WinLC RTX, the Setup program automatically removes any
existing version of WinLC and the DP 5613 drivers from the computer.

Use the following procedure to start the installation program:

1. Start the dialog box for installing software under Windows NT by double-clicking
on the Add/Remove Programs icon in the Control Panel.

2. Click Install.

3. Insert the CD-ROM and click Next. Windows NT searches automatically for the
installation program SETUP.EXE.

4. Follow the instructions displayed by the Setup program and select the elements
of WinAC RTX to install:

— The Setup program first installs the VenturCom Real-time extensions (RTX).
After the RTX extensions are installed, the Setup program restarts your
computer.

— After the computer has been restarted, the Setup program installs elements
of WIinAC RTX that you selected.

5. When prompted by the software, insert the WinLC RTX authorization diskette in
drive A. For more information about authorizing the WinLC RTX software, see
Section 2.5.

After the installation has been completed successfully, a message to that effect is
displayed on the screen.

Windows Logic Controller WinLC RTX Overview
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Setting Up the WinLC RTX Software

Note

You can configure WinLC RTX to connect to STEP 7 that is running either on the
same computer as WinLC RTX or on another computer. Refer to Sections 3.1 and
3.2.

Troubleshooting Any Errors That Occur during Installation
The following errors may cause the installation to fail:

» Initialization error immediately after starting Setup: The SETUP.EXE program
was probably not started under Windows NT.

* Not enough memory: You need at least 10 Mbytes of free space on your hard
disk for WinLC RTX.

» Bad disk: Verify that the WinAC RTX CD is bad, then call your local Siemens
representative.

Windows Logic Controller WinLC RTX Overview
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Setting Up the WinLC RTX Software

2.3 Running WIinLC RTX as an NT Service

The Setup program allows you to choose whether to install WinLC RTX as an NT
service. You must have administrative privileges to install WinLC RTX as a service.
By running as an NT service, WinLC RTX starts automatically any time you start
the computer. You can use the Windows NT control panel to change this selection
later if you wish. See Section 4.7.

Note

You must have Administrator (ADMIN) privileges to manually start WinLC RTX. To
allow WIinLC RTX to run when a non-administrator uses the computer, configure
WinLC RTX as an NT service. When the non-administrator starts the computer
and logs in, the WinLC RTX service runs. The non-administrator can then perform
all of the functions allowed by the level of security for WinLC RTX.

WinLC RTX execution can be controlled from the Windows NT Control Panel when
WinLC RTX is configured to run as an NT service. To access Windows NT
services, follow the procedure below:

1. Select Start > Settings > Control Panel
2. Double-click on the Services icon to open the Services dialog box.

3. Select “SIMATIC WiInLC RTX” from the list of NT Services. Notice that the
Startup behavior is listed as Automatic.

4. To start or stop WIinLC RTX, use the Start and Stop buttons on the Services
dialog box.

To change WinLC RTX so that it does not start automatically after a reboot, follow
the procedure below:

1. On the Services dialog box, click the Startup button to display the dialog box.

2. In the Startup Type field, select “Manual” and click OK. Notice that the Startup
behavior is now listed as Manual.

3. Close the Services dialog box.

After changing WIinLC RTX to start manually, you must open the Services dialog
box and use the Start or Stop buttons every time you want to start or stop
WinLC RTX.

Windows Logic Controller WinLC RTX Overview
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Setting Up the WinLC RTX Software

2.4

2-6

Uninstalling the WinLC RTX Software

Use the Add/Remove Programs utility of Windows NT to uninstall the WinLC RTX
software:

1. Start the dialog box for installing software under Windows NT by double-clicking
on the Add/Remove Programs icon in the Control Panel.

2. From the list of installed programs, select the WinLC RTX and click on the
Add/Remove button. Windows NT then uninstalls the WinLC RTX software.

3. If the Remove Shared Components dialog box appears, click the “No” button if
you are unsure how to respond.

Caution

If improperly transferred or removed, the authorization for WinLC RTX may be
irretrievably lost.

The Readme file on the authorization diskette contains guidelines for installing,
transferring, and removing the authorization for WinLC RTX. If you do not follow
these guidelines, the authorization for WinLC RTX may be irretrievably lost. Losing
the authorization would prohibit you from modifying any program that was
downloaded to WinLC RTX and from downloading another program to WinLC
RTX.

Read the information in the Readme file on the authorization diskette, and follow
the guidelines in regard to transferring and removing the authorization.

Windows Logic Controller WinLC RTX Overview
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2.5 Authorizing the WIinAC RTX Software

WinAC RTX requires a product-specific authorization (or license for use). The
software is therefore copy-protected and can be used only if the relevant
authorization for the program or software package is found on the hard disk of the
computer.

Note

If you remove the authorization, the WinLC RTX controller continues to operate;
however, you cannot modify the program being executed and you cannot
download a new program. You are still permitted to change from RUN mode to
STOP mode, and the controller continues to execute the user program. You are
still permitted to create and reload archive files.

A notification message appears every six minutes to alert you that the
authorization is missing.

If you install an authorization while the WinLC RTX controller is running, you must
also change the operating mode of the controller before the authorization takes
effect.

Authorization Disk

An authorization diskette is included with the software. It contains the authorization
and the program (AUTHORSW) required to display, install, and remove the
authorization.

There are separate authorization diskettes for each of the SIMATIC automation
software products. You must install the authorization for each product as part of
the installation procedure for that software.

Caution

If improperly transferred or removed, the authorization for WinLC RTX may be
irretrievably lost.

The Readme file on the authorization diskette contains guidelines for installing,
transferring, and removing the authorization for WinLC RTX. If you do not follow
these guidelines, the authorization for WinLC RTX may be irretrievably lost.

Read the information in the Readme file on the authorization diskette, and follow
the guidelines in regard to transferring and removing the authorization.

Windows Logic Controller WinLC RTX Overview
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Installing the Authorization

When you install your software for the first time, a message prompts you to install
the authorization. Use the following procedure to install the authorization for
WinLC RTX:

1. When prompted, insert the authorization diskette in drive A.
2. Acknowledge the prompt.

The authorization is transferred to the hard drive (C), and your computer registers
the fact that the authorization has been installed.

Note

Always enter drive C as the destination drive for the authorization for WinLC RTX.

If you attempt to start WinLC RTX and there is no authorization available for the
software, a message informs you of this. If you want to install the authorization,
use the AUTHORSW program on the authorization diskette. This program allows
you to display, install, and remove authorizations.

Removing an Authorization

2-8

If you should need to repeat the authorization (for example, if you want to reformat
the drive on which the authorization is located) you must remove the existing
authorization first. You need the original authorization diskette to do this.

Use the following procedure to transfer the authorization back to the authorization
diskette:

1. Insert the original authorization diskette in your floppy disk drive.
2. Start the program AUTHORSW.EXE from the authorization diskette.

3. From the list of all authorizations on drive C, select the authorization to be
removed.

4. Select the Authorization > Transfer... menu command.

5. In the dialog box, enter the target floppy drive to which the authorization will be
transferred and confirm the dialog box.

6. The window with the list of authorizations remaining on the drive is then
displayed. Close the AUTHORSW program if you do not want to remove any
more authorizations.

You can then use the diskette again to install an authorization. You must use the
authorization diskette to remove any existing authorizations.

If a fault occurs on your hard disk before you can back up the authorization,
contact your local Siemens representative.

Windows Logic Controller WinLC RTX Overview
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2.6

Special Notes for Installing the CP 5613 Card

Caution

Attempting to run WinLC RTX with both the WinLC RTX drivers and the SIMATIC
NET drivers for the CP 5613 installed on your computer can cause unpredictable
operation of the CP 5613 card, which might result in potential damage to
equipment and possible injury to personnel.

Do not install the SIMATIC NET software for the CP 5613 card after you have
installed WinLC RTX.

The WInLC RTX controller uses a real-time device driver to access the CP 5613
card. This device driver replaces the SIMATIC NET CP 5613 device driver
delivered with the CP 5613 hardware.

The SIMATIC NET software for the CP 5613 includes the following products:

DP 5613, S7 5613, FMS 5613, and CP 5613/ CP 5614 Software DP Base.
Installing any of these products on your computer installs the SIMATIC NET device
drivers for the CP 5613 card.

The Setup program for WinLC RTX removes any existing CP 5613 device drivers
from your computer before installing the WinLC RTX device drivers for the

CP 5613 card. Do not install the CP 5613 software from the SIMATIC NET CD,
especially after you have installed the WinLC RTX software.

Accessing the CP 5613 in Polled or Interrupt Mode

WinLC RTX accesses the CP 5613 card in in either “Polled” or “Interrupt” mode.
Interrupt mode provides improved performance over Polled mode. In order for
WinLC RTX to use the Interrupt mode for accessing the CP 5613, the interrupt
request (IRQ) number for the CP card must be available for use by the VenturCom
RTX real-time subsystem (RTSS).

To ensure that WinLC RTX accesses the CP 5613 in interrupt mode, you must
configure your computer so that the CP 5613 does not share an IRQ number with
an NT device.

Use the following procedure to determine the IRQ number assigned to the
CP 5613:

1. Browse to the Program Files\Vci\RTX\Samples directory (typically on the C
drive) and locate the ScanBus.rtss utility.

2. Double-click on the ScanBus.rtss icon. The ScanBus utility lists all of the PCI
devices which have been installed on your computer. Included in this list are the
resources for each device.

Windows Logic Controller WinLC RTX Overview
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3. Locate the PciData for the following device:
— VendorID: 0x11a
— DevicelD: 0x3142

4. The InterruptLine entry shows the IRQ number that has been assigned for the
CP 5613 card. Record the IRQ number to use as a reference.

Use the following procedure to display the IRQ numbers assigned to the NT
devices on your computer:

1. Select the Start > Programs > Administrative Tools (Common) > Windows
NT Diagnostics menu command to display the Windows NT Diagnostics dialog
box.

2. Select the Resources tab to display the IRQ numbers assigned to the devices
installed in your computer:

— If there is an entry for “cp5613” in the device list, you have installed a
component of the SIMATIC NET CP 5613 software. You must remove this
software before WinLC RTX can function correctly.

— Compare the IRQ numbers listed for the NT devices with the IRQ number of
the CP 5613 that you recorded in Step 4. If this number has been assigned
to any device other than the Rtx_rtss device, the CP 5613 is used in Polled
mode. Otherwise, the CP 5613 is used in Interrupt mode.

If the IRQ for the CP 5613 card is assigned to an NT device, use one of the
following methods to change the system configuration for your computer and
assign a different IRQ number to the CP 5613 card:

» Use the BIOS setup utility of your computer to assign a unique IRQ to the
CP 5613 card.

» Install the CP 5613 card in a different slot on the PCI bus of your computer.

Note

This may be an iterative process, and you may find that there is no solution that
assigns an IRQ number to the Rtx_rtss device (CP 5613 card). In this case, you
may want to consider using a different computer or a different BIOS.
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2.7 Troubleshooting the Installation of WinLC RTX

Problems Occur If You Have Not Installed Windows NT 4.0 Service Pack 6

The VenturCom Real-time extensions (RTX) and WinLC RTX require Windows NT
version 4.0 Service Pack 6 (SP6) in order to operate properly. Attempting to run
WinLC without this version of Windows NT might cause problems, including the
following:

» Failure of CPU indicators (LEDS) to register a change of operating mode
» CPU disconnect errors
» Stack fault messages from the DP authorization software

Microsoft Windows NT 4.0 Service Pack 6 is available as a free download from
Microsoft (www.microsoft.com).

If You Cannot Start the WinLC Controller from the WinLC Control Panel

When you install WinLC RTX, the Setup program creates and registers the Active
File, which is an important WinLC system file. If for any reason the Active File path
is not found in the registry, the WinLC RTX controller cannot be started from the
WinLC control panel.

Use the following procedure to restore the path for the Active file:
1. Use Windows Explorer to start the WinLC RTX controller:
— Locate the executable file for the controller:
S7wilcrtx.exe

— Double-click on its icon to start the controller. (This action starts only the
WinLC RTX controller; it does not display the WinLC control panel.)

As WInLC RTX starts the controller, WinLC RTX registers the Active File path
for you. WinLC RTX opens an empty controller (no user program) in STOP
mode.

2. To connect to the controller, double-click the WinLC RTX icon on your desktop
to display the WIinLC control panel.

Note

If you use this method to start the WinLC RTX controller, you will not be able to
shut down the WinLC RTX controller from the application. You must log out of the
Windows NT session in order to shut down the WinLC RTX controller.

Windows Logic Controller WinLC RTX Overview
A5E00083518-01 2-11



Setting Up the WinLC RTX Software

Problems Occur When You Install Elements of WinAC While WIinLC RTX Is

Running

/N

Do not install any elements of WIinAC (such as SIMATIC Computing) on a
computer that is actively running WinLC RTX during the installation. Since these
products use the common resources, this could cause the files to become
corrupted. Always stop the execution of WinLC RTX (or any other element of
WinAC) before installing any of the WinAC software.

Caution

Do not install any component of WinAC (such as WinLC RTX) on a computer while
any other component of WinAC (such as WinLC RTX, the SIMATIC Computing
SoftContainer, programs that use the SIMATIC controls provided by Computing, or
the panel for the CPU 416-2 DP ISA or another slot PLC) is being executed (are
currently running) on that computer.

Since SIMATIC Computing, WinLC RTX, and other elements of WinAC use
common files, attempting to install any component of the WinAC software when
any of the components of WIinAC are being executed by the computer can corrupt
the software files. Always ensure that the following programs are not running when
you install WinLC RTX:

* WinLC

e Panel for CPU 416-2 DP ISA or any other slot PLC
e SIMATIC Computing SoftContainer

* TagFile Configurator

* Toolmanager

e SIMATIC Computing OPC Configuration

e SIMATIC Computing Configuration

* Any program (such as a program created in Visual Basic) that uses one of the
SIMATIC controls provided by Computing

Problems with the Autostart Feature

2-12

In order to use the Autostart feature for modifying the start-up and shut-down
behavior of WinLC RTX, you must have administrator privileges. If you do not have
administrator privileges, you cannot modify the Autostart options.

See Section 4.7 for more information about the Autostart feature.
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Problems Occur If You Use STEP 7 to Change the MPI Address for WinLC RTX

Using the hardware configuration application of STEP 7 to change the MPI node
address for WinLC RTX causes communication problems on your MPI network.
These problems occur because the logical address (as configured by STEP 7)
does not match the physical address for WinLC (as determined by the MPI card,
typically MPI=2).

The MPI address of WinLC RTX (MPI=2) is determined by the MPI card installed
in your computer. This hardware-configured MPI address for WinLC RTX is
independent of any MPI address that you can configure in STEP 7. Always leave
the node address for WinLC RTX set to MPI=2.

Problems Occur If You Uninstall (Remove) the Computing Software While WinLC
RTX Is Running

If WinLC RTX is being executed during the uninstallation procedure for the
Computing software, WinLC RTX experiences a connection error and loses
connection to the machine or process. Use the following procedure to recover from
the connection error:

1. Using the Windows NT Task Manager, end the process for WinLC RTX
(S7wlcrtx.exe).

2. If the WiInLC control panel is open, close the control panel.

3. Restart WinLC RTX to reconnect to the machine or process.

ii Warning
Uninstalling (removing) the Computing software at the same time that WinLC RTX
is being executed on that computer causes WinLC RTX to be disconnected from
the machine or process that it is controlling. This could cause unpredictable
process operation, which could result in death or serious injury to personnel,
and/or damage to equipment.

If you cause WInLC RTX to lose connection to the process by uninstalling
Computing, use the Windows NT Task Manager to end the WinLC RTX process
(S7wlcrtx.exe). If the WIinLC control panel is open, close the panel. To reconnect
WinLC RTX to the machine or process, restart WinLC RTX.

Before removing the Computing software, always ensure that the WinLC RTX
controller has been shut down and that the WinLC RTX software is not being
executed. This helps to ensure that you do not cause WinLC RTX to become
disconnected from the machine or process, which could cause process equipment
to operate erratically. Always install a physical emergency stop circuit for your
machine or process.
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Connecting SIMATIC Client Software to

WInLC RTX

Chapter Overview

3

WinLC RTX allows you to connect to SIMATIC products, such as STEP 7, WinCC,
and ProTool Pro, across networks using MPI, PROFIBUS-DP, or Ethernet (H1)

networks. For more information, refer to the documentation for the specific

products.

This chapter provides information about different configurations for connecting

WiInLC RTX to STEP 7.

Note

Earlier versions of WinLC allowed you to redirect the MPI communications. WinLC

RTX does not support this feature.

Section Description Page
3.1 Connecting STEP 7 to WinLC RTX on the Same Computer 3-2
3.2 Connecting STEP 7 to WIinLC RTX on a Different Computer 3-3
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3.1

3-2

Connecting STEP 7 to WinLC RTX on the Same Computer

Use the following procedure to configure STEP 7 for communicating with WinLC

RTX on the same computer:

1. From WinLC RTX, select the CPU > Setting the PG/PC Interface menu

command to open the Set the PG/PC Interface dialog box.

2. As shown in Figure 3-1, select the following entry from the drop-down list for the

“Access Point of the Application” field:
S7ONLINE (STEP 7)

3. For the “Interface Parameter Assignment Used” field, select the following

parameter:
PC Internal (local)

4. Click OK to enter the configuration and close the dialog box.

STEP 7 is now configured to communicate with WinLC RTX on the local computer.

Set the PG/PC Interface (V5.0) x|

Access Path |

Access Point of the Application:
| STONLINE (STEP 7) --> PC internal (local)

(Standard for STEP 7)

Interface Parameter Assignment Used:

| PC internal (local)

CP5611(MPI)
CP4611(PROFIBUS)
CP5412A2(MPI)

CP5412A2(PROFIBUS) Copy...
PC Internal (local Del
TCP/IP-->3Com Etherlink Il Adapter Delete

(communication with WinAC components in this
PG/PC)

Interfaces

Add/Remove: Select...
OK Cancel | Help |

Figure 3-1  Setting the PG/PC Interface for PC Internal (local)
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3.2 Connecting STEP 7 to WinLC RTX on a Different Computer

As shown in Figure 3-2, you can connect STEP 7 on one computer to a WinLC
RTX on a different computer.

* You must define the network connection over which STEP 7 and WIinLC RTX
communicate by setting the PG/PC interface on the remote computer.

* The remote computer must have STEP 7 installed, and the computer to which
you wish to connect must have WinLC RTX installed.

Note

To configure STEP 7 and WinLC for H1 communications, you must also have
installed the following software:

* NCM Options package for H1 communication

e STEP 7 version 5 service pack 3 (SP3)

STEP 7 WinLC
Setting the PG/PC Setting the PG/PC
Interface tool Interface tool
Network
Remote Local
Computer i T ol T T Computer

= =
—ELL EELL

Control Engines

Figure 3-2  Connecting STEP 7 to WinLC RTX over a network

Note

NetPro cannot reconfigure the MPI or H1 addresses or the bus parameters of a
WiInLC RTX from a different computer. The required CP cards are not controlled
by WIinLC RTX. This can be done only by means of the local Setting the PG/PC
Interface application. The PROFIBUS node address and bus parameters can be
reconfigured remotely. The WinLC RTX is the master for the CP 5613 card.
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Configuring the Computer with STEP 7

3-4

You must configure the computer on which STEP 7 resides for communicating with
WinLC RTX on a remote computer:

1.

From SIMATIC Manager, select the Options > Set the PG/PC Interface menu
command to display the Setting the PG/PC dialog box.

. As shown in Figure 3-3, select the following entry from the drop-down list for the

“Access Point of the Application” field:
S7ONLINE (STEP 7)

If you are using MPI as your network communication path, select the MPI
interface parameter. For example:

CP5611 (MPI)

If you are using PROFIBUS-DP as your network communication path, select
the PROFIBUS-DP interface parameter. For example:

CP5412A2(PROFIBUS)

If you are using H1 as your network communication path, select the TCP/IP
interface parameter. For example:

TCP/IP -> 3Com Etherlink 11l Ada

. Click OK to save the configuration.

Set the PG/PC Interface (V5.0) x|

Access Path |

Access Point of the Application:
| S7ONLINE (STEP 7) --> CP5412A2(PROFIBUS)

(Standard for STEP 7)

Interface Parameter Assignment Used:

e

CP5611 (MPI)

CP5611 (PROFIBUS)
CP5412A2(MPI)

CP5412A2(PROFIBUS) Copy...
PC Internal (local)

TCP/IP-->3Com Etherlink |1l Adapter Delete
(Configuration of your Communication Processor

CP 5412 (A2) for a PROFIBUS network)

Interfaces

Add/Remove: Select...

OK Cancel | Help |

Figure 3-3  Setting the PG/PC Interface for the Computer with STEP 7 Installed

Windows Logic Controller WinLC RTX Overview
A5E00083518-01



Connecting SIMATIC Client Software to WinLC RTX

Note

Before WIinLC RTX is visible to other programming devices on the PROFIBUS-DP
network, you must use the Setting the PG/PC Interface dialog box to configure the
CP card:

S7ONLINE (STEP7) --> PROFIBUS

In addition, you must select the “PG is the only master on the bus” option.

Configuring the Computer where WIinLC RTX Is Installed

You must also configure the communication path(s) from the computer on which
WinLC RXT resides to networks with computer(s) running STEP 7. WIinLC RTX
installs nine access points. Each access point can point to one of the installed
interfaces. In the following example, WinLC RTX provides access by means of two
different CP cards (CP 5412 and CP 5611) at the same time. You cannot access
WinLC through any CP cards that are not assigned to an access point.

WinLC_0 --> none

WinLC_1 --> CP5412A2(MPI)
WinLC_2 --> none

WinLC_3 --> none

WinLC_4 --> none

WinLC_5 --> none

WinLC_6 --> CP5611 (MPI)

WinLC_7 --> none

WinLC_8 --> none

Use the following procedure to configure one of the access points in the example:

1. Using the WinLC RTX control panel, select the CPU > Setting the PG/PC
Interface menu command to display the Setting the PG/PC dialog box.

2. From the drop-down list of the “Access point of application” field, select the
access point. For example:

WinLC_6

3. As shown in Figure 3-4, select the interface parameter from the parameter set
that corresponds to your network communications path. For example:

CP5611 (MPI)

Repeat steps 2. and 3. as needed to configure any other access point used to
communicate to your network.

4. Shut down and restart the WinLC RTX application so that your selections can
take effect.
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Set the PG/PC Interface (V5.0) x|

Access Path |

Access Point of the Application:
| WinLC_6 --> CP54212A2 (MPI)

(Standard for STEP 7)

Interface Parameter Assignment Used:

[ cosens o
CP5611 (MPI)

CP5412A2(PROFIBUS)
PC Internal (local)

TCP/IP-->3Com Etherlink Ill Adapter Copy...
Delete

(Parameter assignment of your communications
processor CP54212A2 for a PROFIBUS network)

Interfaces

Add/Remove: Select...
OK Cancel | Help |

Figure 3-4  Setting the PG/PC Interface for the CP Card

Connecting STEP 7 to Hardware PLCs

After you have configured STEP 7 for communicating with WinLC RTX on the
remote computer (Section 3.2) in addition to any hardware PLCs on the network,
you can use any of the STEP 7 tools or functionality across the network.

Note

WinLC RTX cannot perform the cyclic distribution of PROFIBUS bus parameters.
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Chapter Overview

A

The WinLC control panel allows you to control the operation of the WinLC RTX
controller by performing the following tasks:

Monitoring the status

Changing the operating mode

Registering and unregistering WinLC RTX as an NT service

Performing a cold restart or a warm restart

Enabling the Autostart feature of WinLC RTX

Monitoring the scan cycle

Tuning the operations of WinLC RTX

Changing the language for the WIinAC applications

Creating levels of access and security for WinLC RTX

Changing the password for WinLC RTX

Section Description Page
41 Starting the WinLC RTX Software 4-2
4.2 Creating the Hardware Configuration 4-4
4.3 Downloading Your User Program 4-8
4.4 Executing the User Program 4-9
45 Understanding the WinLC RTX Scan Cycle 4-12
4.6 Tuning the Operation of WinLC RTX 4-14
4.7 Running the WinLC RTX Controller 4-16
4.8 Selecting the Language for WinAC 4-20
4.9 Creating Levels of Security for Access to WinLC RTX 4-21
4.10 Saving and Restoring Your User Program 4-25
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4.1

Starting the WinLC RTX Software

Figure 4-1 provides an overview of the steps required for configuring the hardware
and downloading the user program to WinLC RTX.

Im Start WinLC RTX.

ﬁ | Using STEP 7: Create the hardware configuration. |
[d

| Using STEP 7: Download your user program. |

Figure 4-1  Starting WinLC RTX

Note

You must have administrator (ADMIN) privileges to start WinLC RTX. To allow
non-administrators to start WinLC RTX, configure WinLC RTX to run as an
NT service on the computer. See Section 4.7 and Section 2.3.

Getting Started

4-2

Use the following procedure to start WinLC RTX:
1. Go to the main Windows NT taskbar and click on the Start button.

2. Select the WinLC RTX software from the Start menu (Start > SIMATIC > PC
Based Control > WIinLCRTX Controller ).

You can change the operating mode of the WinLC RTX controller from STOP to
RUN by clicking on the RUN or RUN-P button of the control panel. When you
change the operating mode, the status indicators on the panel also change. For
more information about using the control panel, see Section 4.4 or Section 5.1.

WinLC RTX opens with a control panel, as shown in Figure 4-2.
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Setting Network Connections for STEP 7

From the WInLC control panel, select CPU > Setting the PG/PC Interface menu.
Chapter 3 describes how to configure network settings.

Eile CPU Help
SIEMENS

PS

Displays (or hides) the tuning panel
for the WinLC RTX controller

Changes the operating mode of the
WiInLC RTX controller

Displays the status of the WinLC RTX
controller

Resets the memory areas

Figure 4-2  Control Panel for WinLC RTX
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4.2

Creating the Hardware Configuration

The hardware configuration defines the network addresses and the distributed I/O
(DP) for the WIinLC RTX controller. It also defines the default operating
parameters, such as the minimum scan cycle time. As shown in Figure 4-3, you
must use the STEP 7 programming software to configure WinLC RTX:

» Use the SIMATIC Manager to create a project and a PC station.

» Use the Hardware Configuration to configure WinLC RTX and the distributed
I/0.

For information about using the STEP 7 programming software, refer to the
STEP 7 User Manual or to the online help for the STEP 7 software.

ﬁ | Start WinLC RTX.

Using STEP 7: Insert a PC station.

Create the hardware configuration for WinLC RTX:
7 * Insert the hardware components for the PROFIBUS-DP network.
* Create the PROFIBUS-DP network configuration.

Using STEP 7: Download your user program.

Figure 4-3 Using STEP 7 to Configure the WinLC RTX

Inserting a Station for WinLC RTX in STEP 7

4-4

Before you can create the hardware configuration for WinLC RTX, you must insert
a station under your project. For STEP 7 Version 5, Service Pack 3, insert a PC
station. STEP 7 V5 SP3 models WIinLC RTX as a component in a PC station. (For
versions of STEP 7 prior to Version 5, Service Pack 3, you must insert a

SIMATIC 300 station.) Use the following procedure for inserting a station:

1. Select (click on) the project. For example, select the sample project
ZEn0l1_09_STEP7__ Zebra.

2. Select the Insert > PC Station menu command to insert a station under the
project. (To insert a SIMATIC 300 station, select the Insert > SIMATIC 300
Station menu command.)

3. Select the station to display the hardware icon for the station.
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N
C

ote

ertain System Data Blocks have a different structure, depending on whether the

WinLC RTX is configured in a 300 Station or a PC Station. You must manually
select the correct station type for your application. Failure to configure the correct
station type will cause upload/download error messages to be displayed.

1.

From the WinLC control panel, select the CPU > Options > Customize menu
command.

Select the Station Type tab on the Customize dialog box.
As shown in Figure 4-4, select the appropriate station type.
Click OK to enter the configuration.

( General [ Language f Station Type 1
L WinLC RTX as a S7-300 Station
_ e Select the appropriate station.
(¢ WInLC RTX as a PC Station

The PC Station Configuration is first available with STEP 7
V5.0 SP3 or greater. This setting prevents errors in
uploads and downloads.

OK Apply Cancel Help

Figure 4-4  Setting the Station Type
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Inserting the Hardware Components

4-6

You use the hardware configuration of the STEP 7 programming software to
configure WinLC RTX:

Note

Because WInLC RTX has no effect on any installed MPI card, you cannot use the
MPI node of WinLC RTX to configure hardware. Do not change the MPI address
of WinLC RTX from node address 2.

1. Select the PC station. If you have STEP 7 without the service pack, select
SIMATIC 300 station.

2. Double-click on the Hardware object to open the configuration tool of the
STEP 7 software. (See Figure 4-5.)

SIMATIC Manager - ZEn01_09_STEP7__Zebra
File Edit Insert PLC View Options Window Help

-1 %] =) x|

DiS|ET| | @ o 2of = E =] O (< NoFiter >

€3 zEn01_09_STEP7_zebra | [fl] Configuration
—[ffl s™MATIC 300 Station (1)
SIMATIC PC Station (2)

Press F1 for help. [ [ A

Figure 4-5  Configuring the PC Station in the Sample Project

3. For a PC station:
— Double-click on the Configuration icon to open the hardware catalog.
— Select the second slot in the PC display.

— Select the SIMATIC PC Station > Controller entry from the catalog. Click
on the WinLC RTX icon.

— Use the mouse to drag the WinLC RTX object into slot 2 of the PC display
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Note

With STEP 7 V5.0 SP3 or higher, WinLC RTX is configured as a PC station.
WinLC RTX has features that can only be used if configured in a PC station. In
earlier versions of STEP 7 without the service pack, you must use an S7-300
station and configure WIinLC RTX as version 2.0. See step 4. below.

For a SIMATIC 300 station in a version of STEP 7 prior to V5 SP3:

— Select the Insert > Hardware Components menu command to open the
hardware catalog.

— Select and open the SIMATIC PC Based Control 300/400 object.

— Double-click the WinLC object. If you do not have STEP 7 V5 SP3, be sure
to select WinLC V2.0.

In the Properties - PROFIBUS Node DP Master dialog box, click on New to
open the Properties - New Subnet PROFIBUS dialog box and enter a
PROFIBUS subnet or click OK to accept the default of PROFIBUS(1).

Click OK to enter the default parameters for a PROFIBUS subnet.
Select the PROFIBUS(1) subnet.

Click OK to enter the default subnet and address and to close the Properties -
PROFIBUS Node DP Master dialog box. WinLC RTX V.3.0 appears as the
module in slot 2 of the rack.

Select the Station > Save and Compile menu command to create the sample
hardware configuration for WinLC RTX.

STEP 7 generates the system data (SDBs) for the hardware configuration. Exit the
Hardware Configuration tool.
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4.3

Downloading Your User Program

You use the STEP 7 programming software to download your user program to
WinLC RTX (Figure 4-6). See Chapter 3 for information on connecting STEP 7 to
WinLC RTX.

Due to limitations of the Microsoft “structured document,” programs downloaded to
WinLC RTX are limited to 2500 blocks. This limitation will be addressed in a future
release of WinLC RTX.

Iﬂ | Start the WIinLC RTX software. |

| Using STEP 7: Create the hardware configuration.

ﬁ Using STEP 7:
’

Establish an online connection with WinLC RTX.

Download your user program to WinLC RTX.

Figure 4-6 Using STEP 7 to Download the User Program

Accessing WIinLC RTX from STEP 7

To access WinLC RTX from the STEP 7 programming software, follow these steps:

1. Using the SIMATIC Manager, activate the required project window.

2. Select the View > Online menu command to change to the “Standard
Hierarchy, Online” view.

STEP 7 establishes an online connection to WinLC RTX.

Downloading a User Program from STEP 7

4-8

After you have established an online connection to WinLC RTX, you can download
your user program:

1. Open the icon for your user program and select the Blocks object.
2. Select the PLC > Download menu command or click on the Download button.

STEP 7 downloads all of the blocks of your user program, including the system
data (SDBs), to the WIinLC RTX. You can also download individual blocks of the
user program.

For more information about downloading programs, see the STEP 7 User Manual
or the online help for the STEP 7 programming software.
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4.4

Executing the User Program

After you have downloaded your user program to WinLC RTX, you use the control
panel to control the operation of the controller. The control panel corresponds to
the front panel of an S7 controller.

Running the WinLC RTX Software without Valid Authorization

If you lose the authorization for the software, the WinLC RTX controller will
continue to run, although with less functionality. You will still be permitted to change
from STOP mode to RUN mode, but the controller will not go into RUN-P mode.
The controller continues to execute the user program, but you cannot modify the
user program, and you cannot download a new program or new blocks to the
controller. You can still create and reload archive files.

Using the Control Panel

The WinLC RTX software starts with a control panel. See Figure 4-7. The control
panel contains the following elements:

» A button for displaying or hiding the tuning panel for adjusting the operation of
WinLC RTX (see Section 4.6)

» Three buttons for changing the operating mode of the controller
» Status indicators

* A button for resetting the memory areas

File CPU Help Click to display or hide the tuning panel.

SIEMENS

PS

Click the RUN, RUN-P, or STOP button to change the
operating mode of the WinLC RTX controller.

Status indicators display the status of the WinLC RTX
controller.

Click the MRES button to reset the memory areas of
the WinLC RTX controller.

Figure 4-7 Using the Control Panel of WinLC RTX
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Selecting the Operating Mode

The RUN, RUN-P, and STOP buttons on the control panel correspond to the
different operating modes of the controller:

* In STOP mode, the controller is not executing the user program. To download a
program that includes SDBs, you must place WinLC RTX in STOP mode. On
the transition to STOP mode, the outputs go to a safe state (as configured with
the STEP 7 programming software).

* In RUN mode, the controller executes the user program. You cannot download
any new user program or logic blocks when the controller is in RUN mode. You
can use the STEP 7 programming software to monitor (but not to modify) the
variables.

* In RUN-P mode, the controller executes the user program. You can download
new programs or logic blocks, and you can use the STEP 7 programming
software to modify the variables for testing and debugging.

Clicking on the button places the controller into the selected operating mode. The
status indicators on the control panel show whether the controller is in RUN mode
or in STOP mode.

Selecting a Warm Restart or a Cold Restart

4-10

The hardware configuration downloaded with your user program determines the
default startup mode for WinLC RTX. (For more information about the restart
options, see Section 5.5.) When changing the operating mode of WinLC RTX from
STOP mode to RUN mode, you can selectively change the type of restart:

*  When you use the CPU menu commands (CPU > RUN or CPU > RUN-P) to
change the operating mode, WinLC RTX displays the “Restart Method” dialog
box that allows you to select a cold restart or a warm restart. See Figure 4-8.
Select the type of restart and click OK.

» Using the left mouse button to click on the “RUN” or “RUN-P” buttons on the
control panel performs a warm restart and does not display the “Restart
Method” dialog box.

» As shown in Figure 4-9, using the right mouse button to click on the “RUN" or
“RUN-P” buttons displays the “Restart Method” dialog box that allows you to
select a cold restart or a warm restart.

Restart Method x| | Click the appropriate restart
4 ‘ option and click OK.
(¢ Warm Restart

C cold Restart

oK | Cancel ‘| Help ‘|

Figure 4-8  Selecting a Cold Restart or a Warm Restart
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Sl WinLC RTX m When WiInLC RTX is in STOP mode, you can

Eile CPU Help select a warm restart or cold restart:
| * Move the cursor to the RUN or RUN-P button
SIEMENS . .

¢ Click the right mouse button

* Select the type of restart from the Restart
Method dialog box

Click the right mouse button to display the Restart
Method dialog box.

Figure 4-9  Using the Right Mouse Button to Select the Restart Method

Using the MRES Button to Reset the Memory Areas

The control panel provides a MRES button for resetting the memory areas to the
default values and deleting the user program. Clicking the MRES button places the
controller into STOP mode and performs the following tasks:

» The controller deletes the entire user program, including data blocks (DBs) and
system data blocks (SDBs).

» The controller resets the memory areas (I, Q, M, T, and C).

After the memory has been reset, the diagnostics buffer remains intact, as does
the MPI address.

Using the Status Indicators

The status indicators (BUSF, INTF, EXTF, PS, BATTF, FRCE, RUN, and STOP)
show basic information about the controller, such as the current operating mode or
the presence of an error condition. You cannot change the status of the controller
by clicking on the status indicators. For more information about the status
indicators, see Section 5.1 and Table 5-2.

Windows Logic Controller WinLC RTX Overview
A5E00083518-01 4-11



Running the WinLC RTX Software

4.5

Understanding the WinLC RTX Scan Cycle

As shown in Figure 4-10, the scan cycle of WinLC RTX consists of four basic
elements:

* WiInLC RTX writes the status of the process-image output table (the Q memory
area) to the outputs.

* WiInLC RTX reads the states of the inputs into the process-image input table
(the I memory area).

* WinLC RTX executes the user program.

*  WinLC RTX waits until the minimum scan cycle time has elapsed and triggers
the next scan cycle.

Note

For the first scan, WinLC RTX does not write to the outputs. After the first scan, all
other scans start by writing the process-image output table to the outputs.

The time that elapses between the end of one scan and the minimum scan cycle
time (which starts the next scan) is the “sleep time.”

Scan cycle Next scan cycle
A A

& I a N

Write | Read | EXecute Sleep time Write | Read Execute Sleep time
OB1 OB1

I l Ll
[— Execution time —>: | |
I
I<— Minimum scan cycle time ———— :
f«—— Monitoring time (watchdog) ——— >

Figure 4-10 Elements of the WIinLC RTX Scan Cycle

Configuring the Elements of the Scan Cycle

4-12

You use the hardware configuration tool (Cycle/Clock Memory tab: see

Section 5.5) of the STEP 7 programming software to enter the value for the
minimum scan cycle time and the scan cycle monitoring time (watchdog). These
values are stored as one of the default settings of the hardware configuration for
WinLC RTX.

Do not set the minimum scan cycle time to be longer than the scan cycle
monitoring time (the watchdog time). The maximum value for the scan cycle
monitoring time is 6 seconds; the minimum value for the scan monitoring time must
be more than the minimum scan time.

Windows Logic Controller WinLC RTX Overview
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You can also use the WIinLC control panel to modify (or “tune”) the minimum scan
cycle time; however, changes made to the minimum scan time with the control
panel are only temporary and are replaced by the default values (in the hardware
configuration) when you change the operating mode of the WinLC RTX controller
from STOP to RUN.

For more information about using the WinLC control panel to modify the sleep time
or minimum scan cycle time, see Section 4.6.

Note

WinLC RTX executes the cyclic interrupt OB (OB35) and other OBs at a fixed
interval, independent of the scan cycle and of the execution of the user program in
OBL1. You must allow sufficient time not only for the execution of OB1 and for the
sleep time, but also for the execution of other OBs.

For more information about OB35, refer to Section 5.5 and also to the System
Software for S7-300 and S7-400 System and Standard Functions Reference
Manual.

The following situations can increase the execution time of OB1:

* WiInLC RTX executes other OBs (such as OB20 and OB35) with higher
priorities than OB1.

» Another RTX application that is running on your computer has a higher priority
under the Real-time (RTX) operating system.

Windows Logic Controller WinLC RTX Overview
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4.6 Tuning the Operation of WinLC RTX

The control panel provides a panel for tuning the operation of WinLC RTX. Using
the tuning panel, you can adjust the minimum cycle time, minimum sleep time, and
the real-time (RTX) priority for WinLC RTX.

Using the Tuning Controls to Modify WinLC RTX Operations

The tuning panel (shown in Figure 4-11) allows you to modify elements of the
WinLC RTX scan and to set the priority level for the RTX operating system to
execute the WinLC RTX software:

» Priority: sets the level of priority for the execution of the program downloaded
into WinLC RTX by the RTX operating system. Setting the priority higher for
WinLC RTX means that the operating system responds to WinLC RTX before
executing lower-priority tasks. You only need to adjust the real-time priority for
WinLC RTX if additional RTX applications are running with WinLC RTX.

» Timing Adjustment: allows you to enter new values for either the sleep time or
the minimum cycle time. After you enter the new value in the corresponding
field, you can monitor the effect on the execution of WinLC RTX. (You can
restore the cycle time and sleep time values by clicking on the Restore button
instead of clicking on the Set button.) To enter the new sleep time and cycle
time values, click on the Set button. The panel then stores these values for the
controller.

Using the tuning panel to enter a new value for the scan cycle (cycle time) does
not change the configured value stored in the SDBs. After you have determined
the optimum value of the minimum cycle time, use the STEP 7 programming
software to change the hardware configuration. See Sections 4.2 and 5.5.

~ Cycle Time [ms] — Timing [ms] — CPU Usage
100% . .
Execution Time: 100%
Last: O
Avg: O
Min: 0
Max: 0 I
Sleep Time: 0%
0% A | | | __ Last: O PC
0 20 40 60 — Priority
g J Current: 50
0 6000 - New: 50
Last: 2 Min: 2
Avg: 2 Max:4 _Reset | -| Save the minimum cycle time in Hardware

Configuration to make it permanent.

— Timing Adjustment

Execution Time + Min Sleep Time

I Min Sleep Time [ms]: | 10

,— H " .
Min Cycle Time Min Cycle Time [ms]: | 0 Restore]

Figure 4-11  Tuning Panel for Adjusting the Operation of WinLC RTX
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The tuning panel also provides the following status information:

» Cycle Time (ms): provides a histogram of execution times (in ms) of the scans.
This histogram tracks minimum (shortest) and maximum (longest) execution
times, as well as the percentage of scans that fall in various ranges of
execution times. Clicking on the Reset button deletes the historical data and

starts a new histogram.

» Timing (ms): displays the execution time and the sleep time (in ms) for the last
scan. It also displays the average execution time, the minimum (shortest)
execution time, and the maximum (longest) execution time.

» CPU Usage: displays the total percentage for the processor capability known to
NT of the computer (PC). Because RTX applications (including WinLC RTX) run
separately from NT, the CPU usage figure does not reflect RTX usage.

Displaying the Tuning Interface

As shown in Figure 4-12, clicking on the Tuning icon of the control panel or
selecting the CPU > Tuning Panel menu command displays the tuning panel. If
you have enabled password control, you must enter the password in the dialog box
before the tuning panel appears. (For information about setting passwords, see
Section 4.9.) After you have finished tuning WinLC RTX, click on the Tuning icon to

hide the tuning panel.

Rl winLc RTX —[o] ]
Eile CPU Help
e Cycle Time [ms Timing [ms] —— [ CPU Usage
SIEMENS X = Exec?uEion!l'ime' °
: 100%
PS Last: O
Avg: 0
T Click the Tuning icon to display or hide the 0% I
e O controls for tuning the operation of WinLC RTX. pPC
EXTF STOP O
BUSF1 : J Current: 50
BUSFZ 0 6000 1 L e I e A B A NeW:50
FRCE Last: 2 Min: 2
RUN Avg: 2 Max:4 Reset = + Set
STOP — Timing Adjustment
Execution Time + Min Sleep Time
i P Min Sleep Time [ms]: | 10 Set I
[ . : .
Min Cycle Time Min Cycle Time [ms]:| O Restorel

Figure 4-12  Displaying or Hiding the Tuning Panel of WinLC RTX
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4.7

Running the WinLC RTX Controller

Closing the control panel does not shut down WinLC RTX: you must manually shut
down the WIinLC RTX controller or turn off the computer.

If you do not run WinLC RTX as an NT service, the control panel allows you to
start and stop WIinLC RTX. An Autostart feature allows you to start WinLC RTX
back up in the same operating mode (STOP, RUN, or RUN-P) that it was in before
it was shut down.

Note

You must have administration privileges to register WinLC RTX as a service.
When you run WIinLC RTX as an NT service, you start or stop WinLC RTX either
from the Services dialog box or by turning your computer on or off. The control
panel does not start or stop WinLC RTX.

To access the Services dialog box, use the Start > Settings > Control Panel
menu command to open the Windows NT control panel, then click on the Services
icon.

Registering and Unregistering WinLC RTX as an NT Service

4-16

The control panel provides a menu command for removing WinLC RTX from the
registry of NT services. See Figure 4-13. By unregistering WinLC RTX, you can
start or shut down the WIinLC RTX controller functions without having to turn the
computer on or off. However, this also means that WinLC RTX does not
automatically start running whenever you turn on your computer.

Eile Help

RUN-P
RUN

v STOP
MRES
Tuning Data

Start WinLC Controller
Shutdown WinLC Controller

Setting the PG/PC Interface
Options
FRCE
RUN

Removes WInLC RTX from the registry of
NT services

>

STOP | MRES

Figure 4-13  Unregistering WIinLC RTX as an NT Service
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Shutting Down and Starting the WinLC RTX Controller

Closing the WInLC control panel (window) does not shut down the WinLC RTX
controller: you must either change the controller to STOP mode, manually shut
down the WIinLC RTX controller, or turn off the computer.

Note

If WinLC RTX is not running as an NT service, you can use the WinLC control
panel to start or shut down the operation of the WinLC RTX controller.

To shut down the WinLC RTX controller, select the CPU > Shutdown WinLC RTX
Controller menu command from the WinLC control panel (as shown in
Figure 4-14). The WIinLC RTX controller then stops its operations.

To start the WIinLC RTX controller, select the CPU > Start WinLC RTX Controller
menu command from the WinLC control panel.

If WIinLC is running as an NT service, you must use the NT Services dialog box
(Start > Settings > Control Panel ) to start and stop the service “Siemens
WinLC RTX.”

File Help

RUN-P

RUN
v STOP

MRES Starts (activates) the WinLC RTX controller

Tuning Data ]

A

Start WinLC Controller

Shutdown WinLC Controllgg

Register WinLC as Service
Setting the PG/PC Interface
Options
FRCE
RUN

STOP | MRES

Figure 4-14  Shutting Down the WIinLC RTX Controller

>

Shuts down (deactivates) the WinLC RTX

controller
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Selecting the Autostart Feature

WinLC RTX includes an Autostart feature that defines how WinLC RTX responds
to shutting down and restarting. Based on the parameters shown in Table 4-1,
WinLC RTX starts in the specified operational mode.

You use the Customize dialog box to enable or disable the Autostart feature.

Table 4-1  Autostarting the WinLC RTX controller

If the WinLC RTX controller And the Autostart Then WinLC RTX starts
was running at shutdown ... feature is selected ... with this operating mode
No No STOP mode
No Yes STOP mode
Yes No STOP mode
Yes Yes RUN mode

Use the following procedure to enable the Autostart feature of WinLC RTX:

1. As shown in Figure 4-15, select the CPU > Options > Customize menu
command to display the Customize dialog box.

File Help

RUN-P
RUN

MRES

Tuning Data

Displays the Customize dialog box for

Start WinLC Controller
Shutdown WinLC Controller
Register WinLC as Service

Setting the PG/PC Interface

enabling or disabling the Autostart

CPU option

FRCE
RUN

STOP | MRES

Security
Connect CPU

Figure 4-15 Accessing the “Customize” Dialog Box
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In the Customize dialog box, select the General tab and select the “Autostart

CPU” option. See Figure 4-16.

3. Click Apply to enable the Autostart feature.

4,

Click OK to close the Customize dialog box.

General 1

Language

]

Station Type

— Display Options
[ Aways On Top

Select the “Autostart CPU” option.

Autostart CPU

— Startup Mode /

OK ||

Apply

Cancel

|| Help

Figure 4-16  Selecting the Autostart Feature
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4.8 Selecting the Language for WinAC

WinAC provides three languages for the software and help: German, English, and
French. The menus and help for the WinLC RTX are displayed in the language
selected. You can change the language from the control panel of WinLC RTX.

Use the following procedure to change the language for WinAC:

1. Select the CPU > Options > Customize menu command to display the
Customize dialog box.

2. In the Customize dialog box, select the “Language” tab.

3. Select the language for WinAC applications (German, English, or French). See
Figure 4-17.

4. Click Apply to change the language.

5. Click OK to close the Customize dialog box.

Note

The change in language for WinLC RTX does not become effective until you
restart the WinAC applications.

General Language ] Station Type ]
I
— Language Setting
Select the language for the menus
‘| english and _help files of the WinAC
applications.
deutsch /
francais
OK || Apply Cancel || Help

Figure 4-17  Selecting the Language for the WinLC Control Panel and Help Files
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4.9

Creating Levels of Security for Access to WinLC RTX

You use the WInLC control panel to create levels of security and limit access to
WinLC RTX:

» Select the security level: You can set WinLC RTX to request confirmation or
enable password-protection before allowing any changes.

» Configure the password to be valid for a specific amount of time: You can set a
specific length of “password free” time in which the user is not required to enter
another password when making changes. This length of time can be up to
23 hours and 59 minutes after the user has initially entered the password.

» Change the password: You can easily change the password with the Change
Password dialog box.

To access the Security dialog box, select the CPU > Options > Security menu
command from the WiIinLC control panel. See Figure 4-18.

File Help

RUN-P
RUN

MRES

Tuning Data

Start WinLC Controller
Shutdown WinLC Controller
Register WinLC as Service
Setting the PG/PC Interface

Customize

RUN Connect CPU

Displays the Security dialog box for
changing the level of security or for
changing the password.

STOP | MRES

Figure 4-18 Accessing the “Security” Dialog Box

Warning

Running the WIinLC RTX controller without confirmation or password protection
increases the risk that the operating mode could be changed inadvertently. This
could cause erratic behavior of the process or machinery being controlled, which
could cause damage to equipment or death or serious injury to personnel.

Exercise caution to ensure that you do not inadvertently change the operating
mode of the controller, or permit unauthorized persons to access the machine or
process controlled by WinLC RTX. Always install a physical emergency stop circuit
for your machine or process.

Windows Logic Controller WinLC RTX Overview
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Changing the Security Level for WinLC RTX

You can create levels of security and limit access to the controller. WinLC RTX
provides the following levels:

* None: No confirmation or password is required to access WinLC RTX.

» Confirmation: Any change made with the control panel (such as changing
operating mode or tuning the operations) requires confirmation by
acknowledging a message box.

» Password: Any change made with the control panel (such as changing
operating mode or tuning the operations) requires that the user enter a
password.

Use the following procedure to change the security level for WinLC RTX:
1. Select the CPU > Options > Security menu command.

2. In the Access verification dialog box, enter the password for WinLC RTX and
click OK. See Figure 4-19. (If the security level is set to “None” or no password
has been configured, simply click OK.)

Access Verification E
Enter the password and
/ click OK.
Enter Password: \|

Cancel I Help |

Figure 4-19  Entering the Password for WinLC RTX

3. In the Security dialog box (Figure 4-20), click on the option for password
(security level).

4. Click OK to enter the changes and close the Security dialog box.

1

Select the security level.

Password ———— B Password P ——
(= Password <+— | Hours: I 0 E
(" Confirmation [fies: ﬁgo
C None

Change Password

Cancel || Help ||

Figure 4-20 Setting the Security Level for WinLC RTX
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Creating or Changing the Password for WinLC RTX

The Security dialog box allows you to create or to change the password for WinLC
RTX. Use the following procedure for creating or changing a password:

1. Select the CPU > Options > Security menu command.

2. In the Access verification dialog box, enter the password for WinLC RTX and
click OK. (If the security level is set to “None” or no password has been
configured, simply click OK.)

3. In the Security dialog box, click the Change Password button. See Figure 4-21.

Password

Password Prompt Interval —

Hours: 0 E

(" Confirmation Minutes:

(" None /
|

Change Password

(= Password

Click on the Change Password button.

Cancel || Help ||

Figure 4-21  Accessing the “Change Password” Dialog Box

4. As shown in Figure 4-22, enter the following information in the Change
Password dialog box:

— Inthe “Old Password” field, enter the text string for the previous password.
— In the “New Password” field, enter the new text string for the password.

— In the “Confirm New Password” field, enter the text string for the new

password.
R |
Enter the old password and the
Old Password: \| new password.
Confirm the new password and
New Password: \| click OK.

Confirm New Password: \|

Cancel | Help

Figure 4-22 Changing a Password for WinLC RTX
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5.
6.

Click OK to change the password and return to the Security dialog box.

Make certain that the security level of WIinLC RTX is set to the Password option
and click OK to accept the changes and close the Security dialog box.

Note

If you create a password, but set the security level to “None” (disabling the
password), you will still need to enter the configured password before you can
access the Security dialog box again.

Making the Password Valid for a Specific Length of Time

By configuring the “validity” of the password, you set a specific length of
“password-free” time during which the user is not required to enter another
password when making changes. This length of time can be up to 23 hours and
59 minutes after the user has initially entered the password.

Use the following procedure to configure the validity for the password:

1.
2.

Select the CPU > Options > Security menu command.

In the Access Verification dialog box, enter the password for WinLC RTX and
click OK. (If the security level is set to “None” or no password has been
configured, simply click OK.)

In the Security dialog box, enter the length of time for the password to be valid.
See Figure 4-23.

— Enter up to 23 hours in the “Hours” field.
— Enter up to 59 minutes in the “Minutes” field.

Click OK to enter the length of validity for the password.

. Make certain that the security level of WinLC RTX is set to the Password

option, and click OK to accept the changes and close the Security dialog box.

Enter the length of
Password ——— Password Prompt Interval | “password-free” time (in
Q@ s Hours: 0 | hours and minutes) and
were || ciekok
C Confirmation Minutes: ﬁg
C None

Change Password

Cancel || Help ||

Figure 4-23  Configuring the Password Validity
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4.10 Saving and Restoring Your User Program

You can save the Load memory (user program) to an archive file. You can use this
archive file like a memory cartridge: you can easily restore the user program from
the archive file.

If you load your user program by restoring an archive file, the archive file is not
automatically restored again after a memory reset (MRES) operation (unlike the
behavior of an EPROM in a hardware PLC). You can use the File > Restore menu
command to perform this operation manually.

Creating an Archive File

As shown in Figure 4-24, you create an archive file by selecting the File > Archive
menu command from the control panel. A dialog box allows you to save the
archive file under a specific name. This allows you to store different archive files.

The archive file contains the user program and the hardware configuration (SDBS).

Restoring the Archive File

When you restore the archived file, you reload the user program and the hardware
configuration (SDBs). To reload a user program from an archive file, follow these
steps:

1. Click on the STOP button to place the controller in STOP mode.
2. Click on the MRES button to perform a memory reset.

3. Select the File > Restore menu command from the control panel (as shown in
Figure 4-24).

4. Select the specific archive file to reload.
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gpu ﬂilp/ Saves the user program to an archive file

e

Restores the user program from an archive file

INTF
EXTF
BUSF1
BUSF2
FRCE
RUN

STOP | MRES

Figure 4-24 WinLC RTX Archive and Restore Commands
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Chapter Overview

WinLC RTX is a programmable logic controller (PLC) that runs on your computer.
It communicates with the distributed (remote) I/O over a PROFIBUS-DP network.
For more information about using PROFIBUS-DP, see Chapter 6 and the SIMATIC
NET PROFIBUS User Manual.

This chapter describes the basic operation of WinLC RTX and includes the
following information:

» Elements of the WinLC RTX interface. For additional information, see Chapter 4
and the online help of the WinLC RTX software.

* Memory reset function (MRES) of the PLC memory

» Real-time clock. For more information, see the System Software for S7-300 and
S7-400 System and Standard Functions Reference Manual.

» Configuration of the WinLC RTX parameter blocks. For more information, see
the STEP 7 User Manual and the online help of the STEP 7 software.

Section Description Page

5.1 Mode Selector and Status Indicators of the WinLC RTX Control 5-2
Panel

5.2 Resetting the WinLC RTX Memory 5-5

5.3 Using the Diagnostic Information Stored in WinLC RTX 5-7

5.4 Understanding How WinLC RTX Operates if Windows NT 5-9
Crashes

55 Configuring the Operational Parameters of WinLC RTX 5-10

5.6 System Clock Supported by WinLC RTX 5-17
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5.1

Mode Selector and Status Indicators of the WinLC RTX Control
Panel

The WIinLC RTX control panel corresponds to the faceplate of the S7 controllers.
As shown in Figure 5-1, the control panel contains buttons for changing the
operating mode of the WinLC RTX controller, a button for resetting the memory
areas, and status indicators. For detailed information about resetting the WinLC
RTX memory, see Section 5.2.

Note
Indicators that are not applicable for WinLC RTX are “grayed-out.”

Eile CPU Help
SIEMENS

.

Changes the operating modes

Displays the status of the controller (WinLC RTX)

stop [ MRES |

Figure 5-1  Mode Selector Buttons and Status Indicators of the WinLC Control Panel

Selecting the Operating Mode

5-2

The RUN, RUN-P, and STOP buttons on the control panel correspond to the
different operating modes of the controller. Table 5-1 describes the operating
modes. Clicking on one of these buttons places WinLC RTX into the selected
operating mode.

To allow an external source, such as the STEP 7 programming software, to change
the operating mode of WinLC RTX, select RUN-P mode. If the operating mode is
changed by the external software, the selected button on the control panel does
not change, but the status indicators reflect the actual operating mode of WinLC
RTX.
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Table 5-1 Operating Modes of the WinLC RTX Controller

Mode Description

RUN-P | WIinLC RTX executes the user program. When WinLC RTX is in RUN-P mode
(RUN-PROGRAM mode), you can:

® Upload a program from WinLC RTX to your computer or programming device

®* Download a program to WinLC RTX

¢ Download individual blocks to WinLC RTX

® Use external software (such as STEP 7) to change the operating mode of WinLC RTX

RUN WinLC RTX executes the user program. When WinLC RTX is in RUN mode, you can upload
a program from WinLC RTX to your computer or programming device; however, you cannot
download a program to WinLC RTX.

STOP WinLC RTX does not execute the user program. When the controller is in STOP mode, you
can:

® Upload a program from WinLC RTX to your computer or programming device

®* Download a program to WinLC RTX

Running WIinLC RTX without Valid Authorization

If you lose the authorization for the software, WinLC RTX will continue to run,
although with less functionality. You will still be permitted to change from RUN
mode to STOP mode or from STOP mode to RUN mode, but you cannot change
WinLC RTX to RUN-P mode. WinLC RTX continues to execute the user program,
but you cannot modify the user program, and you cannot download a new program
or new blocks to WIinLC RTX.

Using the Status Indicators

The status indicators on the control panel show basic information about WinLC
RTX, such as the current operating mode or the presence of an error condition.
Table 5-2 describes the different status indicators for the control panel. You cannot
change the status of WinLC RTX by clicking on the status indicators.

If the user program reaches a break point set by the STEP 7 Program Editor, both
the RUN and STOP indicators turn on while the break point is active: the RUN
indicator flashes, and the STOP indicator is on.

During a restart, both the RUN and STOP indicators are turned on: the RUN
indicator flashes, and the STOP indicator is on during the restart; when the STOP
indicator turns off, the outputs are enabled.
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5-4

Table 5-2  Status Indicators

Indicator Description

ON Power supply. Always on for WinLC RTX.

BATTF Battery fault. Always off for WinLC RTX.

INTF This indicator lights up (solid) to show error conditions within the controller, such as
programming errors, firmware errors, arithmetic errors and timer errors.

EXTF This indicator lights up (solid) to show error conditions that exist outside of the
controller, such as hardware faults, parameter assignment errors, communication
errors, and I/O fault errors.

BUSF1 These indicators light up (either solid or flashing) to identify fault conditions in the

BUSF2 communication with the distributed 1/0O. See Table 6-5.

Since WiInLC RTX supports only one PROFIBUS-DP network, BUSF1 is the only
active indicator; BUSF2 is not applicable for WinLC RTX.

FRCE This indicator lights up (solid) to show that a force request is active.

Not applicable for WinLC RTX.

RUN Lights up (solid) to show the operating mode (RUN or STOP)
When RUN is flashing and STOP is lighted (solid):

STOP ® The controller is executing a restart. (Run light blinks with 2 Hz.)
® The user program has reached a break point. (Run light blinks with 0.5 Hz.)

All status When all of the status indicators are flashing, WinLC RTX has encountered an error

indicators are condition that cannot be fixed by resetting the memory (MRES). To recover from this

flashing condition, you must perform the following tasks:

1. Shut down the WIinLC RTX controller.
2. Restart the WinLC RTX controller.
3. Reset the memory (MRES).

If WIinLC RTX is running as a service, you must use the Windows NT control panel
to shut down and restart the WinLC RTX controller.
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5.2 Resetting the WinLC RTX Memory

The WinLC RTX control panel provides a MRES button for resetting the memory
areas to the default values and deleting the user program from the Load memory
and work memory areas.

You can also use STEP 7 to reset the WinLC RTX memory; however, WinLC RTX
must already be in STOP mode.

You normally reset the memory areas before downloading a new program to
WinLC RTX or restoring an archive file. You also reset the memory if the STOP
indicator on the control panel is flashing to alert you to the following conditions:

» Errors were detected in the work memory area.

» The size of the user program exceeded the work memory area.

Using the MRES Button to Reset the Memory Areas

The MRES button performs a memory reset on the memory areas. See Figure 5-2.
Clicking the MRES button places WinLC RTX into STOP mode and performs the
following tasks:

* WinLC RTX deletes the entire user program from both the work memory area
and the load memory area. This includes the data blocks (DBS).

* WiInLC RTX deletes the backup memory and resets the memory areas (I, Q, M,
T, and C) to 0.

After the memory has been reset, the diagnostics buffer remains intact, as does
the MPI address.
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Note

To reset the memory without using the mouse, press the ALT+C+M keys.

File CPU Help

SIEMENS

s

(O]\\

CPU RUN-P@
T INTF [RUN @
EXTE STOP @)

BUSF1
BUSF2
FRCE

RUN
B stor

To reset the WinLC RTX memory areas, click the
MRES button or press the ALT+C+M keys.

Figure 5-2 Resetting the WinLC RTX Memory with the WinLC Control Panel
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5.3 Using the Diagnostic Information Stored in WinLC RTX

As described in Section 5.1, the control panel provides indicators that display
information about the status of WinLC RTX. In addition to the status information,
you can use the STEP 7 programming software to read diagnostic and operational
information.

STEP 7 also provides additional tools for testing and monitoring a program running
on WIinLC RTX.

Monitoring the Diagnostic Information

When WinLC RTX encounters an error condition while in RUN mode (executing
the user program), WinLC RTX turns on the SF (system fault) indicator and writes
one or more entries to the diagnostics buffer. Based on the type of error and the
organization blocks (OBs) that were downloaded with the program, WinLC RTX
then either goes to STOP mode or executes the appropriate OB, which allows your
program to react to the error condition. For more information about the OBs which
are available for WinLC RTX, see Section B.2.

WinLC RTX stores diagnostic information in different registers and stacks. (You
can access this information from the Accessible Nodes menu command.)

Table 5-3 lists the types of information which can be viewed by using the tools
provided by STEP 7. For more information about viewing and using the diagnostic
information, see the online help for STEP 7 or the STEP 7 User Manual.

Table 5-3  Diagnostic Information Provided by WinLC RTX

Information Description

Communication Displays information about the transmission rates, communication connections,
communication load, and the maximum frame size for messages on the
communication bus.

Cycle time Displays the durations for the longest, shortest, and last scan cycle.

Diagnostic buffer | Displays the contents of the diagnostics buffer, including a description of the event
and the time and date that the event occurred.

General Displays general information about WinLC RTX, such as the project path, the
version number, and the order number

Memory Displays the current utilization of the Work memory and the Load memory of WinLC
RTX.

Performance data | Displays the memory configuration and the valid addresses for the controller.
Clicking on the “Blocks” button displays all of the blocks (OBs, SFBs, SFCs, FBs,
FCs, and DBs) which are available (including all priority classes).

Scan cycle time Displays information about the cycle time of the user program, including the longest
cycle time, the shortest cycle time, the minimum cycle time, and the last cycle time.

Stacks Displays the contents of the B Stack (block stack), the | Stack (interrupt stack), and
the L Stack (local data stack)

Time system Displays information about the current time, the operating hours, and the
synchronization of the system clock.
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Monitoring and Modifying the Variables in the User Program

STEP 7 provides tools for monitoring the status of a user program running on
WinLC RTX. You can also use STEP 7 to modify the value of the process variables
used by your program. For more information about monitoring and modifying the
process variables in a program, see the online help for the STEP 7 programming
software or the STEP 7 User Manual.

WinLC RTX allows you to use the STEP 7 tools to perform the following tasks:

» Monitoring variables: You can monitor the status of the different process
variables used in your program. You can view the status of your program either
with a status chart or by turning on the status option in the Program Editor.

* Modifying variables: You can modify a process variable by entering a specific
value. By changing the values of the process variables, you can monitor the
behavior of your program. You can modify variables with a status chart.

Viewing a Status Block

You can monitor a block with regard to the program sequence for support in startup
and troubleshooting. The status block allows you to monitor the contents of
registers, such as the address register, the status register, and the DB registers,
while WinLC RTX is executing the user program.
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Understanding How WinLC RTX Operates if Windows NT
Crashes

WinLC RTX supports OB84 (CPU Hardware Fault), which allows you to initiate the
shutdown of your process in case Windows NT detects an unrecoverable fault or
STOP error while WinLC RTX is running. If WinLC RTX is still able to run after
Windows NT has initiated the system shutdown procedure, one of the following
occurs:

* If WInLC RTX is in RUN mode and the user program includes OB84, WinLC
RTX starts OB84 and continues in RUN mode until the user program calls
SFC46 (STP) to place the controller in STOP mode. After WinLC RTX
transitions to STOP mode, Windows NT completes its system shutdown.

* If WInLC RTX is in RUN mode and the user program does not include OB84,
WinLC RTX transitions to STOP mode and Windows NT completes its system
shutdown.

* If WInLC is in STOP mode or if the user program does not include OB84,
Windows NT completes its system shutdown.

» If NT is configured to automatically reboot after a STOP error occurs, WinLC
automatically restarts if it is configured to run as a service. (To configure
automatic reboot, open the System Properties dialog box, select the
Startup/Shutdown tab, then check the “automatically reboot” checkbox.)

Note

When WiInLC is restarted, it will use the program as it was last downloaded and
will execute OB100 if it is present. Event 1382 is used to start OB100.The
current/last startup type is shown in the diagnostic buffer as “automatic warm
reboot after non-backup power on with system memory reset”. If you want to
check for this condition in OB100, see the System Software for S7-300/400
System and Standard Functions Reference Manual.

OB100 is always executed after an NT failure, even if OB102 “Cold start” is
configured in the STEP 7 Hardware Configuation.

The following restrictions apply:
» The WInLC control panel is unavailable.

» Communication with external systems (such as HMI devices or programming
devices) may be unavailable.

» Some system functions may be disabled.

» Cycling the power to the computer initializes all of the program variables to their
default values.
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Configuring the Operational Parameters of WinLC RTX

STEP 7 provides the tool for configuring the characteristics and behavior of WinLC
RTX. You use the Hardware Configuration tool to display a dialog that configures
the operational characteristics for WinLC RTX. This configuration is then stored in
SDBO. Table 5-4 lists the different parameters that can be configured. For more
information about configuring the operational parameters, see the STEP 7 User
Manual.

After you download SDBO, the controller uses the configured parameters for the
following events:

» Whenever you start up the controller

» On the transition to RUN mode (if you modified the hardware configuration
online while WinLC RTX was in STOP mode)

Table 5-4 WiInLC RTX Configuration Parameters Provided by STEP 7

Parameters Description
General Provides information about WinLC RTX
Startup Defines the operational characteristics of WinLC RTX for powering on or

going to RUN mode

Cycle/Clock Memory Cycle: defines any constraints on the scan cycle (such as the minimum
scan cycle time and the size of the process image)

Clock Memory: defines a memory byte to function as a “clock
memory”—each bit of this byte toggles on and off at a different frequency

Interrupts Configures the operation of the time-of-day interrupts (OB10)

Time-Of-Day Interrupts Defines the priority for the hardware interrupts (OB40), the time-delay
interrupts (OB20), and the asynchronous error interrupts (OB82, OB83,
0B85, and OB86)

Retentive Memory Defines the memory areas (M, T, and C) as well as the DBs to be retained
following a power failure or a transition from STOP mode to RUN mode

Cyclic Interrupt Defines the operation of the cyclic interrupts (OB35, OB36)

Diagnostics/Clock Defines the reporting of diagnostic errors and the synchronization and the

correction factor for the WinLC RTX clock

Memory Defines the amount of local data (L memory) for each priority class
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Configuring the Startup Characteristics

Using the Startup tab of the STEP 7 Hardware Configuration, you can configure
WinLC RTX to perform certain tasks before going to RUN mode. Table 5-5 lists the
parameters for configuring the startup characteristics.

Table 5-5 Parameters for the Startup Characteristics

Parameter Description Range Default
Startup on setpoint Reserved for future use. Not applicable | Yes
configuration not equal to actual
configuration
Startup after Power On WinLC RTX provides a cold restart | Warm restart Warm restart
(OB102) and a warm restart Cold restart
(OB100).

Configuring the Clock Memory

Using the Cycle/Clock Memory tab of the STEP 7 Hardware Configuration, you can
configure a byte of the bit memory (M) area to function as a “clock memory.”
Table 5-6 lists the parameters and ranges for configuring a clock memory.

Table 5-6  Parameters for Configuring a Byte as Clock Memory

Parameter Description Range Default
Clock Enables the clock memory (if enabled, you must enter a | Yes or No No
Memory memory byte address)

Memory Byte | Defines a memory byte (MB) to function as a clock 0 to maximum Disabled
memory for M memory

When this byte has been configured as clock memory, the bits turn on and off (with
a duty cycle of 1:1) at fixed frequencies. (The eight bits in the byte yield eight
different, fixed frequencies.) Figure 5-3 shows the frequencies of the different bits
for the byte used as clock memory.

Bt 76 543210

| Frequency
L 0.15sec. (10 Hz)
0.2 sec. (5 Hz2)
-——— 0.4 sec. (2.5 Hz)
0.5 sec. (2 Hz)
0.8 sec. (1.25 Hz)
1.0 sec. (1 Hz)

1.6 sec. (0.625 Hz)
2 sec. (0.5 Hz)

Figure 5-3  Clock Frequencies for the Memory Byte Configured as Clock Memory
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Configuring the Scan Cycle

5-12

Using the Cycle/Clock Memory tab of the STEP 7 Hardware Configuration, you can
configure WinLC RTX to control certain aspects of the scan cycle. Table 5-7 lists
the parameters for configuring the scan cycle. For more information about the scan
cycle, see Section 4.6.

Note

The minimum cycle time of WinLC RTX encompasses both the time required for
executing the user program and the sleep time (which allows your computer to
perform other tasks).

WinLC RTX monitors the execution time of the scan cycle. If the scan cycle
(program execution time plus the sleep time) exceeds the scan cycle monitoring
time (watchdog), WinLC RTX starts an error OB. The scan cycle monitoring time
must be greater than the maximum execution time for the scan cycle plus the
configured sleep time.

Table 5-7  Parameters for Controlling the Scan Cycle

Parameter Description Range Default
Scan cycle Enters the maximum time for the scan cycle plus the sleep time | 1to 6000
monitoring for the controller. This value must be larger than the value for 6000 ms
time the minimum scan cycle time.

The following list gives a few examples of events that could
cause the controller to exceed the limit on maximum cycle time:

® Starting other PC applications
® Anincreasing humber of interrupts in the program
® Processing an error in the user program

Minimum Enters the minimum time for the scan cycle. This value includes | 0 to 0
scan cycle both the execution time of the user program and the sleep time | 6000 ms
time of WinLC RTX. For more information about the scan cycle, see

Section 4.6.

The minimum scan time allows you to determine the percentage
of processing time of your computer to dedicate to the
controller. For example: if you entered a minimum scan time
that is twice as long as the actual execution time of the user
program, 50% of the processing time would be dedicated to
WinLC RTX and 50% could be used by another application
(based on process priority).
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Configuring the Retentive Areas of Memory

Using the Retentive Memory tab of the STEP 7 Hardware Configuration, you can
configure the following areas of memory to be retained in the event of loss of
power or on a transition from STOP mode to RUN mode:

» Memory bytes: up to 256 bytes (from MBO to MB255)

e S7timers: up to 128 timers (from T O to T 127)

e S7 counters: up to 64 counters (from C 0 to C 63)

Table 5-8 lists the parameters for configuring the retentive memory areas.

In the event of a transition from STOP mode to RUN mode, WinLC RTX does not
reset the values which are stored in the timers, counters, and memory bytes that
are configured to be retentive. All DBs are retentive.

In the event of a power failure while the controller is running, the current values are
lost. If you close the WinLC RTX software before the power failure, the values are
retained according to the configured parameters shown in Table 5-8.

Note

DBs that were created by SFC22 (CREATE_DB) are not retained following a cold
restart.

Table 5-8 Parameters for Configuring the Retentive Memory

Parameter Description Range Default
Memory Enters the number of memory bytes to be retained (starting 0to 256 16
Bytes from MBO)

S7 Timers Enters the number of S7 timers to be retained (starting from Oto 128 0
T0)

S7 Counters | Enters the number of S7 counters to be retained (starting Oto 64 8
from C 0)
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Configuring the Time-of-Day Interrupt

WinLC RTX supports one time-of-day interrupt (OB10). Using the Time-of-Day tab
of the STEP 7 Hardware Configuration, you can configure OB10. Table 5-9 lists the
parameters for the time-of-day interrupt.

Table 5-9  Parameters for Configuring the Time-of-Day Interrupt

Parameter Description Range Default
Active Determines whether OB10 is automatically activated | Yes/No No
following a warm restart
Execution Selects the frequency for executing OB10 None None
Once
Once per minute
Hourly
Daily
Weekly
Monthly
End of the month
Yearly
Start Determines the starting date and time for executing Any valid date 01.01.94
Date/Time OB10 and time 00:00:00
® Date: day.month.year
® Time: hours:minutes:seconds (24-hour format)

Configuring the Interrupts

Using the Interrupts tab of the STEP 7 Hardware Configuration, you can configure
the priority class for some of the interrupt OBs supported by WinLC RTX.
Table 5-10 lists the parameters for the different interrupts.

WinLC RTX has the following restriction: you cannot change the priority class for
OB20 (time-delay interrupt).

Table 5-10 Parameters for Configuring the Priority Class of the Interrupts

Interrupt Description Range Default
Time-Delay You cannot change the priority class for 0,2t0 24 3
0OB20 the time-delay interrupt
Asynchronous Error Defines the priority class for the OB80: 26 OB80: 26
OB80 to OB87 asynchronous error interrupts OB81 to OBS7: | OB81 to OBS7:
2410 26 26
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Configuring the Cyclic Interrupt

WinLC RTX supports one cyclic interrupt (OB35). Using the Cyclic Interrupts tab of
the STEP 7 Hardware Configuration, you can configure time interval for executing
OB35. Table 5-11 lists the parameters for the cyclic interrupt.

Table 5-11 Parameters for Configuring the Cyclic Interrupt

Parameter Description Range Default
Priority Determines the priority class of the cyclic interrupts (OB35, 0,2to24 | OB35: 12
0OB36) 0B36: 13

Execution Determines the time interval (in milliseconds) for executing 0 to 60000 | OB35: 100
the cyclic interrupts OB36: 50

Phase Offset | Defines an amount of time that the start of a cyclic interrupt 0to 60000 | O
can be delayed in order to allow another cyclic interrupt to
finish

Based on the interval that was configured, WinLC RTX starts the execution of
OB35 at the appropriate interval. For best results, choose an interval greater than
10 ms. Selecting an interval of less than 10 ms can cause OB35 not to be
executed at the scheduled time. The causes for OB35 not being executed can
include:

» The program in OB35 takes longer to execute than the interval allows.

* Programs in other priority classes frequently interrupt or take longer to execute,
which causes the controller not to execute OB35 at the scheduled time.

» A programming device performs some task or function that causes the
controller not to execute OB35 at the scheduled time.

The sleep time of the WIinLC RTX scan cycle (see Section 4.6 and Figure 4-10)
does not affect the execution of OB35: WinLC RTX executes OB35 at the
appropriate interval regardless of the amount of sleep time that you configure for
the scan. (See Section 4.6.) Having OB35 run too frequently or require too much of
the time allotted for the total scan could cause the watchdog timer to time out
(calling OB80 or going to STOP mode).

Assigning the Parameters for Diagnostics

Using the Diagnostics/Clock tab of the STEP 7 Hardware Configuration, you can
configure how WIinLC RTX responds to the various events that are recognized and
evaluated during the execution of the user program. Table 5-12 lists the
parameters for configuring the handling of diagnostic events.

WinLC RTX can recognize certain diagnostic events, such as an error in the user
program, a failed module, or an open circuit on the connector of a module. Events
that are not transmitted to WinLC RTX (such as a defective motor) must be
handled by the user program by some error detection program for the process.
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Table 5-12 Parameters for Configuring the Diagnostic Activities

Parameter Description Range Default
Display Cause of | Determines whether to send the last message (the most Yes/No | Yes
STOP recent) in the diagnostic buffer to the registered display unit
Synchronization Determines whether to use the WinLC RTX clock to None or | None
on MPI synchronize the clocks of other controllers: As Slave

® None: no synchronization

® As Slave: WIinLC RTX clock is synchronized from
another clock

Correction Factor | Compensates for a loss or gain in the clock time within a -99999 0
(ms) 24-hour period. Value is entered in milliseconds (1 second = | to 99999
1000).
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5.6 System Clock Supported by WinLC RTX

WinLC RTX supports a real-time clock. The user program being executed by the
controller can access this information by using different SFCs. The real-time clock
is based on the hardware clock of the computer that is running WinLC RTX.

You can use the STEP 7 programming software to set the system clock of the
controller to a time that is different from that of the hardware clock of your
computer. If you close the WIinLC RTX application, this difference from the
hardware clock is maintained: when you open the WinLC RTX application again,
the system clock of the controller reflects the passage of time while the WinLC
RTX application was closed.

Using the Real-Time clock

The default setting for the system clock is the default date and time for the
hardware clock of your computer.

You can also use SFCO (SET_CLK) and SFC1 (READ_CLK) to set and read the
system clock. For more information about using these SFCs, see the System
Software for S7-300 and S7-400 System and Standard Functions Reference
Manual.
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Chapter Overview

The WInLC RTX controller uses a PROFIBUS-DP network to communicate with
the distributed 1/O. The controller is the DP master station, and the I/O modules
(for example, ET 200B or ET 200L) are the DP slave stations. An S7 CPU (such as
the CPU 315-2 DP) can also function as an intelligent slave device.

You use the hardware configuration tools of the STEP 7 programming software to
assign the addresses and other parameters for WinLC RTX (DP master) and the
I/O (DP slaves). For more information, see the online help for STEP 7
programming software and the STEP 7 User Manual.

For more information about DP communications and setting up PROFIBUS
networks, refer to the SIMATIC NET PROFIBUS User Manual.

Section Description Page
6.1 Guidelines for Configuring the PROFIBUS-DP Network 6-2
6.2 Determining the Physical Layout of the Network 6-6
6.3 Assigning the Addresses for the Distributed 1/10 6-8
6.4 Starting the PROFIBUS-DP Network 6-13

Windows Logic Controller WinLC RTX Overview
A5E00083518-01 6-1



Configuring the PROFIBUS-DP Network

6.1

Guidelines for Configuring the PROFIBUS-DP Network

PROFIBUS-DP (Process Field Bus - Distributed Peripherals) is an industry
standard for process communications with distributed peripherals. WinLC RTX
uses PROFIBUS-DP to connect to its distributed I/O. Digital, analog, and intelligent
I/O (including field devices such as drives and valve terminals) can be installed as
distributed 1/0 on the PROFIBUS-DP network.

The PROFIBUS-DP network connects the controller with the distributed 1/0
modules. The controller and the I/O modules are called “nodes” or “stations”
WinLC RTX must be the master node (DP master) and the distributed I/O are the
slave nodes (DP slaves). You can connect up to 125 DP slaves for WinLC RTX. A
network consists of one or more segments. Each segment can have up to 32
nodes (including repeaters on either end of the segment).

Note

Both WinLC RTX and the communications processor CP 5613 support a total of
125 DP slaves.

Device Types

Cabling

6-2

Devices connected to a PROFIBUS-DP network are referred to as “nodes” or
“stations”: A node may be a DP master (controlling) or a DP slave (controlled)
node. For DP networks used by WinLC RTX, WinLC RTX is the master node and
the distributed I/O devices are slave nodes.

Each node on a DP network must have a unique node address. Node addresses
can be assigned in the range 0..125. You can connect up to 126 nodes on a DP
network. Since WinLC RTX counts as one of these nodes, this means that WinLC
RTX can control up to 125 DP slaves.

A DP slave can consist of one or more modules. The modules may be integrated
into the node (ET200B) or they may be separately installable (ET200M).

From a cabling view point, a DP network consists of one or more segments, where
segment is the bus line between two terminating resistors. The nodes are
connected in series to a network segment. The first and last nodes of a segment
must have a powered termination circuit switched to the “On” position whenever
the network is operational. All other nodes of the segment must have their
termination circuits switched to the “Off” position.
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Network segments are connected using repeaters. A DP network can have many
segments as long as the following guidelines are observed:

* A maximum of ten segments can be connected in series. In other words, the
signal path from any node on the network to any other node on the network
must not pass through more than nine repeaters.

* No segment can have more than 32 nodes. The repeaters connected to a
segment count in the node count for the segment.

* No segment can exceed the maximum cable length allowed for the baud rate
used by the network.

Figure 6-1 shows a sample network consisting of a single segment with three

nodes.
Master WinLC RTX Slave ET 200M Slave ET 200M
I Nl nl I 1l
S I 1 = R
L[] r
wil 1L
o t eammen e
J

Figure 6-1  Sample PROFIBUS-DP network

Assigning the Node Addresses

You must assign a node address for each node on the network (from 0 to 125).
Each address must be unique. You do not assign a node address to a repeater.

The default address for the DP master (WinLC RTX) is 2. Typically, you would
reserve address 0O for a programming device that is to be connected temporarily for
maintenance or commissioning. Figure 6-2 shows a sample PROFIBUS-DP
network with typical addresses for the nodes.

Depending on the type of device, a node address may be assigned using physical
switches on the device or using a configuration tool. Consult your device
documentation for the procedure required for your specific PROFIBUS-DP device.

Note

You are not required to assign consecutive addresses; however, performance is
improved when the addresses are consecutive.
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ETHZOOM _ ET 200B ET 200B ET 200B
o |
O
|
=1L
J

Terminating L
resistor is on

Address 2 Master  Address 3 Slave Address 4 Slave

WinLC RTX ET 200M ET 200M Address 5 Slave
i = i = S5-95U
o LI B
- - aft(d
ol A s
alll UG ol

Address 9 Slave Address 8 Slave Address 7 Slave Address 6 Slave

Figure 6-2  Typical Addresses for a PROFIBUS-DP Network

Installation Guidelines

Use the following guidelines for configuring and installing your DP network:

6-4

Before connecting a node to the network, insure that its node address has been
correctly set. Depending on the device, you may need to use the STEP 7
programming software to assign both the PROFIBUS node address or you may
need to set the address using switches on the device. (You do not assign

a node address to repeater.) Clearly label each node with its node address.

Reserve node address 0 for a programming device that will be connected to the
network on a temporary basis (such as to provide maintenance or
commissioning).

Turn on the terminating resistor for the nodes on either end of a network
segment. For all other nodes, ensure that the terminating resistor is turned off.

To connect more than 32 nodes on the network, use repeaters to create
additional segments for the network.

You can connect multiple segments to create a network; however, the signal
path between any two nodes of the network must not cross more than ten
segments. While each segment can consist of up to 32 nodes, the total network
cannot exceed 126 nodes.

When adding a new node to the network, turn off the power to the node before
connecting it to the network.
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Use spur lines to connect any programming device or operator panel that will be
used for startup or maintenance. If your network communicates at 3 Mbaud or
more, use a special high-speed cable.

All of the nodes in a segment must be connected in a linear construction (in a
row from one node to the next). If your network communicates at 3 Mbaud or
more, use special high-speed bus connectors.

Guidelines for Using Repeaters

Use the following guidelines for networks that utilize repeaters:

Use repeater modules to connect segments of the network or to extend the
cable length between nodes, or to connect non-grounded bus segments with
grounded bus segments.

You do not assign a node address to the repeater.

Each repeater on the network segment counts as a node (against the maximum
number of 32 nodes for the segment) and reduces the number of available
nodes that you can connect to the segment.

Even though the repeater counts as one of the 32 nodes (maximum) that can
be physically connected on a segment, the repeater is not included as one of
the 126 addressable nodes (maximum) for the PROFIBUS network.
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6.2

Determining the Physical Layout of the Network

The requirements of the distributed 1/0O determine the physical layout of the
network. These factors include the distance between stations, the number of
nodes, and the different types of nodes being used.

Determining the Maximum Length of a Segment

6-6

Each segment of the PROFIBUS-DP network is limited to a maximum distance (or
cable length). As shown in Figure 6-3, the maximum length of cable for a segment
is measured between the nodes that have terminating resistors.

Address 2 Address 3 Address 4
Master Slave Slave Address 5
WinLC RTX ET 200M ET 200M Slave
i = i = S5-95U
s L B
Sl ERl Bk
il al; i L

J

Terminating l«——— Maximum cable length ——»]

resistor is on for the segment

Figure 6-3 Maximum Cable Length for a Segment

The maximum distance for a segment is determined by the baud rate of the
communication. Table 6-1 lists the maximum length of a segment for the baud
rates which are supported by PROFIBUS-DP. For example, if the segment shown
in Figure 6-3 uses 187.5 Kbaud, the maximum cable length is 1000 m (3280 ft.).

Table 6-1 Baud Rate and Maximum Cable Length

Baud Rate Maximum Cable Length
9.6 Kbaud 93.75 Kbaud 1200 m (3936 ft.) with an isolated interface
19.2 Kbaud
187.5 Kbaud 1000 m (3280 ft.) with an isolated interface
500 Kbaud 400 m (1312 ft.)
1.5 Mbaud 200 m (656 ft.)
3 Mbaud 12 Mbaud 100 m (328 ft.)
6 Mbaud
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Using Repeaters to Extend the Maximum Length

To communicate over distances which are greater than the maximum cable length
allowed in Table 6-1, you must use a repeater with the network. In the example
shown in Figure 6-4, two repeaters connect two nodes at a distance of 1100 m
(3608 ft.), which is longer than the 1000 m (3280 ft.) maximum.

The maximum distance between two repeaters corresponds to the maximum cable
lengths of a segment (see Table 6-1). You can connect up to nine repeaters in
series.

The repeater counts as a node, but is not assigned a PROFIBUS address.

Address 2 Master Address 3 Slave
WinLC RTX Repeater Repeater ET 200M

L=

[—— —]
——1

)

50 m (164 ft.) 1000 m (3280 ft.) 50 m (164 ft.)
Figure 6-4  Using Repeaters to Increase the PROFIBUS Cable Length

Using Spur Lines

You can use a spur line to connect a node to a terminal block or other connector,
instead of connecting the node directly to the PROFIBUS-DP cable. Table 6-2 lists
the maximum lengths for spur lines. For networks that communicate at 3 Mbaud or
greater, use a special, high-speed cable (order number 6ES7 901-4BD00-0XA0).
This cable also allows you to connect more than one programming device.

Table 6-2 Length of Spur Line per Segment

Baud Rate Maximum Length Number of Nodes for Spur Line Length of:
per Segment 15m (4.9 ft) 3m (9.8 ft)

9.6 Kbaud to 96 m (314.8 ft.) 32 32
93.75 Kbaud
187.5 Kbaud 75 m (246.0 ft.) 32 25
500 Kbaud 30 m (98.4 ft.) 20 10
1.5 Mbaud 10 m (32.8 ft.) 6 3
3 Mbaud to Use the high-speed cable (order number 6ES7 901-4BD00-0XA0). (Spur
12 Mbaud lines are not allowed.)
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6.3 Assigning the Addresses for the Distributed I/O

You specify the PROFIBUS-DP configuration using the hardware configuration tool
of the STEP 7 programming software. This includes specifying the node and
diagnostic addresses for each node of the network as well as the logical addresses
for the 1/0 data presented to WinLC RTX by the modules for each node. The
PROFIBUS-DP configuration must be downloaded to WinLC RTX before you
attempt to operate the PROFIBUS network.

As stated previously, each node of the DP network has a unique node address.
This address is used by the DP Master to communicate with its DP slaves;
however, the user program generally does not use the node address to reference a
data. Instead, as part of the configuration process, the user assigns a “diagnostic”
address to the node and a “logical” address range to the Input and Output data
areas of the node’s modules. This is accomplished using the hardware
configuration tool of the STEP 7 programming software. Table 6-3 provides an
overview of the addresses which may be assigned to the distributed 1/O for WinLC
RTX.

Table 6-3 Address Ranges for the Distributed /0O

Address Areas Size
Process image areas 512 bytes:  I1BO to IB511
QBO to QB511
1024 bytes: 1BO to 1B1023
QB0 to QUAY1023
Total amount for the distributed 1/O (accessed by | 16 Kbytes:  PIBO to PIB16383
Load and Transfer instructions) PQBO to PQB16383
Total amount for consistent data (accessed by Up to 16 Kbytes (16384 bytes) for
SFC14 and SFC15) inputs and 16 Kbytes (16384 bytes) for
outputs
Maximum size per SFC14 or SFC15 240 bytes
Maximum Input/Output data for one node Up tol122 bytes

Specifying the Node Addresses

When you place a DP device into the WinLC RTX configuration using the hardware
configuration function of STEP 7, you are prompted to enter the node address for
the device. This address identifies the node to the DP master system. The default
node address for WinLC RTX is 2. As slaves (/O modules/racks) are placed on
the DP “wire,” STEP 7 displays a default node address. You can change this
address as required.

Windows Logic Controller WinLC RTX Overview
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Specifying the Logical I/O Address

During the configuration of WinLC RTX, the 1/O data of each module of the
PROFIBUS-DP network is allocated a logical address in the input and/or output
area. You use these addresses to access the input or output data for the module.
Additionally, a base (lowest logical) address for the module is used by WinLC RTX
to report module events to the user program.

Table 6-4 lists the methods for accessing the distributed 1/O:

» To access data as bytes, words, or double words (that is, as 1 byte, 2 bytes, or
4 bytes), use the Load (L) and Transfer (T) instructions (for statement list) or
the Assign Value (MOVE) instruction (for ladder logic) to read and write the
distributed inputs and outputs. See Figure 6-5. I/O data may be accessed from
the process image (l) area or from the peripheral image (PI) area.

» To access data that has consistency of 3 bytes or more than 4 bytes (up to
240 bytes), use SFC14 (DPRD_DAT) and SFC15 (DPWR_DAT). SFC14 and
SFC15 always access the module’s peripheral image.

Table 6-4  Accessing the Distributed /O

Type of Access Method
Accessing data in byte, word (2-byte), or | Use the the following instructions:
double-word (4-byte) units * The Load instruction reads 1,2, or 4 bytes of
Data integrity is 2 bytes for accessing inputs from the | or Pl area.
words, and 4 bytes for accessing double |«  The Transfer instruction writes 1,2, or
words. 4 bytes of outputs to the Q or PQ area.

Accessing consistent data in units other | Use the following SFCs:
than 1 byte, 2 bytes and 4 bytes (upto |«  SFC14 copies up to 240 bytes from a
240 bytes) module’s inputs to the |, Q, M, D or L area.

* SFC15 writes up to 240 bytes from the I, Q,
M, D, or L area to a module’s outputs.

As shown in Figure 6-5, the user program can access up to 16384 bytes (each) of
inputs and outputs by using the Load (L) and Transfer (T) instructions (for
statement list) or the Assign Value (MOVE) instruction (for ladder logic).

Note

You may access any byte of the Process Image (1,Q) area, whether the byte is
assigned to physical /0O or not; however, you may only access addresses actually
assigned to physical I/O when accessing the Peripheral Image (Pl, PQ) or when
using SFC14 or SFC15.

Windows Logic Controller WinLC RTX Overview
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6-10

Distributed I/O
Input Address Area
Process-
Image Inputs .
0] Accessible
by Load
instructions
16384
Inputs ]
(PD bytes
]
I
] 240 bytes
(max.)
240 bytes
Diagnostic addresses (max.)
(1 byte for each DP slave)
Output Address Area
Process- Byte O .
Image Outputs Accessible
Q) 7 by Transfer
instructions
Byte 511 or Byte 1023
16384
Outputs bytes
(PQ)
240 bytes
(max.)
N 240 bytes
(max.)
- Allocated addresses

Figure 6-5  Accessing the Distributed 1/0

SFC14 and SFC15 can access blocks of data up to 240 bytes:

SFC14 copies the complete block of data from the module’s inputs to any of the
specified memory areas.

SFC15 writes the complete block of data from any of the specified memory
areas to the module’s outputs.
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For information about the Load (L) and Transfer (T) instructions, see the online
help for the STEP 7 programming software and the Statement List (STL) for
S7-300 and S7-400 Programming Manual. If you are programming in ladder logic,
see the Assign Value instruction (MOVE) in the Ladder Logic (LAD) for S7-300 and
S7-400 Programming Manual.

For information about SFC14 (DPRD_DAT) and SFC15 (DPWR_DAT), see the
System Software for S7-300 and S7-400 System and Standard Functions
Reference Manual.

Specifying the Diagnostic Addresses

During the configuration of WinLC RTX, each node of the DP Network is allocated
a diagnostic address in the peripheral input (PI) area. You use the diagnostic
address in parameters for the SFCs that access the node’s diagnostic data (for
example, the LADDR parameter of SFC13). This address is also used by WinLC
RTX to report node state changes (in OB86) to the user program.

Note

STEP 7 documentation sometimes refers to the diagnostic address for the node
as the “logical base address” of the slave or station, as opposed to a logical base
address for the module.

As you use the STEP 7 hardware configuration tools to configure WinLC RTX and
the PROFIBUS-DP network, these diagnostic addresses are assigned above the
process-image input (I) memory area. See Figure 6-6. If you do not enter a specific
address, STEP 7 allocates 1B16383 for the first DP slave, PIB16382 for the
second, and so forth.

For more information about configuring the DP diagnostic addresses, see the
online help for the STEP 7 programming software, the STEP 7 User Manual, and
the SIMATIC NET PROFIBUS User Manual.

Process- Byte0
Image
Inputs

DP Slave 2
Distributed I/O

DP Slave 1

Byte 511 or Byte 1023

Diagnostic addresses
- (1 byte for each DP slave)
-

Byte 16383 <——— Diagnostic address for DP Master

Figure 6-6  Diagnostic Addresses for the Distributed I/O
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Troubleshooting for Network Problems

WinLC RTX provides powerful features to help you diagnose DP network
problems:

» The WiInLC control panel provides two status indicators (EXT1 and BUSF1) that
can be used to diagnose problems with the PROFIBUS-DP network. Table 6-5
describes the activity of the EXTF and BUSF1 indicators to help you determine
the type of problem and a possible solution.

» In addition to these visual indicators, you can use the Diagnose Hardware
feature of the STEP 7 programming software to determine which nodes are
experiencing problems and to determine the nature of the problem.

Table 6-5 Using the EXTF and BUSF1 Indicator

EXTF BUSF1 Description Action

Off Off No configuration Ensure that the DP configuration has
been entered into your STEP 7
project. Download the project’s
System Data container to WinLC
RTX.

Off Off Normal operation The configured DP slaves are
responding. No action is required.

On Flashing Station failure Check to see that the bus cable is
connected to WinLC RTX (the CP
card) and that all segments are
correctly terminated at powered

nodes.

Check to see that the bus is not

interrupted.
At least one of the Wait for WinLC RTX to complete the
DP slaves could not be power-on cycle. If the indicator
accessed continues to flash, check the

DP slaves or evaluate the diagnostic
data for the DP slaves.

On Off Diagnostic error Indicates that a fault condition has not
been cleared or that a DP module
with diagnostic capability has initiated
0oB82.

Windows Logic Controller WinLC RTX Overview
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6.4 Starting the PROFIBUS-DP Network

There are two elements of the hardware configuration in the STEP 7 programming
software that affect the PROFIBUS-DP network:

The Startup tab of the STEP 7 Hardware Configuration configures the startup
parameters for the WinLC RTX controller. These parameters are stored in the
System Data container, which is downloaded with the user program from
STEP 7 to the controller.

The STEP 7 Hardware Configuration also maintains the PROFIBUS-DP
network configuration. This information is stored in the System Data container,
which is downloaded with the user program from STEP 7 to the controller.

For more information about configuring the PROFIBUS-DP and the startup
parameters for the controller, see Section 5.5 (and Table 5-5), the online help for
the STEP 7 programming software and the STEP 7 User Manual.

Turning On the Network

After configuring the PROFIBUS-DP network, use the following procedure to turn
on the network:

1.

With the controller in STOP mode, download the configuration of the
PROFIBUS-DP network. You can download just the System Data (hardware
configuration) or you can download all of the blocks of the user program.

Turn on all of the DP slaves on the PROFIBUS-DP network.

3. Wait until the EXTF and BUSF1 LEDs are both off.

Switch the operating mode of the controller from STOP to RUN.
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Responding to Diagnostic Events

If an error is detected by the controller, the error condition is logged in the
diagnostics buffer as a diagnostic event. The diagnostic events that are typically
associated with distributed 1/0 can cause the controller to execute the following
OBs:

» OB40 responds to hardware interrupts (process alarms) generated by an 1/0
module with configured interrupt capability.

» OB82 responds to diagnostic interrupts generated by an I/0O module with
configured diagnostic interrupt capability.

» 0OB83 responds to module removal/insertion at a DP Slave, (for example,
ET200M), which has been configured for module pull/plug support.

» OBS85 responds to a priority class error. There are multiple causes for OB85
relating to the DP 1/O system. If the controller attempts to copy a module’s
inputs to (or outputs from) the process image during the 1/O cycle, and the
module is not operational, then an OB85 is executed.

» OB86 responds to a station failure or some other interruption of the physical
network (such as a short circuit).

» OB122 responds to an I/O access error by the user program. If OB122 is not
programmed, the controller goes to STOP mode.

You can use SFC39 to SFC42 to disable, to delay, or to re-enable any of these
OBs. If an OB is requested and the OB has not been downloaded to WinLC RTX,
the controller goes to STOP mode.

The local variables for these OBs contain startup information indicating the cause
for executing the OB. The program for the OB can use this information for
responding to the event. For information about using these OBs, refer to the
System Software for S7-300 and S7-400 System and Standard Functions
Reference Manual.

You can also use SFC13 (DPNRM_DG) to read the diagnostic information from a
DP slave. For information about SFC13, refer to the System Software for S7-300
and S7-400 System and Standard Functions Reference Manual.

Windows Logic Controller WinLC RTX Overview
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The information in the system status list (SZL) is stored as a set of sublists. Each
sublist has a two-word header that provides the following information about the
sublist:

» The first word defines the length (size in bytes) of a record for the sublist.
* The second word defines the number of records contained in the sublist.

SFC51 (RDSYSST) accesses the entries in the system status list. For more
information about the system status list, see the System Software for S7-300 and
S7-400 System and Standard Functions Reference Manual.

Table A-1 provides an overview of the SZL sublists, sorted according to the
SZL-ID. You use the SZL-ID and index (as hexadecimal numbers: 16#) to access
the records stored in the sublist.

Table A-1  Sublists of the System Status List (SZL) for the WinLC

SZL-ID Sublist Index Record Contents
(hexadecimal) (hexadecimal)
SZL-ID Information on all available SZL-1Ds
0000 All available SZL-IDs 0131 Indices for SZL-ID 0131
0300 Lists the available indices 0132 Indices for SZL-ID 0132
0222 Indices for SZL-ID 0222
CPU identification WinLC type and version number
0011 All records of the sublist 0001 Identification of the module
0111 One record of the sublist 0007 Identification of the firmware
OF11 Header information only
CPU features
0112 Only those records of a 0100 Time system in WinLC
group of features 0200 System response
0300 Language description of WinLC
OF12 Header information only
0013 User memory areas Work memory, integrated Load memory, plugged-in Load

memory, maximum number of plug-in Load memories,
and size of backup memory

0014 Operating system areas Process-image input area (bytes), process-image output
area (bytes), bit memory (bytes), timers, counters, size of
the 1/0 address area, and total local data area for WinLC
(bytes)
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Table A-1  Sublists of the System Status List (SZL) for the WinLC, continued

SZL-ID Sublist Index Record Contents
(hexadecimal) (hexadecimal)
Block types
0015 All records of the sublist OBs (nhumber and size)
DBs (number and size)
SDBs (number and size)
FCs (number and size)
FBs (humber and size)
0115 One record, depending on 0A00 OBs (humber and size)
the index: 0B0O
0C00
OEOO
F15 Only SZL partial list header 0800
information
State of the module LEDs
0019 Status of all LEDs
0119 Status of each LED 0002 INTF Internal failure
0003 EXTF External failure
0004 RUN Run
0005 STOP Stop
0006 FRCE Force
0007 CRST Complete restart
0008 BAF Battery failure
000B BUSF1 Bus fault
OF19 Header information only
Interrupt/error assignment
(via number of assigned
OBs)
0021 All possible interrupts
OF21 Header information only
Interrupt status
0222 Record for specified interrupt 0001 Event that started OB1
0050 Event that started OB80
Priority class
0023 Records for all priority 0000 Priority of possible OBs
classes
0123 Records for a specific priority
class
0223 Records for all configured
priority classes
0F23 Header information only

A-2
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Table A-1  Sublists of the System Status List (SZL) for the WinLC, continued

SZL-ID Sublist
(hexadecimal)

Index
(hexadecimal)

Record Contents

Operating status of the
CPU

0124 Last executed operating
status transition

0424 Current operating status 4520 Defective status
0524 Specified operating status 5000 STOP status
5010 Startup status
5020 RUN status
5030 HOLD status
0131 Communications 0001 Number of connections and baud rates
performance parameters  of 0002 Test and startup parameters
the communications type 0003 o tor interf. t
specified perator interface parameters
0004 Object management system (operating
system function)
0005 Diagnostics functions and diagnostics
entries
0006 PBK: connections; number of
send/receive parameters
0009 Number of run-time meters
0132 Communications status 0001 Number and type of connections
information i of thte 0002 Number of test jobs set up
communications type 0003 Operator interface: number of current
specified . ;
cyclic read jobs
0004 Protection levels of the WinLC
0008 Time system, correction factor, run-time
meter, date and time of day
0009 Baud rate (set by means of the MPI)
000A Baud rate (set by means of the S7-300
backplane bus)
0x10 PMC S7 scan: Number of configured

messages and time stamp of SDBs for
each scan cycle

Diagnostic Station List

0033 All entries
Start-up events

0782 Start-up events of all OBs of
a priority class before
processing

Priority class

Event ID, priority class, and OB number
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Table A-1  Sublists of the System Status List (SZL) for the WinLC, continued

SZL-ID
(hexadecimal)

Sublist

Index
(hexadecimal)

Record Contents

Module status information

slave

0A91 Status information of all DP
subsystems and DP masters
0Co1 Status information of a Start address | Features and parameters of the module
module XXyy All the modules of station yy in the
0D91 Status information for the PROFIBUS-DP network xx
specified station
0F91 Header information only
Status information of the Status information for the nodes
nodes in a DP network connected to a PROFIBUS-DP network
0092 Target status of nodes in a 0000
subnetwork
0292 Actual status of the nodes in | Subnetwork
a subnetwork ID
0692 DP slaves indicating failure
of one or more modules
0F92 Header information only
Diagnostics buffer Event information (dependent on the event)
00A0 All entries (event information)
01A0 Specified number of entries
OFAO Header information only
Module diagnostics Module-dependent diagnostics
information
00B1 Data record 0 of the module | Start address | Starting address for the specific module
diagnostics information
00B3 Data record 0 of the module | Rack and Rack and slot number of the specific
diagnostics information slot number | module
(Complete module-
dependent diagnostics)
00B4 DP-norm diagnostics of a DP
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Like the other S7 PLCs, WinLC RTX provides several types of logic blocks for
processing the user program: organization blocks (OBs), system functions (SFCs),
and system function blocks (SFBs). These blocks are an integral part of WinLC
RTX. In addition to these system blocks, you can use the other S7 blocks to create
the user program:

* Function (FC): WinLC RTX supports up to 65,536 FCs (FCO to FC65535). Each
FC can contain up to 65,570 bytes.

* Function block (FB): WinLC RTX supports up to 65,536 FBs (FBO to FB65535).
Each FB can contain up to 65,570 bytes.

» Data block (DB): WinLC RTX supports up to 65,535 DBs (DB1 to DB65535).
(DBO is reserved.) Each DB can contain up to 65,534 bytes.

An OB can also contain 65,570 bytes.

The total number of blocks in the user program that you can download to WinLC
RTX is 2500 blocks.

For more information about OBs, SFCs, and SFBs, see the System Software for
S7-300 and S7-400 System and Standard Functions Reference Manual.

Chapter Description Page
B.1 Technical Data B-2
B.2 Organization Blocks Supported B-4
B.3 System Functions (SFCs) Supported B-7
B.4 Execution Times of the DP Instructions B-10
B.5 System Function Blocks (SFBs) Supported B-11
B.6 Execution Times of Instructions B-11
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B.1 Technical Data

Order Number

WinLC RTX is a component of the WIinAC RTX package: 6ES7 671-0RC01-0YX0

Features

WinLC RTX provides the following features:

» Accumulators: 4 (ACCU 1 to ACCU 4)

e Communications: PROFIBUS-DP master device

*  Work memory and Load memory: limited by the amount of non-paging memory
supported by the computer (PC) and the operating system, which is less than
the physical memory (RAM) in the computer

» Distributed 1/O only, no local I/O:

— You can configure the size of the process-image I/O areas (I and Q memory
areas) to be either 512 bytes or 1024 bytes. These memory areas can be
accessed directly by the instructions in the user program.

— Using Load (L) and Transfer (T) instructions (for statement list) or the Assign
Value (MOVE) instruction (for ladder logic) to the peripheral I/O (Pl and PQ
memory areas), you can access up to 16384 bytes of inputs and

16384 bytes of outputs.

WiInLC RTX communicates with the distributed I1/O as a PROFIBUS-DP master
device. As a master device, WinLC RTX can communicate with up to 125 slave
devices (either S7-DP slaves or other DP slaves).

Technical Specifications

Table B-1 Technical Specifications of WinLC RTX

WinLC RTX

Description

Work memory
Load memory (RAM)

Limited by the amount of non-paging memory of the
computer. The following factors affect this amount:

® Amount of physical memory (RAM) installed in the
computer

® Other programs being executed at the same time as
WinLC RTX

Accumulators

4 (ACCU 1to ACCU 4)

Local data

16 Kbytes per priority class

Clock

Real-time system clock, based on the hardware clock of the
computer

B-2
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Table B-1 Technical Specifications of WinLC RTX, continued

WinLC RTX

Description

Digital I/0 (digital and analog)

16384 bytes (inputs) and 16384 bytes (outputs)

Process image I/0
(user configurable)

512 bytes (inputs) and 512 bytes (outputs) or
1024 bytes (inputs) and 1024 bytes (outputs)

® Retentive range (configurable)
® Preset as retentive

®* Inputs ®* 100tol511.70r10.0tol1023.7
®* OQutputs ® QO0.0to Q511.7 or Q0.0 to Q1023.7
Memory bits 2 Kbytes

*  MBO to MB255
* 16 bytes (MBO to MB15)

Counters
® Retentive range (configurable)
® Preset as retentive

512
* COtoC63
* 8(COtoC7)

Timers (only updated in OB1)
® Retentive range (configurable)
® Preset as retentive

512
* TOtoT127
®* None

Clock memory

Bits of the clock memory byte toggle at
specific times and are accessible from
the user program.

8 bits of clock memory (1 byte)

8 frequencies within 1 byte of M memory: address is
configurable

Number of blocks supported

e OB

* SFB

® SFC

®  Maximum number of asynchronous
SFCs

® Address ranges for logic blocks:
- FB
- FC
- DB

® Total number of blocks that can be
downloaded to WinLC

16 (see Table B-2)

7 (see Table B-8)
52 (see Table B-6)
20

FBO to FB65535

FCO to FC65535

DB1 to DB65535 (DBO is reserved)
2500

Nesting depth

24 per OB. Each OB, including the two synchronous OBs
(OB121 and OB122), has a nesting depth of 24.

PROFIBUS-DP interface

® DP address area

® Number of DP slaves supported
® Baud rate

® Baud rate search (as a DP slave)
® Transfer memory (as a DP slave)
® Maximum distance

® 16384 bytes (inputs) and 16384 bytes (outputs)
e 125
* Upto 12 Mbaud

(9.6 KBPS, 19.2 KBPS, 45.45 (31.25) KBaud,
93.75 KBPS, 187.5 KBPS, 500 KBPS, 1.5 MBPS,
3 MBPS, 6 MBPS, 12 MBPS)

®* Not applicable
®* Not applicable
® Dependent on the baud rate (see Table 6-1)
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B.2

Organization Blocks (OBs) Supported
OBs are the interface between the operating system of WinLC RTX and the user
program. Table B-2 lists the OBs which are supported. WinLC RTX executes OBs

according to the priority class.

Table B-2  Organization Blocks (OBs) Supported

OB Description Priority Class
OB1 Main program cycle 1 (lowest)
OB10 Time-of-day interrupt 2
0OB20 Time-delay interrupt 3to6
OB35, OB36 Cyclic interrupt 7to 15
OB40 Hardware interrupt 16to 23
0OB80 Time error 26
0OB82 Diagnostic interrupt 24 to 26 (or 28)1
OB83 Module remove/insert interrupt 24 to 26 (or 28)1
OB84 CPU hardware fault 26 (or 28)1
0B85 Priority class error 24 to 26 (or 28)1
OB86 Rack failure 24 to 26 (or 28)1
0OB100 Warm restart 27
0B102 Cold restart 27
OB121 Programming error Priority class of the OB where
0OB122 1/O access error the error occurred

1 Priority class 28 during STARTUP mode of WinLC, user-configurable priority class (from 24
to 26) in RUN mode.

OBs for the Main Program Cycle, Cold Restart, and Warm Restart

B-4

Table B-3 shows OBs for the main program cycle and cold and warm restarts.
WinLC RTX provides OB1 (main program cycle) for continuously executing the
user program. On the transition from STOP mode to RUN mode (or RUN-P mode),
WinLC RTX executes OB100 (warm restart) or OB102 (cold restart), based either
on the hardware configuration for WinLC RTX or which restart option was selected
from a dialog box displayed by the WinLC control panel. After OB100 (or OB102)
has been successfully executed, WinLC RTX executes OB1.

Table B-3 OBs for the Main Program Cycle, Cold Restart, and Warm Restart

Organization Block (OB) Start Event Priority
Main program cycle OB1 1101y, 1103y, 1104y 1
Warm restart OB100 1381y, 1382y 27
Cold restart 0OB102 1385y, 1386y 27
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Interrupt OBs

WinLC RTX provides a variety of OBs that interrupt the execution of OB1.
Table B-4 lists the different interrupt OBs which are supported by WinLC. These
interrupts occur according to the type and configuration of the OB.

The priority class determines whether the controller suspends the execution of the
user program (or other OB) and executes the interrupting OB. You can change the
priority class for the interrupt OBs (see Table B-2).

Table B-4 Interrupt OBs

Interrupts Start Event Default Priority
Time-of-Day Interrupt OB10 11114 (OB10) 2 Low
Time-Delay Interrupt 0OB20 11214 (OB20)

Range: 1 ms to 60000 ms

Cyclic Interrupt OB35 1136y 12
Range: 1 ms to 60000 ms OB36 11374 13

The practical minimum time is based on the
performance of the computer and the size
of the user program.

Hardware interrupt OB40 1141 (channel 1) 16 High

If WinLC RTX has been configured to execute a particular interrupt OB, but that
OB has not been downloaded, WinLC RTX reacts in the following manner:

« If OB10, OB20, or OB40 is missing and OB85 has not been downloaded,
WinLC RTX changes operating mode (from RUN to STOP).

* WiInLC RTX remains in RUN mode if OB35 or OB36 is missing or cannot be
executed at the specified time.

Note

If you schedule OB35 or OB36 to be executed at a specific interval, make certain
that the program can be executed within the time frame and also that your WinLC
RTX application can process the OB within the allotted time.

Error OBs

As shown in Table B-5, WinLC RTX provides a variety of error OBs. Some of these
error OBs have the configured (the user-assigned) priority class, while others
(OB121 and OB122) inherit the priority class of the block where the error occurred.
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B-6

The local variables for OB121 and OB122 contain the following information that
can be used by the program to respond to the error:

» The type of block (byte 4) and the number (bytes 8 and 9) where the error

occurred

» The address within the block (bytes 10 and 11) where the error occurred

If the start event occurs for a particular error OB that has not been downloaded,
WinLC RTX changes operating mode from RUN to STOP.

Table B-5 Error OBs

Error or Fault

Start Event

Default Priority

(For example: the user program attempts to
access a module that is defective or is not

plugged in.)

Time-out error OB80 3501y, 3502y, 26
3505, 3507y
Diagnostic Interrupt 0OB82 3842y, 3942 26
Insert/remove module interrupt 0OB83 3861y, 3863, 26
3864, 3961y,
3865
CPU hardware fault 0B84 3985y, 26 (or 28)
Priority class error: 0B85 35A1, 26
® Start event occurs for an OB that has not 35A3y,
been downloaded. 39B1y, 39B2y,
® During the I/O cycle, WIinLC RTX attempts
to access a module or DP slave that is
defective or not plugged in .
® WinLC RTX attempts to access a block
(such as a DB) that has not been
downloaded or has been deleted.
Distributed I/O failure: a node in the OB86 38C4y, 39C4y,, 26 (or 28)
PROFIBUS-DP subnetwork has failed or been 38C5y, 39C5,
restored. 38C7h,
38C8y,
Programming error OB121 | 2521y 2522y, Same priority class
(For example: the user program attempts to 2523y, 2524y, as the OB in which
address a timer that does not exist.) 2525y, 2526, the error occurred
2527y, 2528y,
2529y, 25304,
2531y, 2532y,
2533y, 2534y,
2535y, 253Ay;
253Cy, 253Ey
1/0O access error OB122 | 2942y, 2943
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B.3

System Functions (SFCs) Supported

WinLC RTX provides SFCs, which are logic blocks that perform basic tasks. The
user program calls the SFC and passes the required parameters; the SFC
performs its task and returns the result.

Asynchronous SFCs Supported

WinLC RTX allows a maximum of 20 asynchronous SFCs to be running. The
following asynchronous SFCs are supported: SFC11, SFC13, SFC51 (index B1,
B3), SFC55, SFC56, SFC57, SFC58, and SFC59.

Note

An asynchronous SFC is an SFC that has a “Busy” output parameter.

SFCs That Can Cause the Scan Cycle to Vary

The following SFCs can cause the scan cycle to vary (“jitter”):
* SFC22 (CREAT_DB)

e SFC23 (DEL_DB)

* SFC52 (WR_USMG)

Execution Times for the SFCs Supported by WinLC RTX
Table B-6 lists the SFCs which are supported.

Table B-6 System Functions (SFCs) Supported

SFC Name Description Execution Time 1
SFCO | SET_CLK Sets the system clock 25.55 us
SFC1 | READ_CLK Reads the system clock 7.79 us
SFC2 | SET_RTM Sets the run-time meter 5.18 us
SFC3 | CTRL_RTM Starts or stops the run-time meter 5.50 us
SFC4 | READ_RTM | Reads the run-time meter 3.88 us
SFC5 | GADR_LGC | Queries the logical address of a channel 8.43 us
SFC6 | RD_SINFO Reads the start information of an OB 8.76 us
SFC11 | DPSYNC_FR | Synchronize groups of DP slaves 5.20us
SFC13 | DPNRM_DG | Reads the diagnostic data of a DP slave 29.63 us

DP configuration tested: one ET 200M slave with one 8-input/8-output
module and one 16-output module
SFC14 | DPRD_DAT Reads the consistent data from a DP slave 14.45 us
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Table B-6 System Functions (SFCs) Supported, continued

SFC Name Description Execution Time 1
SFC15 | DPWR_DAT | Writes the consistent data to a DP slave 14.32 us
SFC17 | ALARM_SQ | Generates an acknowledgeable block-related message 25.18 us
SFC18 | ALARM_S Generates an unacknowledgeable block-related message 27.31 us
SFC19 | ALARM_SC | Queries the status for the last message (SFC17 or SFC18) 6.04 us
SFC20 | BLKMOVB Copies variables 18.85 us
SFC21 | FILL Initializes a memory area 1 word 19.03 us

50 words 31.02 us
100 words 4251 us
SFC22 | CREAT_DB Creates a data block 35.02 us
SFC23 | DEL_DB Deletes a data block 11.67 us
SFC24 | TEST_DB Provides information about a data block 5.60 us
SFC26 | UPDAT_PI Updates the process-image input table 1282.40 ys
DP configuration tested: one ET 200M slave with one 8-input/8-output
module and one 16-output module
SFC27 | UPDAT_PO Updates the process-image output table 1286.20 us
SFC28 | SET_TINT Sets the time-of-day interrupt (OB10) 10.16 us
SFC29 | CAN_TINT Cancels the time-of-day interrupt (OB10) 5.26 us
SFC30 | ACT_TINT Activates the time-of-day interrupt (OB10) 4.94 us
SFC31 | QRY_TINT Queries the time-of-day interrupt (OB10) 5.56 us
SFC32 | SRT_DINT Starts the time-delay interrupt (OB20) 14.29 us
SFC33 | CAN_DINT Cancels the time-delay interrupt (OB20) 5.87 us
SFC34 | QRY_DINT Queries the time-delay interrupt (OB20) 5.53 us
SFC36 | MSK_FLT Mask synchronous errors 5.50 us
SFC37 | DMSK_FLT Unmask synchronous errors 4.92 us
SFC38 | READ_ERR | Read the error register 4.86 us
SFC39 | DIS_IRT Disables the processing of all new interrupts 5.17 us
SFC40 | EN_IRT Enables the processing of new interrupts 4.93 us
SFC41 | DIS_AIRT Disables the processing of new interrupts with higher priority than the 3.58 us
current OB
SFC42 | EN_AIRT Enables the processing of new interrupts with higher priority than the 7.77 us
current OB
SFC43 | RE_TRIGR Retriggers the watchdog timer (monitoring the cycle time) 2407.46 us
SFC44 | REPL_VAL Transfers a value to ACCU1 (accumulator 1) 10.75 us
SFC46 | STP Changes the operating mode to STOP Not applicable
SFC47 | WAIT Delays the execution of the user program 1951.41 ys
SFC49 | LGC_GADR | Queries the module slot belonging to a logical address 6.99 us
SFC50 | RD_LGADR | Queries all of the logical addresses of a module 22.06 us
SFC51 | RDSYSST Reads all or part of a system status list 22.42 us
SFC52 | WR_UMSG Writes a user element to the diagnostics buffer 29.23 us
SFC54 | RD_PARM Read the defined parameter 14.17 us

B-8
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Table B-6 System Functions (SFCs) Supported, continued

SFC Name Description Execution Time 1
SFC55 | WR_PARM Write the defined parameter 24.03 us
SFC56 | WR_DPARM | Write the default parameter 13.63 us
SFC57 | PARM_MOD | Assign the parameters to a module 13.58 us
SFC58 | WR_REC Write a data record 24.01 us
SFC59 | RD_REC Read a data record 23.37 us
SFC64 | TIME_TCK Reads the time from the system clock 4.21 s
SFC79 | SET Set a range of outputs 5.83 us
SFC80 | RESET Reset a range of outputs 5.83 us

1 The execution times were measured at O sleep time and 0 minimum cycle time on a Dell Dual 600 computer with 256
Kbytes of RAM running NT at 600 MHz. Actual execution times may vary, depending on your system.
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B.4 Execution Times of the DP Instructions

Table B-7 lists the execution times for the SFCs used with the distributed 1/O.

Table B-7 Execution Times of the DP Instructions

SFC Name Description CP5613!
SFC11 | DPSYNC_FR | Synchronize groups of DP slaves 10.045 ps
SFC13 | DPNRM_DG | Reads the diagnostic data of a DP slave 28.03333 us

DP configuration tested: one ET 200M slave with one
8-input/8-output module and one 16-output module
SFC14 | DPRD_DAT Reads the consistent data from a DP slave 28.34567 us
SFC15 | DPWR_DAT | Writes the consistent data to a DP slave 27.896 us
SFC26 | UPDAT_PI Updates the process-image input table 125.2333 us
DP configuration tested: one ET 200M slave with one
8-input/8-output module and one 16-output module
SFC27 | UPDAT_PO Updates the process-image output table 92.46667 us

1 The execution times were measured at O sleep time and 0 minimum cycle time on a Dell Dual 600
computer with 256 Kbytes of RAM running NT at 600 MHz. Actual execution times may vary,
depending on your system.
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B.5 System Function Blocks (SFBs) Supported
WinLC RTX provides SFBs, which are logic blocks similar to SFCs. Table B-8 lists
the SFBs which are supported. When the user program calls an SFB, a data block
(DB) must also be assigned.
Table B-8 System Function Blocks (SFBs) Supported
SFB Name Description Execution Time 1
SFBO CTU Provides a “count up” timer 9.08 us
SFB1 CTD Provides a “count down” timer 9.11 us
SFB2 CTUD Provides a “count up/down” timer 11.04 ps
SFB3 TP Generates a pulse 9.41 us
SFB4 TON Generates an on-delay timer 9.41 us
SFB5 TOF Generates an off-delay timer 9.54 us
SFB32 DRUM Implements a sequencer 29.96 us
1 The execution times were measured at O sleep time and 0 minimum cycle time on a Dell Dual 600
computer with 256 Kbytes of RAM running NT at 600 MHz. Actual execution times may vary,
depending on your system.
B.6 Execution Times of Instructions

The execution times listed in Table B-9 (execution times for math operations) and
Table B-10 (execution times for instructions) reflect the average execution times for
STEP 7 programs running on WIinLC. Actual execution times may vary, depending
on your system.

Table B-9 Execution Times of Math Operations (us)

Math Operation Integer ! Reall Double Word 1
Addition (+) 0.06 us 0.10 us 0.08 us
Subtraction (-) 0.08 us 0.09 us 0.08 us
Multiplication (*) 0.06 us 0.10 us 0.14 us
Division (/) 0.21 us 0.17 us 0.13 us

1 The execution times were measured at O sleep time and 0 minimum cycle time on a Dell Dual 600
computer with 256 Kbytes of RAM running NT at 600 MHz. Actual execution times may vary,

depending on your system.
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Table B-10 Execution Times (us) per Instruction

Instructions Execution Time 1
Direct addressing Indirect addressing
Boolean operations: Memory areas: | 0.17 us 0.24 us
A, AN O, ON, X, XN M 0.16 us 0.24 us
L 0.20 us 0.24 us
DB 0.19 us 0.27 us
1.88 us 2.01us
0.15 us 0.26 us
Boolean operations (on the accumulator):
==1, <>l, >I, <I, >=|, <=I 0-12us
Operations on the bits of the status word: 0.15 s
A==0, A<>0, A>0, A<0, A>=0, A<=0
Transitional contacts: Edge Positive FP 0.24 us
Edge Negative FN 0.24 us
Set/Reset operations Set S 0.20 us 0.31yus
(bit operands) Reset R 0.20 us 0.31yus
RLO Operations Negate RLO NOT 0.11 us
SetRLO SET 0.11 us
Clear RLO CLR 0.09 us
Save RLO SAVE 0.11 us
Operations on Timers Pulse timer SP 1.94 us 2.04 us
Reset (timer) R 0.11 us 0.21 s
Extended pulse timer SE 1.93 us 2.04 us
On-delay timer SD 2.00 us 2.10 us
Retentive on-delay timer SS 2.00 us 2.10 us
Off-delay timer SF 2.07 us 2.16 us
Miscellaneous: Open DB OPN 1.22 us
Load L 0.16 us
Transfer T 0.17 us

1 The execution times were measured at O sleep time and 0 minimum cycle time on a Dell Dual 600 computer with 256
Kbytes of RAM running NT at 600 MHz. Actual execution times may vary, depending on your system.
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Chapter Overview

The WinLC control panel is also available as an ActiveX component for use in
SIMATIC Computing. The Panel control permits access from the SoftContainer
provided by SIMATIC Computing or from any other ActiveX container.

The Panel control provides access to the operating modes of either WinLC (WinAC
RTX) or a slot PLC (WinAC Pro). You can change the operating mode from STOP
to RUN or RUN-P, or you can use the MRES button to reset the memory areas of
the controller.

Section Description Page
Cl1 Accessing the Controller with the Panel Control C-2
Cc.2 Selecting the Control Engine for the Panel Control C-6
C3 Sample Programs Using the Panel Control C-7
CA4 Evaluating the LEDs of the Panel Control C-11
C5 Properties and Methods of the Panel Control C-12
C.6 Events of the Panel Control C-25
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Cl

C-2

Accessing the Controller with the Panel Control

The Panel control corresponds to the faceplate of the S7 CPU modules. As shown
in Figure C-1, the control contains buttons for changing the operating mode of the
controller, a button for resetting the memory area, and status indicators.

[E] S7SoftContainer - [S7Soft1] !En
.h File Edit View Mode Options Window Help E

NEFRNFEENE KN mie N D A E R R

Displays the status of the controller

Changes the operating mode of

the controller

Resets the memory area of the
controller

| 2

Ready Design | STWCPanel1 44,2 |2ax26

Figure C-1  Buttons and Indicators on the Panel Control

Warning

When you change the operating mode selection of the Panel control, you are
changing the operating mode of the controller in your actual process. If you select
the MRES button, a memory reset is issued to the controller.

Resetting or changing the mode of the controller interrupts process operation. If
equipment is not in a safe state, interrupting the process could result in death or
serious injury to personnel, and/or damage to equipment.

Do not allow anyone to change the mode of the controller or issue a reset unless
you have ensured that your equipment is in a safe state. Always install a physical
emergency stop circuit for your machine or process.
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Selecting the Operating Mode

The RUN, RUNP, and STOP buttons on the Panel control correspond to the
different operating modes of the controller, and are shown in Table C-1:

* In STOP mode, the controller is not executing the user program. To download a
program that includes SDBs, you must place the controller in STOP mode. On
the transition to STOP mode, the outputs go to a safe state.

* In RUN mode, the controller executes the user program. You cannot download
any new user program or logic blocks when the controller is in RUN mode.

* In RUN-P mode, the controller executes the user program. You can download
new programs or logic blocks.

Clicking on the button places the controller into the selected operating mode. The
status indicators on the Panel control show whether the controller is in RUN (or
RUN-P) mode or in STOP mode.

To allow an external source, such as the STEP 7 programming software, to change
the operating mode of the controller, select either RUN or RUN-P mode. If the
operating mode is changed by the external software, the selected button on the
Panel control does not change, but the status indicators reflect the actual operating
mode of the controller.

Table C-1 Buttons for Changing the Operating Modes of the Controller

Mode Description

RUNP | The controller executes the user program. When the controller is in RUN-P mode
(RUN-PROGRAM mode), you can:

* Upload a program from the controller to your computer or programming
device

* Download a program to the controller
* Download individual blocks to the controller

RUN The controller executes the user program. You can upload a program from the
controller to your computer or programming device, but you cannot download a
program to the controller.

STOP | The controller does not execute the user program. When the controller is in
STOP mode, you can:

* Upload a program from the controller to your computer or programming
device

* Download a program to the controller
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Using the Status Indicators

The status indicators (BUSF1, BUSF2, INTF, EXTF, PS, BATTF, FRCE, RUN, and
STOP) show basic information about the controller, such as the current operating
mode or the presence of an error condition. Table C-2 describes the different
status indicators for the CPU panel of the controller. You cannot change the status
of the controller by clicking on the status indicators.

c4

If there is a break point in the user program, both the RUN and STOP indicators
turn on while the break point is active: the RUN indicator flashes, and the STOP

indicator is on.

During a restart, both the RUN and STOP indicators are turned on: the RUN
indicator flashes, and the STOP indicator is on during the restart; when the STOP
indicator turns off, the outputs are enabled.

If all of the status indicators are flashing, the controller is defective.

Table C-2 Status Indicators

Indicator Description

ON Power supply. Always on for WinLC.

BATTF Battery fault. Always off for WinLC.

INTF This indicator lights up (solid) to show error conditions within the controller, such as
programming errors, firmware errors, arithmetic errors and timer errors.

EXTF This indicator lights up (solid) to show error conditions that exist outside of the
controller, such as hardware faults, parameter assignment errors, communication
errors, and I/O fault errors.

BUSF1 These indicators light up (either solid or flashing) to identify fault conditions in the

BUSF2 communication with the distributed 1/0O. See Table 6-5.

Since WInLC supports only 1 PROFIBUS-DP network, BUSF1 is the only active
indicator; BUSF2 is not applicable for WinLC.

FRCE This indicator lights up (solid) to show that a force request is active.

Not applicable for WinLC.

RUN Lights up (solid) to show the operating mode (RUN or STOP)
When RUN is flashing and STOP is lighted (solid):

STOP ® The controller is executing a restart.
® The user program has reached a break point.

All status When all of the status indicators are flashing, WinLC has encountered an error

indicators are condition that cannot be fixed by resetting the memory (MRES). To recover from this

flashing condition, you must perform the following tasks:

1. Shut down the WinLC controller.
2. Restart the WinLC controller.
3. Reset the memory (MRES).

If WIinLC is running as a service, you must use the Windows NT control panel to
shut down and restart the WinLC controller.
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Using the MRES Button to Reset the Memory Areas

The Panel control provides a MRES button for resetting the memory areas to the
default values and deleting the user program. Clicking the MRES button places the
controller into STOP mode and performs the following tasks:

1. The controller deletes the entire user program, including the data blocks (DBSs).
2. The controller resets the memory areas (I, Q, M, T, and C).

After the memory has been reset, the diagnostics buffer remains intact, as does
the MPI address.
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C.2

C-6

Selecting the Control Engine for the Panel Control

When using the ActiveX Panel Control, you must specify the Control Engine to
which to connect. The Panel does not connect to hardware PLCs or across
networks. Figure C-2 shows the Properties dialog box for the Panel control. You

enter the name of the controller in the “Control Engine” property field:
* For WInAC RTX:

— WinLC (for WinLC)

— WInLCRTX(for WinLC RTX)
* For WIinAC Pro:

— CPU 412-2 PCI (for the PCI version of the S7 CPU 412)

— CPU 416-2 PCI (for the PCI version of the S7 CPU 416)

— CPU 416-2 DP ISA  (for the ISA version of the S7 CPU 416)

Siemens Panel Control Properties n

General ] Name]

Control Engine | WinLCRTX

OK | Cancel Apply

Figure C-2  Panel Control Properties (General Tab)

Note

If you are using a third-party container that allows you to view the other properties
for the Panel control, do not modify these properties or the values assigned to

them.
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C.3 Sample Programs Using the Panel Control

You can write programs to initiate actions based the status of the Panel control.
The following sample programs provide examples of how you can write programs
that use the Panel control.

Changing the Operating Mode of the Controller

Your program can change the operating mode (RUN, RUN-P, STOP) of the
controller. Table C-3 provides sample subroutines that performs these tasks when
you click on a command button in the VB form.

» |f the subroutine ConnectToCPU is called, the Panel control connects to a
specific controller

» If the subroutine SetToRun is called, the operating mode of the controller
changes to RUN mode.

» If the subroutine SetToRunP is called, the operating mode of the controller
changes to RUN-P mode.

» If the subroutine SetToStop is called, the operating mode of the controller
changes to STOP mode.

Table C-3 Connecting to a Controller and Changing the Operating States

Visual Basic Code

Private Sub ConnectToCPU
S7Panell.ConnectCPU = True "Connect the Panel to the Selected Control Engine
End Sub

Private Sub SetToRun
S7Panell.ModeCtrl = RUN_Switch 'Place WInLC in Run Mode
End Sub

Private Sub SetToRunP
S7Panell.ModeCtrl = RUNP_Switch "Place WInLC in Run-P Mode
End Sub

Private Sub SetToStop
S7Panell.ModeCtrl = STOP_Switch 'Place WInLC in Stop Mode
End Sub
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Configuring the Security State of the Panel Control

You can design a custom application that uses a Panel control, but allows the
security for the application to determine whether a user can operate the Panel
control. Since your application will have its own password or other security
checking, you do not require any additional security checking to be performed by
the Panel control.

The sample subroutines listed in Table C-4 provide sample code for accomplishing
the following tasks:

» To bypass the security provided by the Panel control, you set the SecurityState
property of the Panel control to App_Does_Security . The Panel control now
relies on the application to determine whether the user has permission to make
changes in the controller.

In this example, the SecurityState property is set to this value when the form for
the application loads.

» To ensure that a user must have permission from the application before
allowing any changes to be made with the Panel control, you set the SwitchOK
property of the Panel control to False. The button on the Panel control will now
respond to user requests only if the application changes the state of the
SwitchOK property.

In this example, the SwitchOK property is set to False when the form for the
application loads.

» To enable the user to make changes to the controller with the Panel control,
your application sets the SwitchOK property of the Panel control to True.

When the PerformSecurityCheck subroutine determines that the user has
permission to make changes with the Panel control, the subroutine sets the
SwitchOK property of the Panel control to True. Until the SwitchOK property is
set to True, the Panel control does not make the change requested by the user.

Using this sample code, any time that a user requests that the Panel control
perform some task, the Panel control determines whether the user has been given
permission by the application to make the requested change. For example, when a
user clicks on the “RUN” button of the Panel control to change the controller from
STOP mode to Run mode, the Panel control checks the state of the SwitchOK
property before changing the operating mode of the controller.
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Table C-4 Configuring the Security State for the Panel Control

Visual Basic Code

'This sample application uses a Boolean parameter (AppPasswordValid)
'to allow changes to be made with the Panel control

Dim AppPasswordValid As Boolean 'User is (or is not) allowed to make changes

Private Sub Form_Load()

"This section connects the Panel control to the controller (WinLC) and initializes
‘the properties of the Panel control

'Set the Control Engine String for the controller
S7Panel.ControlEngine = WinLC

'Connect the Panel control to WinLC
S7Panel.ConnectCPU = True

‘Initialize the SwitchOK property to False. This prevents any changes to be made
‘until the application performs the security check
S7Panel.SwitchOK = False

'Set the security state to have the application perform the security check
S7Panel.SecurityState = App_Does_Security

End Sub

Private Sub PerformSecurityCheck()
"This subroutine provides the security checking for the application.

"The code that checks the security for the application goes here...

'If the user has permission to make changes, AppPasswordValid is set to True
'Otherwise, AppPasswordValid is set to False

'State of AppPasswordValid determines whether the Panel control responds to user
S7Panel.SwitchOK = AppPasswordValid

End Sub
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Responding to Changes in the State of the LEDs on the Panel Control

Table C-5 provides a sample subroutine that reads the state of the LED for RUN
mode and determines the color of the LED and if the LED is turned on or is
flashing. The constants which are declared for the subroutine are the masks for the
values in the LED properties: CpuBusfl, CpuBusf2, CpuExtF, CpuFrce, CpulntF,

CpuRun, and CpusStop.

Table C-5 Responding to Changes in the LEDs of the Panel Control

Visual Basic Code

Private Sub S7Panel_UpdateState()

'These constants are the masks for the LED properties:

Const LED_GREEN = &H2

Const LED_3SEC = &H100

Const LED_ON = &H200

Const LED_05HZ = &H300

Const LED_20HZ = &H400
'For this example, RunLedColorTxt and RunLedStateTxt are text fields:
'RunLedColorTxt displays a message about the color of the RUN mode LED
'RunLedStateTxt displays a message about the state (on or flashing)
' of the RUN mode LED

If S7Panel.CpuRun = 0 Then
RunLedColorTxt.Caption = “Color of the RUN mode LED is gray”
RunLedStateTxt.Caption = “RunLED is Off”

End If

If (S7Panel.CpuRun And LED_GREEN) = LED_GREEN) Then
RunLedColorTxt.Caption = “Color of the RUN mode LED is green”
End If

If (S7Panel.CpuRun And LED_ON) = LED_ON) Then
RunLedColorTxt.Caption = “RUN mode LED is turned on (and is not flashing)”
End If

If (S7Panel.CpuRun And LED_3SEC) = LED_3SEC) Then
RunLedColorTxt.Caption = “RUN Mode LED flashes for 3 seconds”
End If

If (S7Panel.CpuRun And LED_05SEC) = LED_05HZ) Then
RunLedColorTxt.Caption = “RUN Mode LED flashes at 5 Hz intervals”
End If

If (S7Panel.CpuRun And LED_20SEC) = LED_20HZ) Then
RunLedColorTxt.Caption = “RUN Mode LED flashes at 20 Hz intervals”
End If

End Sub
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C4a Evaluating the LEDs of the Panel Control

The Panel control has the following LED properties:

You use the constants (hexadecimal values) listed in Table C-6 to evaluate the

CpuBusfl
CpuBusf2
CpuExtF
CpuFrce
CpulntF
CpuRun
CpuStop

states of the LEDs on the Panel control. These masks determine the status of the
individual LED property.

Table C-6 Masks for the LEDs of the Panel Control

Mask (Hexadecimal Value)

Description

1 LED color = orange

2 LED color = green

3 LED color =red

100 LED flashes for 3 seconds

200 LED is on (solid, not flashing)

300 LED flashes at a frequency of 5 Hz
400 LED flashes at a frequency of 20 Hz
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C.5 Properties and Methods of the Panel Control

ActiveFilePath Property
Applies to: Panel

This read-only property provides the pathname to the control engine (controller).
Syntax:
[ value =] object.ActiveFilePath

The ActiveFilePath property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A String expression that evaluates to the name of the
controller.

AutoStart Property
Applies to: Panel

This property allows you to select the “autostart” feature for WinLC. This property
is valid only for WinLC. For information about the autostart feature, refer to the
WinLC documentation.

Syntax:
object.AutoStart [= value]

The AutoStart property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A Boolean expression that specifies whether the autostart

feature is enabled for object.

The settings for value are:

Setting Description
True The autostart feature of WinLC is enabled.
False (default) The autostart feature of the WinLC is disabled.

Windows Logic Controller WinLC RTX Overview
C-12 A5E00083518-01



Panel Control

CheckPW Property
Applies to: Panel

This property determines whether the password entered was correct. If the
password entered matches the password stored in the control engine, the control
executes the requested action.

Syntax:
object .CheckPW [=  value]
The CheckPW property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A integer that determines whether object performs the

requested action.

The settings for value are:

Setting Description

0 - Check_Wait (default) The control engine is verifying the password.

1 - Check_Good The password entered was correct and the action is
allowed.

2 - Check_Bad The password entered was incorrect and the action is not
allowed.

ConnectCPU Property
Applies to: Panel

This property establishes a connection to or disconnects from the S7 controller
(WIinLC or any of the slot PLCs listed in section C.2).

Syntax:
object.ConnectCPU [= value]

The ConnectCPU method has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A Boolean expression that specifies whether object

establishes a connection to the S7 control engine.

Windows Logic Controller WinLC RTX Overview
A5E00083518-01 C-13



Panel Control

The settings for value are:

Setting Description
True Object connects to the S7 controller.
False (default) Object disconnects from the S7 controller.

ControlEngine Property

Applies to: Panel

This property stores the pathname or identification of the control engine connected
to the control.

Syntax:
object.ControlEngine [= value]

The ControlEngine property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A String that specifies the pathname or identification of the

control engine to be accessed by object.

CpuBusfl, CpuBusf2 Properties

C-14

Applies to: Panel

This read-only property determines the state of the communication indicators
(BUSF1 and BUSF2) on the control. BUSF1 shows the status of the distributed
(remote) 1/O for the control engine; if a second network is supported by the control
engine, BUSF2 shows the status of the second network.

Syntax:

[ value =] object.CpuBusfl
[ value =] object.CpuBusf2

The CpuBusfl and CpuBusf2 properties have these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the status of the bus

fault (BUSF1 or BUSF2) on object.

Windows Logic Controller WinLC RTX Overview
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Settings for value are shown in Table C-6.

CpuExtF Property
Applies to: Panel

This read-only property determines the state of the External Fault indicator on the
control. External faults are errors that are detected outside the CPU module of the
control engine, such as broken wiring for the local I/O.

Syntax:
[ value =] object.CpuExtF
The CpuExtF property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the status of the

EXTF indicator on object.

The settings for value are shown in Table C-6:

CpuFrce Property
Applies to: Panel

This read-only property determines the state of the FRCE indicator on the control.
The FRCE indicator lights to signal that a user-generated Force request is in
effect. (Using programming software such as STEP 7, the user can stipulate that
the control engine set or force an input or output to a specific value.)

Syntax:
[ value =] object .CpuFrce

The CpuFrce property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the status of the

FRCE indicator on object.

The settings for value are shown in Table C-6.

CpulntF Property
Applies to: Panel

Windows Logic Controller WinLC RTX Overview
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This read-only property determines the state of the Internal Fault indicator on the
control. Internal faults are errors that are detected within the CPU module of the

control engine, such as programming errors that cause the control engine to go to
STOP mode.

Syntax:
[ value =] object.CpulintF
The CpulntF property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the status of the INTF

indicator on object.

The settings for value are shown in Table C-6:

CpuRun Property

Applies to: Panel

This read-only property determines the state of the RUN mode indicator on the
control.

Syntax:
[ value =] object.CpuRun

The CpuRun property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the state of the RUN
indicator.

The settings for value are shown in Table C-6:

CPURunning Property

C-16

Applies to: Panel

This read-only property indicates that the control engine is still running or in
operation. The control queries the control engine, and if the control engine
responds, the property is set to True.

Syntax:

[ value =] object.CpuRunning
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The CpuRunning property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A Boolean expression that specifies whether the control

engine is running and able to respond to the control.

The settings for value are:

Setting Description

True The control engine is running and has responded to the
query by the control

False (default) The control engine is not running or not
responding.

CpuStop Property
Applies to: Panel

This read-only property determines the state of the STOP mode indicator on the
control.

Syntax:
[ value =] object.CpuStop
The CpuStop property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the state of the STOP
indicator.

The settings for value are shown in Table C-6:

FirmwareVersion Property

Applies to: Panel

This read-only property stores the revision level of the firmware in the control
engine.

Syntax:

[ value =] object.FirmwareVersion

Windows Logic Controller WinLC RTX Overview
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The FirmwareVersion property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A String value that describes the revision level of the

firmware for the control engine.

FmrSwitch Property
Applies to: Panel
This property restarts the backup battery of the slot PLC.
Syntax:
object.FmrSwitch [= value]

The FmrSwitch property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A Boolean expression that causes the control engine to

restart the backup battery.

The settings for value are:

Setting Description
True The control engine performs a battery restart (FMR).
False (default) No action is required.

HardwareVersion Property

Applies to: Panel

This read-only property stores the version (revision level) of the control engine
hardware.

Syntax:

[ value =] objectHardwareVersion

Windows Logic Controller WinLC RTX Overview
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The HardwareVersion property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A String value that describes the hardware version for the

control engine.

mifb Property
Applies to: Panel
This read-only property stores the order number for the slot PLC.
Syntax:
[ value=] object.mlfb

The mlfb property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A String value that specifies the order number for the

control engine.

ModeCitrl Property
Applies to: Panel

This property changes the operating mode of the control engine.
Syntax:
object.ModeCitrl [= value]

The ModeCtrl property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer that determines the new operating mode for the

control engine.
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The settings for value are:

Setting Description

0 MRES (memory restart)
1 STOP mode

2 RUN mode

3 RUN-P mode

OnStateChanged Method

Applies to: Panel

This method is used internally by the control and must not be modified.

PSBattF Property

Applies to: Panel

This read-only property determines the state of the Battery Fault indicator on the
control. This property is valid for the control engine. The BATTF indicator lights to
alert the user to a battery fault condition.

Syntax:
[ value =] object.PSBattF
The PSBattF property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the status of the

BATTF indicator on object.

The settings for value are shown in Table C-6:

PSOnN Property

C-20

Applies to: Panel

This read-only property determines the state of the power supply (ON) indicator on
the control. The ON indicator shows the status of the power supply for the control
engine.

Syntax:
[ value =] object.PSOnN
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Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer expression that specifies the status of the PS

indicator on object.

The settings for value are shown in Table C-6:

PwrSwitch Property
Applies to: Panel
This property indicates the on/off status of the control engine.
Syntax:
object.PwrSwitch [= value]

The PwrSwitch property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A Boolean expression that specifies whether the control

engine is on or off.

The settings for value are:

Setting Description
True The control engine is on.
False The control engine is off.

ResourceFile Property

Applies to: Panel

This read-only property determines the name of the DLL for the language-specific
Strings displayed by the control.

Syntax:
object.ResourceFile [= value]

The ResourceFile property has these parts:
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Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A String that determines the name for the

language-specific DLL.

ResourcePath Property

Applies to: Panel

This read-only property contains the pathname of the language-specific DLL
selected for the control.

Syntax:
object.ResourcePath [= value]

The ResourcePath property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A String that determines the pathname for the

language-specific DLL.

SecurityState Property

C-22

Applies to: Panel
This property determines the level of security in effect for the control:
» Panel control handles security checking.

» Disables the security checking by the control. Your application performs all of
the security. (See also the SwitchOK property.)

Syntax:
object.SecurityState [= value]

The SecurityState property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value An integer that determines the level of security for object.
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The settings for value are:

Setting Description
0 Panel control provides security checks.
1 The security checking performed by the control is

disabled. Your application performs all management of
security. (See also the SwitchOK property.)

SetPassword Property

Applies to: Panel

If set to True, this property executes the “Set Password” function for changing the
password in the control engine.

Syntax:
object.SetPassword [= value]

The SetPassword property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A Boolean expression that determines whether to call the

“Set Password” function.

The settings for value are:

Setting Description

True The control calls the “Set Password” function for changing
the password in the control engine.

False (default) No action.

ShowErrorBoxes Property

Applies to: Panel

This property specifies whether to display the default error boxes when there is a
user-generated error. Every time an error occurs, an Error event will be generated.

If the ShowErrorBoxes property is enabled (selected), a default error message box
will be displayed.

All errors on connections are reported by the Connection Error event.
Syntax:

object.ShowErrorBoxes [= value]
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The ShowErrorBoxes property has these parts:

Part Description

object An object expression (identifier for the specific SIMATIC
control) that evaluates to an object in the Applies To list.

value A Boolean expression that specifies whether the control
displays error boxes.

The settings for value are:

Setting Description
True (default) The control shows the default error boxes.
False The error boxes are hidden.

SwitchOK Property
Applies to: Panel

If your application is handling the security (by disabling the security checking
normally performed by the control), this property allows a requested action to be
performed. When the SecurityState property is set to 3, the control waits until the
SwitchOK property is set to True before performing any action requested by a

user. If the SecurityState property is set to 4, this property must be set to “True” in
order for any action to take place.

Syntax:
object.SwitchOK [= value]
The SwitchOK property has these parts:

Part Description

object An object expression that evaluates to an object in the
Applies To list.

value A Boolean expression that allows or disallows an action to

be performed.

The settings for value are:

Setting Description
True The user has permission to affect the requested action.
The control then performs the requested action.
False (default) The control does not perform the requested
action.
Windows Logic Controller WinLC RTX Overview
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C.6 Events of the Panel Control

AlarmCondition Event

Applies to: Panel

This event occurs when the Panel control detects that the control engine has an
error condition or has gone to STOP mode.

Syntax: AlarmCondition()

ConnectionError Event

Applies to: Panel

This event occurs when an error on a connection occurs. The ConnectionError
event provides no parameters.

Syntax:

ConnectionError()

MouseDown Event
Applies to: Panel

This event occurs when a mouse button is pressed while the mouse cursor is over
the control.

Syntax:

MouseDown(short  Button, short Shift, OLE_XPOS_PIXELS x, _
OLE_YPOS_PIXELS y)
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The MouseDown event has these parts:

Part

Description

Button

Shift

X,y

MouseMove Event

Applies to: Panel

An integer that identifies the button that was pressed to
cause the event

The button argument is a bit field with bits corresponding
to the left button (bit 0), right button (bit 1), and middle
button (bit 2). These bits correspond to the values 1, 2,
and 4, respectively. Only one of the bits is set, indicating
the button that caused the event.

An integer that corresponds to the state of the SHIFT,
CTRL, and ALT keys when the button specified in the
button argument is pressed or released

A bit is set if the key is down. The shift argument is a bit
field with the least-significant bits corresponding to the
SHIFT key (bit 0), the CTRL key (bit 1), and the ALT key (bit
2). These bits correspond to the values 1, 2, and 4,
respectively. The shift argument indicates the state of
these keys. Some, all, or none of the bits can be set,
indicating that some, all, or none of the keys are pressed.
For example, if both CTRL and ALT were pressed, the
value of shift would be 6.

returns a number that specifies the current location of the
mouse pointer

This event occurs when the mouse cursor moves over the control.

Syntax:

MouseMove(short

Button, short Shift, OLE_XPOS_PIXELS x, _

OLE_YPOS_PIXELS y)

C-26
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The MouseMove event has these parts:

Part

Description

Button

Shift

X,y

MouseUp Event

Applies to: Panel

An integer that identifies the button that was pressed to
cause the event

The button argument is a bit field with bits corresponding
to the left button (bit 0), right button (bit 1), and middle
button (bit 2). These bits correspond to the values 1, 2,
and 4, respectively. Only one of the bits is set, indicating
the button that caused the event.

An integer that corresponds to the state of the SHIFT,
CTRL, and ALT keys when the button specified in the
button argument is pressed or released

A bit is set if the key is down. The shift argument is a bit
field with the least-significant bits corresponding to the
SHIFT key (bit 0), the CTRL key (bit 1), and the ALT key (bit
2). These bits correspond to the values 1, 2, and 4,
respectively. The shift argument indicates the state of
these keys. Some, all, or none of the bits can be set,
indicating that some, all, or none of the keys are pressed.
For example, if both CTRL and ALT were pressed, the
value of shift would be 6.

returns a number that specifies the current location of the
mouse pointer

This event occurs when a mouse button is released while the mouse cursor is over

the control.

Syntax:

MouseUp(short

Button, short Shift, OLE_XPOS_ PIXELS x, _

OLE_YPOS_PIXELS y)
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The MouseUp event has these parts:

Part Description

Button An integer that identifies the button that was pressed to
cause the event

The button argument is a bit field with bits corresponding
to the left button (bit 0), right button (bit 1), and middle
button (bit 2). These bits correspond to the values 1, 2,
and 4, respectively. Only one of the bits is set, indicating
the button that caused the event.

Shift An integer that corresponds to the state of the SHIFT,
CTRL, and ALT keys when the button specified in the
button argument is pressed or released
A bit is set if the key is down. The shift argument is a bit
field with the least-significant bits corresponding to the
SHIFT key (bit 0), the CTRL key (bit 1), and the ALT key (bit
2). These bits correspond to the values 1, 2, and 4,
respectively. The shift argument indicates the state of
these keys. Some, all, or none of the bits can be set,
indicating that some, all, or none of the keys are pressed.
For example, if both CTRL and ALT were pressed, the
value of shift would be 6.

X,y returns a number that specifies the current location of the
mouse pointer

MResBttnSelected Event
Applies to: Panel

This event occurs when a user selects (clicks on) the memory reset (MRES)
button on the Panel control. You can use this event for implementing external
security for your process.

Syntax: MResBttnSelected()

RunBttnSelected Event
Applies to: Panel

This event occurs when a user selects (clicks on) the RUN mode button on the
Panel control. You can use this event for implementing external security for your
process.

Syntax: RunBttnSelected()
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RunPBttnSelected Event
Applies to: Panel

This event occurs when a user selects (clicks on) the RUN-P mode button on the

Panel control. You can use this event for implementing external security for your
process.

Syntax: RunPBttnSelected()

StopBttnSelected Event
Applies to: Panel

This event occurs when a user selects (clicks on) the STOP mode button on the

Panel control. You can use this event for implementing external security for your
process.

Syntax: StopBttnSelected()

UpdateState Event
Applies to: Panel

This event occurs when the Panel control detects a change in the status of the
control engine.

Syntax: UpdateState()
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Accessing consistent data,|6-10, B-2
Accessing WInLC from STEP 7, 4-8
Accumulators

addresses, B-1

number of (WinLC),|1-2

WinLC specifications, B-Z2--B-4
ActiveFilePath property, C-12
ActiveX controls, properties, Panel control,

C-6-C-7
Address ranges| 6-9-6-12

DB, B-1

diagnostic addresses for the distributed 1/O,

6-11
FB, B-1/|B-4
FC, B-1
Addressing the distributed 1/0/ 6-9-6-12
diagnostic addresses, 6-11
Adjust scan time| 4-14-4-16
AlarmCondition event, C-25
Amplifying the network signal,|6-7
Analog 1/0, B-1
WinLC specifications, B-2, B-3
Archive file
creating,|4-25
restoring,|4-25
Authorizing the WinLC software| 2-7-2-9
installing and removing the software,
2-3-2-5
procedure, 2-8
See also README.TXT on the
authorization disk
guidelines, 2-8
removing the authorization, |2-8
running without authorization, 2-8
transferring the authorization, 2-8
AUTHORS.EXE
removing the WinLC authorization, 2-8
transferring the WIinLC authorization, 2-8
WinLC authorization| 2-7-2-9
installation procedure| 2-3-2-5
Autostart| 4-1€-4-20
AutoStart property, C-12
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Backup, archive file,|4-25
Baud rate,|6-6 |B-1
cable length, 6-6
repeaters, |6-7
spur lines, 6-7
WinLC specifications, B-2,|B-3
Bit memory (M) area, B-1
clock memory, 5-11
memory reset, 5-5//C-4
retentive, 5-13--5-15
WinLC specifications, B-2,|B-3
Blocks supported by WinLC, B-1--B-4
addresses
DBs, B-1
FBs, B-1
FCs, B-1
OBs, B-1
SFBs, B-11
SFCs, B-7-B-9
total number, |B-2
Blue screen (unrecoverable fault in Windows
NT), 5-9

C

Cable length, 6-6
baud rate, |6-6
repeaters, |6-7
spur lines, 6-7
Central 1/0. See Local I/O
Changing the language,|4-20
Changing the operating mode,/4-10, 5-2,|C-3
effect on status indicators,/4-10,/5-2/|C-3
from STEP 7 or WinCC,|4-10,/5-2,/C-3
CheckPW property, C-13
Clock, 5-17
Clock memory, B-1
configuration,| 5-11
WinLC specifications, B-2,|B-3
Cold restart, 4-10-4-12
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Communication Computing
address guidelines, 6-3| 6-4 Panel control, properties, C-6-C-7
amplifying the network signals, 6-7 properties, Panel, C-6-C-7
assigning addresses for distributed 1/O, Configuring WinLC, STEP 7 hardware
6-8-6-11 configuration, 4-4-4-6
baud rate,|6-6 Confirmation level (security), 4-22
cable length, 6-6 ConnectCPU property, C-13
capabilities of WinLC, B-Z-B-4 ConnectionError event, C-25
consistent data, 6-10, B-2 Considerations, PROFIBUS-DP network,
diagnostic address for distributed 1/0,| 6-11 6-2—-6-5
distributed 1/O, addresses, 6-9--6-12 Consistent data, mapping the memory
DP slaves, B-2-B-4 addresses| 6-8-6-11
guidelines, 6-2-6-5 Control engine
summary, 6-3!6-4 selecting for Panel control, C-6

loading and transferring distributed 1/0, B-2 SIMATIC controls, Panel, C-1
mapping I/O into the process image area,  Control panel

B-2 register WinLC as NT service, 4-16
monitoring time for READY,| 5-11 WinLC as NT service, 2-5
MPI address, default address (WinLC), 4-8 ControlEngine property, C-14
MPI address for WinLC,|6-3 Copy-protection, 2-7-2-9
nodes,|6-3 installing and removing the WinLC software,
number of segments allowed, 6-4 2-3-2-5
process image, B-2 removing the authorization, 2-8
PROFIBUS-DP transferring the authorization, 2-8
status indicator (WinLC), 6-12 Counters,|B-1
WinLC specifications, B-2-B-4 memory reset,|5-5||C-4
range of addresses, |6-3 retentive, 5-13-5-15
repeaters,|6-7 WinLC specifications, B-2||B-3
amplifying the network signals, |6-7 CP 5412
guidelines, 6-5 addressing the distributed 1/0O, 6-9--6-12
spur lines, |6-7 baud rate, 6-6
not allowed for some baud rates, 6-7 cable length, 6-6
stations, 6-3 diagnostic addresses for distributed 1/O,
troubleshooting, status indicator (WinLC), 6-11
6-12 guidelines for configuring the network,
using an RS 485 repeater, 6-5 6-2-6-5
Complete restart repeaters, 6-7
resetting the memory areas, 5-5, C-4 spur lines, 6-7
startup characteristics, 5-11 not allowed for some baud rates,|6-7
status indicators, 5-3,/C-4/ C-5 troubleshooting, status indicator (WinLC),
Components of WinAC| 1-1-1-4 6-12
communications processor (CP), 2-2 WinLC specification, B-2-B-4
WiInLC, 2-2 CP 5613 card, installation notes/| 2-9--2-10
Components of WinLC, 1-2 CPU (processor), system requirements, 1-3

Computer requirements, 1-3
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CPU panel| 4-2--4-3, 4-9-4-12, 5-2-5-4
autostart, 4-1&-4-20
complete restart, status indicators, 5-3
MRES button,|5-5
operating modes, 4-10, 5-2
effect of autostart,|4-18
resetting the memory areas, 5-5
restart (cold or warm), 4-10
RUN mode
autostart| 4-1&-4-20
status indicator, 5-3
status indicators| 4-6-4-12,|5-3
complete restart, 5-3
PROFIBUS-DP, | 6-12
STOP mode
autostart| 4-1&-4-20
status indicator, 5-3
system fault (SF) indicator, 5-3
tuning panel, 4-14-4-16
CPU Panel control
MRES button,|C-4
resetting the memory areas, C-4
RUN mode, status indicator, C-4|/C-5
status indicators, complete restart,|C-4
STOP mode, status indicator, C-4
system fault (SF) indicator, C-4,/C-5
CpuBusfl, CpuBusf2 properties, C-14
CpuEXxtF property,| C-15
CpuFrce property, C-15
CpulntF property, C-15
CpuRun property, C-16
CpuRunning property, C-16
CpuStop property,|C-17
Crash operations (OB84), 5-9
Customize
autostart feature| 4-18--4-20
changing the language,|4-20
Cycle time
configuration, 5-12-5-14
description| 4-12-4-15
execution time, 4-12
expanding the execution time, 4-13
minimum scan cycle time, 4-12
sleep time| 4-12| 5-12--5-14
Cyclic interrupt, configuring, 5-15

D
Data, SIMATIC controls, Panel, C-6-C-7
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Data block (DB)
address ranges, B-1
number supported by WinLC, B-3
retentive, 5-13--5-15
size, B-1, B-4
Data integrity (consistent data), 6-11, B-2
Decentralized I/O. See Distributed 1/0
Diagnostics buffer; 5-7-5-9
following a memory reset, 5-5/|C-4
system status list, A-1-A-5
Diagnostics/clock, assigning parameters, 5-15
Digital I/O,|B-1
See also Distributed I/O
WinLC specifications, B-2,|B-3
Displaying the scan cycle times| 4-14-4-16
Distance
cable length and baud rate, |6-6
PROFIBUS-DP, 6-2-6-7
using repeaters, 6-7
Distributed 1/0
consistent data| 6-6-6-11,|B-2
DP address area of the WinLC, B-1
error OB, |B-6
guidelines for configuring the network,
6-2-6-5
Load and Transfer instructions, B-2
process image area, B-2
scan cycle of the WinLC, 4-12-4-14
WinLC specifications, B-2,|B-3
Distributed peripherals. See Distributed I/O;
PROFIBUS
Downloading, maximum program size,|4-8
Downloading a program to WinLC
allowed in RUN-P mode or STOP mode,
4-10//5-2|C-3
not allowed in RUN mode, 4-10,/5-2, C-3
using STEP 7,4-8
DP (distributed peripherals). See distributed
I/0; PROFIBUS
DP address area of the WinLC, B-1
DP database. See PROFIBUS
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DP Master
See also PROFIBUS
capabilities of the WinLC, B-2-B-4
diagnostic addresses for distributed 1/O,
6-11
DP slaves, B-2-B-4
guidelines for configuring the network,
6-2—6-5
monitoring time for READY,| 5-11
WinLC specifications| B-2--B-4
DP Slave
See also PROFIBUS
diagnostic addresses for distributed 1/O,
6-11
guidelines for configuring the network,
6-2—6-5
monitoring time for READY,| 5-11
number allowed, B-2
WinLC specifications,|B-2| B-3
Drivers for CP 5613, 2-9-2-10

E

English, changing to, 4-20
Error OBs, B-4| B-5-B-7
Events
AlarmCondition, C-25
ConnectionError, C-25
MouseDown, C-25
MouseMove, C-26
MouseUp, C-27
MResBttnSelected, C-28
RunBttnSelected, C-28
RunPBttnSelected, C-29
StopBttnSelected, C-29
UpdateState,|C-29
Example, Panel control programs, C-7
Execution time
per instruction, B-11-B-13
scan cycle| 4-12-4-14
tuning panel, 4-14-4-16

F

FirmwareVersion property, C-17
FmrSwitch property, C-18
French, changing to, 4-20
Function (FC)
address ranges,|B-1
number supported by WinLC, B-3
size, B-1, B-4

Index-4

Function block (FB)
address ranges, B-1||B-4
number supported by WinLC,|B-3
size, B-1

G

German, changing to, 4-20
Guidelines
assigning network addresses (PROFIBUS),
6-3,6-4
CP 5613 card, 2-9-2-10
installation overview, 2-2
instruction execution times, B-11-B-13
minimum sleep time for WinLC, 4-12
MRES (memory reset),| C-2
PROFIBUS-DP network| 6-2-6-5
scan cycle and sleep time, 4-12--4-14
setting the minimum scan cycle, 4-12--4-14
using an RS 485 repeater, 6-5
using OB35| 4-12-4-14
WinLC authorization, 2-7
See also README.TXT on the
authorization disk

H

Hardware configuration

clock,|5-17

clock memory, 5-11

diagnostic addresses for distributed 1/O,

6-11

retentive data, 5-13-5-15

scan cycle, 4-12--4-14, 5-12-5-14

startup characteristics, 5-11

using STEP 7, 4-4-4-6

WinLC specifications, B-Z-B-4
HardwareVersion property, C-18
HMI (Human/Machine interface),|1-2

I/O configuration
STEP 7 hardware configuration| 4-4-4-6
WinLC specifications, B-Z-B-4

Input register
addressing the distributed 1/0O, 6-9--6-12
diagnostic address of distributed 1/0, 6-11
scan cycle, 4-12-4-14
WinLC specifications, B-Z-B-4
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Inserting hardware components, 4-6
Installation
authorization, 2-7-2-9
copy-protection, 2-7-2-9
removing the authorization, |2-8
transferring the authorization,| 2-8
CP 5613 notes| 2-9-2-10
installing and removing the WinLC software,
2-3-2-5
installing the WinLC authorization,|2-8
guidelines, 2-8
See also README.TXT on the
authorization disk
installing WIinLC with the CP 5412, 2-2
operating with no valid authorization,|4-9
removing the authorization, |2-8
system requirements, |1-3
transferring the authorization, 2-8
Instruction execution times, B-11-B-13
Interrupt
configuring priority class, 5-14
cyclic, 5-15
time-of-day, 5-14
Interrupt mode (CP 5613), 2-9--2-10
Interrupt OBs,|B-4||B-5
Interrupt Request number (IRQ), 2-9--2-10

L

Language selection, for WinAC, 4-20
Load memory,|B-1
WinLC, B-2-B-4
Loading and transferring distributed 1/O,|B-2
Local data
size, B-1
WinLC specifications, B-2| B-3
Local I/O (process image)
addressing, B-2
addressing the distributed 1/0O| 6-9--6-12
Logic blocks
address ranges
DB, B-1
FB, B-1,|B-4
FC, B-1
maximum size
DB, B-1,/B-4
FB, B-1
FC, B-1/B-4
number supported by WinLC, B-2
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M

Mapping 1/O to the process image area,
6-8-6-11, B-2
Master
capabilities of WinLC| B-Z--B-4
diagnostic addresses for distributed 1/O,
6-11
DP slaves| B-2-B-4
guidelines for configuring the network,
6-2—-6-5
monitoring time for READY, 5-11
WinLC specifications, B-2
Maximum asynchronous SFCs,|B-3| B-7
Maximum program size,|4-8
Maximum size
DB, B-1
FB, B-1, B-4
FC, B-1,B-4
Megahertz (MHz), system requirements, |1-3
Memory areas
assigning addresses for distributed 1/O,
6-8-6-11
consistent data, 6-8||B-2
diagnostic address for distributed 1/0, 6-11
memory reset, 5-5//C-4
range of addresses| 6-6-6-10
specifications, B-Z2-B-4
Memory bits, B-1
clock memory, 5-11
memory reset, 5-5//C-4
retentive, 5-13--5-15
WinLC specifications, B-2,|B-3
Memory requirements, |1-3
Memory reset (MRES), 4-9-4-12, 5-2-5-4
C-2-C-4
resetting the memory areas, |5-5/C-4
Messages
diagnostic addresses for DP slaves, 6-11
system status list (SZL), A-1-A-5
MHz, system requirements, |1-3
Minimum scan cycle time| 4-12--4-16
tuning panel| 4-14-4-16
Minimum scan time, 5-12-5-14
mlfb property,| C-19
Mode selector, 5-2--5-4, C-2-C-4
ModeCtrl property, C-19
Modes (operating), 4-9-4-12
Monitoring and modifying data, 5-8
Monitoring the diagnostic information, 5-7-5-9
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Monitoring the scan cycle, tuning panel,
4-14-4-16
Monitoring time (scan cycle), 4-12-4-16
Monitoring time for READY, 5-11
MouseDown event, C-25
MouseMove event, C-26
MouseUp event, C-27
MPI
address following a memory reset, 5-5/ C-4
default MPI address (WinLC),|4-8
WinLC address,|6-3
MRES, 4-9--4-12, 5-2-5-4
resetting the memory areas, 5-5
MRES (memory reset)| C-2-C-4
resetting the memory areas, C-4
MResBttnSelected event, C-28
Multi-point interface (MPI). See MPI

N

Nesting depth, WinLC specifications, B-3
Network
addressing guidelines,|6-3}/6-4
addressing the distributed 1/0| 6-9-6-12
diagnostic addresses, 6-11
baud rate,|6-6
cable length, 6-6
guidelines, 6-3,|6-4
monitoring time for READY,| 5-11
number of segments allowed, 6-4
repeaters, 6-7
guidelines, 6-5
spur lines, |6-7
not allowed for some baud rates, 6-7
Nodes
maximum allowed on a subnetwork, 6-4
number of addressable nodes,|6-5
PROFIBUS, 6-3
using a repeater, 6-5
NT service
automatic or manual operation, 2-5
register and unregister, 4-16

Index-6

Number of blocks supported, WinLC
specifications, B-3
Number of blocks that can be downloaded,|4-8

O

OB. See Organization block (OB)
OB1
effect on the scan cycle,|5-12
expanding the execution time, 4-13
increasing the scan cycle,|4-13
scan cycle, 4-12
start event, B-4
OB10
configuring, 5-14
start event, B-5
OB100, start event, B-4
OB102, start event, B-4
OB121, start event, B-6-B-8
OB122, start event, B-6-B-8
0B20
effect on the scan cycle| 4-12-4-14
increasing the scan cycle,|4-13
start event, B-5
0OB35
configuring, 5-15
effect on the scan cycle| 4-12-4-14,5-12
increasing the scan cycle,|4-13
start event, B-5
OB36, start event, B-5
OB40, start event, B-5
OB80, start event, B-6--B-8
OB82, start event, B-5-B-8
OB83, start event, B-5-B-7
OB84, Operations when Windows NT crashes,
5-9
OBS85, start event, B-5-B-7
OB86, start event, B-5-B-7
OnStateChanged method, C-20
Operating modes, 4-10,|5-2| B-6, C-2,|C-3
effect on scan cycle, 4-13
loading the configuration parameters, 5-10
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Operating system requirements, |1-3
Operational features of WinLC, 1-2
Order number, B-2
Organization block (OB)
number supported by WinLC, B-3
OB1, B-4
effect on the scan cycle, 5-12
increasing the execution time, 4-13
increasing the scan cycle, 4-13
scan cycle| 4-12--4-14
OB10, B-5
OB100, B-4
OB102, B-4
OB121, B-€-B-8
OB122, B-€-B-8
0OB20, B-5
increasing the execution time, 4-13
increasing the scan cycle, 4-13
scan cycle| 4-12-4-14
OB35, B-5
effect on the scan cycle, 5-12
increasing the execution time, 4-13
increasing the scan cycle, 4-13
scan cycle| 4-12-4-14
OB36, B-5
0OB40, B-5
OB80, B-6-B-8
0OB82, B-5-B-8
0OB83, B-5-B-7
0B85, B-5-B-7
OB86, B-5-B-7
OBs supported by WinLC, B-4
Output register
addressing the distributed 1/0O| 6-9--6-12
diagnostic address for distributed 1/0, 6-11
scan cycle| 4-12-4-14
WinLC specifications, B-Z--B-4
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P
Panel control, C-1--C-12

complete restart, status indicators,|C-5

events
AlarmCondition, C-25
ConnectionError, C-25
MouseDown, C-25
MouseMove, C-26
MouseUp, C-27
MResBttnSelected, C-28
RunBttnSelected, C-28
RunPBttnSelected,| C-29
StopBttnSelected, C-29
UpdateState, C-29
operating modes, |C-3
properties| C-€-C-7
ActiveFilePath, C-12
AutoStart, C-12
CheckPW, C-13
ConnectCPU, C-13
ControlEngine, C-14
CPU operating modes, C-11
CpuBusfl, CpuBusf2, C-14
CpuExtF, C-15
CpuFrce, C-15
CpulntF, C-15
CpuRun, C-16
CpuRunning, C-16
CpuStop, C-17
FirmwareVersion, C-17
FmrSwitch, C-18
HardwareVersion, C-18
LEDs, C-11
mlfb, C-19
ModeCitrl, C-19
OnStateChanged method, C-20
PSBattF, C-20
PSOn,/ C-20
PwrSwitch, C-21
ResourceFile, C-21
ResourcePath, C-22
SecurityState,| C-22
SetPassword,|C-23
ShowErrorBoxes, C-23
SwitchOK, | C-24
sample programs, C-7
selecting control engine, C-6
status indicators, |C-5
complete restart,|C-5
STOP mode, status indicator, C-5

Index-7



Index

Password
change, 4-23
enable,|4-22
validity, 4-24
Pentium, system requirements, | 1-3
Performance
execution times (instructions), B-11-B-13
OBs supported, B-4-B-7
SFBs supported, B-11
SFCs supported, B-7--B-9
system requirements, 1-3
technical specifications, B-2-B-4
testing, instruction execution time,
B-11-B-13
PLC, archive file, 4-25
Polled mode (CP 5613)| 2-9-2-10
Procedures
access the tuning panel 4-14--4-16
accessing WinLC from STEP 7, 4-8
authorizing the WinLC software, 2-8
See also README.TXT on the
authorization disk
adding an authorization,|2-8
guidelines, 2-8
no valid authorization, |2-7/|4-9
removing an authorization, 2-8
change the operating mode, 4-10/|C-3
create hardware configuration (STEP 7),
4-4-4-6
determine the sleep time, 4-12
downloading the user program, 4-8
installing the WinLC software, 2-3
monitor the scan cycle time, 4-14-4-16
password| 4-21-4-25
removing the authorization,|2-8
reset the memory areas,|4-11,/C-5
selecting cold or warm restart, 4-10--4-12
set WinLC priority, 4-14-4-16
shut down the WinLC controller, 4-17
start the WinLC controller, 4-17
starting the WIinLC software, 4-2
uninstalling WinLC, |2-6
Process data, SIMATIC controls, Panel,
C-6-C-7
Process Field Bus. See PROFIBUS-DP

Index-8

Process image, B-1
addressing the distributed 1/0, 6-9--6-12,
B-2
diagnostic addresses for distributed 1/O,
6-11
WinLC specifications, B-2||B-3
Process-image input table, B-2
addressing the distributed 1/0O, 6-9--6-12
distributed I/O, diagnostic addresses, 6-11
Process-image output table,|B-2
addressing the distributed 1/0O, 6-9--6-12
distributed I/O, diagnostic addresses, 6-11
Processor (CPU), system requirements,|1-3
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PROFIBUS-DP
addresses, repeaters,|6-7
amplifying the network signals, 6-7
baud rate, 6-6
cable length, 6-6
capabilities of WinLC, B-2-B-4
configuring the 1/0, STEP 7, 4-4-4-6
consistent data, 6-9--6-11,/B-2
distributed 1/O
addresses, 6-9-6-12
consistent data) 6-8--6-11
DP address area, B-2
consistent data) 6-8--6-11
DP slaves, B-2-B-4
error OB, B-6
guidelines, 6-2-6-5
accessing distributed 1/0, 6-8--6-11
summary, 6-3/6-4
using repeaters, 6-5

Load and Transfer instructions, 6-9--6-11|

B-2
monitoring time for READY, 5-11
MPI address for WinLC, |6-3
nodes allowed, 6-3
number of segments allowed, |6-4
process image, B-2
process image area of WinLC, B-2
range of addresses, 6-3
repeaters, 6-7

amplifying the network signals, 6-7
spur lines, |6-7

not allowed for some baud rates, 6-7

status indicator,|6-12
system status list| A-1-A-5
troubleshooting problems
status indicator, 6-12
system status list (SZL); A-1-A-3
WinLC specifications, B-Z2--B-4
Program, archive file, 4-25
Program size, 4-8
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Properties
ActiveFilePath, C-12
AutoStart, C-12
CheckPW, C-13
ConnectCPU, C-13
ControlEngine, C-14
CpuBusfl, CpuBusf2, C-14
CpuExtF,|C-15
CpuFrce,|C-15
CpulntF, C-15
CpuRun, C-16
CpuRunning,|C-16
CpuStop, C-17
FirmwareVersion, C-17
FmrSwitch,|C-18
HardwareVersion,|C-18
mlifb, C-19
ModeCtrl, C-19
OnStateChanged method, C-20
Panel control, C-6-C-7, C-11
PSBattF, C-20
PSOn, C-20
PwrSwitch,| C-21
ResourceFile, C-21
ResourcePath, C-22
SecurityState,| C-22
SetPassword, C-23
ShowErrorBoxes, C-23
SwitchOK,| C-24
PSBattF property, C-20
PSOn property,| C-20
PwrSwitch property, C-21

R

RAM
Load memory for WinLC,|B-1
system requirements, 1-3
Ranges
DB addresses, B-1
FB addresses, B-1, B-4
FC addresses, B-1
Reading consistent data, 6-10, B-2
Readme file, guidelines for WinLC
authorization, 2-7
Real-time clock,|5-17//B-1
WinLC specifications, B-2,|B-3
Register WinLC as NT service, 4-16
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Remote 1/0
See also Distributed I/O
accessing data. 6-8--6-11
consistent data, 6-8--6-11
diagnostic addresses of DP slaves, 6-11
scan cycle of the WinLC, 4-12-4-14
Removing the WinLC authorization, 2-7-2-9
guidelines, 2-7
See also README.TXT on the
authorization disk
requirements, 2-6
Repeater modules
addressing, |6-5
extending the cable length, 6-7
guidelines, 6-5
spur lines, |6-7
Requirements, computer, 1-3
Resetting the memory areas, 5-5/|C-4
ResourceFile property, C-21
ResourcePath property,| C-22
Restart
resetting the memory areas, 5-5, C-4
startup characteristics, 5-11
status indicators, |5-3, C-4, C-5
Restart (cold or warm), 4-10
Restoring the user program, 4-25
See also Archive file
Retentive data
bit memory (M) area, B-1| B-3
counters,|B-1//B-3
data blocks (DBs), 5-13-5-15
resetting the memory areas, 5-5, C-4
timers,|B-1,|B-3
Retentive memory, WinLC specifications,|B-2
Retentive memory areas, B-3
configuration, 5-13-5-15
RS 485 repeater, 6-7
addressing, |6-5
guidelines, 6-5
RUN mode, 4-10, 5-2
cold or warm restart, 4-10--4-12
status indicator, 5-3
upload and download prohibited, 4-10//5-2
RUN mode (controller),|C-3
status indicator, C-5
RunBttnSelected event, C-28
Running WIinLC as an NT service
automatic or manual operation, 2-5
register and unregister, 4-16

Index-10

RUN-P mode, 4-10, 5-2

cold or warm restart, 4-10-4-12

upload and download allowed, 4-10,|5-2
RUN-P mode (controller), C-3

upload and download allowed, C-3
RunPBttnSelected event,|C-29

S

Saving the user program, 4-25
Scan cycle
adjust with tuning panel| 4-14--4-16
configuration, 5-12-5-14
description| 4-12-4-14
execution time, 4-12
expanding the execution time, 4-13
minimum scan cycle time, 4-12
sleep time, 4-12, 5-12-5-14
tuning,|4-12
SDB. See System data block (SDB)
SecurityState property, C-22
Selecting the operating mode, 4-10//5-2, C-3
SetPassword property, C-23
Setting the language, 4-20
Setting the system clock,|5-17
Setup program
authorization; 2-7-2-8
memory requirements, 1-3
WinLC, 2-3-2-5
SF. See System fault (SF) indicator
SFBs supported by WinLC, B-11
SFC14 and SFC15, transferring consistent
data,|6-9-6-11, B-2
SFCs supported by WinLC, B-7
ShowErrorBoxes property, C-23
Shutting down the WinLC controller,/4-17
SIMATIC 300 station, WIinLC I/O configuration,
4-4
SIMATIC controls, Panel control, C-1
SIMATIC NET
See also PROFIBUS
drivers for CP 5613, 2-9-2-10
Size
DB, B-1
FB, B-1| B-4
FC, B-1,B-4
Slave, monitoring time for READY, 5-11
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Slaves
diagnostic addresses for distributed 1/O,
6-11
guidelines for configuring the network,
6-2-6-5
number allowed, B-2
Sleep time| 5-12--5-14
adjust with tuning panel, 4-14-4-16
description| 4-12-4-14
minimum sleep time,|4-12
Software installation
installing and uninstalling WinLC, 2-3-2-5

removing the WinLC authorization, 2-7-2-9

transferring the WinLC authorization,
2-7-2-9

WinLC and CP 5412 together, 2-2

WinLC authorization| 2-7-2-9

Windows Logic Controller WinLC RTX Overview
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Specifications| B-1-B-3

analog 1/0; B-1-B-3

baud rate, B-1--B-3

bit memory (M) area (size), B-1//B-2
clock memory, B-1! B-2

counters, |B-1|/B-2

digital I/0/B-1-B-3

distributed I/O| B-1-B-3

DP slaves| B-1-'B-3

instruction execution times, B-11-B-13
Load memory, B-1, B-2-B-4

Local data (size),|B-1||B-2

memory bits (size), B-1/|B-2

MPI address, default address (WinLC), 4-8
nesting depth,|B-2

number of blocks supported (WinLC), B-2
OBs supported by WinLC, B-4

order number, B-2

process image (size), B-1, B-2
real-time clock B-1-B-3

retentive memory,|B-1, B-2

SFBs supported by WinLC, B-11
SFCs supported by WinLC, B-7
system clock| B-1-B-3

system requirements, 1-3

timers, B-1 B-2

Work memory, B-1| B-2-B-4
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Spur lines, 6-7

not allowed for some baud rates, 6-7

Start event

OB1,|B-4
OB10, B-5
OB100, B-4
OB102, B-4
OB121, B-6-B-8
OB122, B-6-B-8

STEP 7

accessing WinLC, 4-8

addressing the distributed 1/0O, 6-9-6-12
diagnostic addresses, 6-11

bit memory (M) area, retentive, 5-13--5-15

clock memory, configuration, 5-11

configuring the scan cycle, 4-12-4-14

configuring the WinLC, diagnostic
addresses of DP slaves, 6-11

0OB20, B-5 configuring WinLC| 4-4-4-6

OB35, B-5 counters, retentive| 5-13--5-15

0OB36, B-5 data blocks, retentive| 5-13-5-15

OB40, B-5 diagnostic addresses of DP slaves, 6-11

OB80, B-6—B-8 diagnostics buffer| 5-7-5-9

OB82, B-5-B-8 system status list; A-1-A-5

OB83, B-5-B-7 downloading to WinLC, 4-8

OB85, B-5-B-7 hardware configuration| 5-10-'5-16

OB86, B-5-B-7 assigning addresses for distributed 1/O,
Starting 6-1, 6-8-6-11

startup configuration, 5-11 clock memory, 5-11
startup not equal to actual configuration, diagnostic addresses for distributed 1/O,
5-11 6-11
WInLC as NT service,|2-5 retentive data, 5-13-5-15
WinLC controller,|4-17 scan cycle| 4-12--4-14, 5-12-5-14
WinLC software, 4-2-4-4 startup characteristics, 5-11
Stations. See Nodes, PROFIBUS memory bits, retentive| 5-13-5-15
Status block, using STEP 7 to monitor the monitoring and modifying data, 5-8

program, 5-8 MPI address, default address (WinLC), |4-8
Status indicators, 4-9-4-12, 5-2--5-4| C-2-C-4, MPI address for WinLC, 6-3

C-5 retentive data

complete restart, 5-3,/C-5 bit memory (M) area 5-13--5-15

DP, 6-12 counters, 5-13-5-15

data blocks (DBs), 5-13--5-15
memory bits| 5-13-5-15
timers, 5-13-5-15

scan cycle, configuration, 5-12--5-14

setting the system clock, 5-17

startup characteristics, configuration, 5-11

status block, 5-8

system status list (SZL)| A-1-A-5

SZL, A-1-A-5

timers, retentive| 5-13--5-15

used with WinAC, |1-2

STOP mode, 4-10,/5-2,/C-3

cold or warm restart, 4-10-4-12

diagnostic information| 5-7-5-9

status indicator, |5-3,/C-5

upload and download allowed, 4-10,/5-2,
C-3

using STEP 7 to reset the memory areas,
5-5//C-4

StopBttnSelected event,|C-29

Windows Logic Controller WinLC RTX Overview
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Storing date and time in WinLC,|1-4
SwitchOK property, C-24
System clock, 5-17/ B-1
WinLC specifications, B-2| B-3
System data block (SDB)
configuration parameters, 5-10-5-16
configuring the scan cycle, 4-12-4-15
tuning the scan cycle| 4-14-4-16
System fault (SF) indicator, 5-3||C-5
System function (SFC)
maximum asynchronous SFCs, B-3! B-7
number supported by WinLC, B-3
reading the system clock, 5-17
setting the system clock,|5-17
SFCs supported by WinLC, B-7-B-9
System function block (SFB)
number supported by WinLC, B-3
SFBs supported by WinLC, B-11
System requirements,|1-3
System status list (SZL), A-1-A-5
SZL. See System status list, STEP 7

Windows Logic Controller WinLC RTX Overview
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T

Technical information, B-1-B-3

analog 1/0, B-2

baud rate, B-2

bit memory (M) area (size), B-2

clock memory, B-2

consistent data/ 6-8--6-11

counters, |B-2

digital 1/0, B-2

distributed I/0,|B-2

DP slaves,|B-2

instruction execution time, B-11-B-13

Load memory, B-2-B-4

Local data (size),|B-2

memory bits (size), B-2

MPI address, default address (WinLC), 4-8

nesting depth,|B-2

number of blocks supported (WinLC), B-2

OBs supported by WinLC, B-4

order number, B-2

process image (size),|B-2

real-time clock, B-2

retentive memory,|B-2

SFBs supported by WinLC, B-11

SFCs supported by WinLC, B-7

specifications, B-2

system clock, B-2

timers, B-2

Work memory, B-2-B-4
Terminating resistor, 6-3
Time-of-day interrupt, configuring, 5-14
Timers,|B-1

memory reset, 5-5//C-4

retentive, 5-13--5-15

WinLC specifications, B-2,|B-3
Toggling bits of the clock memory, 5-11
Transfer of parameters, configuration, 5-11
Transferring the WIinLC authorization, 2-7-2-9

guidelines, 2-7

See also README.TXT on the
authorization disk

uninstalling the WinLC software, 2-6
Troubleshooting

no valid authorization, |2-7

PROFIBUS problems,|6-12

system status list, A-1-A-5

WinLC installation, 2-4
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Tuning panel| 4-14-4-16
CPU usage| 4-14-4-16
execution time, 4-14-4-16
minimum cycle time| 4-14-4-16
sleep time| 4-14-4-16
tuning the scan cycle, 4-14-4-16
WinLC priority, 4-14-4-16
Tuning the scan cycle| 4-14-4-16

U

Uninstalling, WinLC, 2-6
Unrecoverable fault in Windows NT, 5-9
UpdateState event,| C-29
Uploading a program from a controller, allowed
in RUN-P mode or STOP mode, C-3
Uploading a program from WinLC
allowed in RUN-P mode or STOP mode,
4-10,/5-2, C-3
not allowed in RUN mode, 4-10, 5-2, C-3
User program, archive file, 4-25

W
Warm restart| 4-10--4-12

Index-14

Warnings, MRES (memory reset), C-2
Watchdog, scan cycle| 4-12-4-14
WInAC
accessing WinLC from STEP 7,/4-8
address ranges, FB, B-4
components, 1-1-1-4
configuring, WIinLC 1/O, 4-4-4-6
handling crashes, 5-9
installing WIinLC with the CP 5412, 2-2
MPI address, 6-3
default address, 4-8
following a memory reset, 5-5
0OB84,/5-9
OBs supported by WinLC, B-4
order number, B-2
product overview, 1-1-1-4
SFBs supported by WinLC, B-11
SFCs supported by WinLC, B-7
specifications| B-1--B-3
starting the WIinLC software, 4-2
Windows Automation Center. See WinAC
Windows Control Center (WinCC), used with
WinLC,|1-2
Windows Logic Controller. See WinLC
Windows NT, set WIinLC priority, 4-14-4-16
Windows NT Crash, 5-9
WinLC
accessing from STEP 7,|4-8
accumulators, B-1
address ranges
DB, B-1
FB, B-1|/B-4
FC, B-1
amplifying the network signals, 6-7
analog 1/0,|B-1
archive file, creating and restoring,|4-25
autostart feature, 4-18-4-20
baud rate, 6-6, B-1
bit memory (M) area, B-1
memory reset, 4-11, 5-5
cable length, 6-6
change password| 4-21-4-25
changing the operating mode, 4-10, 5-2
clock memory, B-1
configuration, 5-11
communication
amplifying the network signals, 6-7
repeater modules, 6-7
complete restart
resetting the memory areas, 4-11//5-5
status indicators,|5-3
component of WinAC, 1-2

Windows Logic Controller WinLC RTX Overview
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components,|2-2
configuration
clock memory, 5-11
parameters, 5-10-5-16
scan cycle| 5-12-5-14
startup characteristics, 5-11
configuring the 1/0| 4-4-4-6
consistent data, 6-8--6-11, B-2
counters, B-1
memory reset, 4-11//5-5
CPU panel, 4-9--4-12, 5-2-5-4
MRES button,|4-11/|5-5
resetting the memory areas, 4-11, 5-5
status indicators,|5-3
diagnostics buffer
following a memory reset, 4-11, 5-5
system status list; A-1-A-5
digital 1/0, B-1
distributed 1/0, 1-2
addresses, 6-9-6-12
diagnostic addresses, 6-11
downloading a program, 4-8
DP address area of the WinLC, |B-1
drivers for CP 5613, 2-9
execution time
description, 4-12-4-14
per instruction, B-11-B-13
tuning, 4-14-4-16
features for version 2.0,/ 1-4
guidelines for configuring the network,
6-2-6-5
handling crashes, 5-9
Installation, CP 5613 2-9-2-10
installation
authorization| 2-7-2-9
copy-protection| 2-7-2-9
procedure, 2-3-2-5
removing the authorization, |2-8
transferring the authorization, 2-8
troubleshooting, 2-4
uninstalling, 2-6
installing with the CP 5412,/2-2
instruction execution times, B-11-B-13
Load memory, B-1, B-2-B-4
loading and transferring 1/0, B-2
local data, B-1

mapping /O to the process image area, B-2

maximum size
DB, B-1, B-4
FB, B-1
FC, B-1. B-4
memory bits, B-1
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memory reset, 4-11, 5-5
memory reset (MRES), 4-11//5-5
minimum sleep time, 4-12
MPI address
default address, |4-8
following a memory reset, 4-11//5-5
for WIinLC, |6-3
MRES button, resetting the memory areas,
4-11,/5-5
NT service
automatic or manual operation, [2-5
register and unregister, 4-16
0B84, 5-9
operating modes, 4-10, 5-2
operational features,|1-2
options
autostart, 4-18-4-20
language, 4-20
security, 4-21-4-25
order number, B-2
overview,|2-2
password, 4-21-4-25
process image, B-1
product overview| 1-1-1-4
PROFIBUS-DP
addresses| 6-9-16-12
baud rate, 6-6
cable length, 6-6
diagnostic addresses (modules), 6-11
repeaters, 6-7
spur lines, 6-7
program size (maximum), 4-8
RAM, B-1
real-time clock, 5-17, B-1
removing the authorization, 2-8
repeaters, |6-7
resetting the memory areas,/4-11, 5-5
restart, resetting the memory areas, 4-11,
5-5
restart (cold or warm), 4-10
retentive data
bit memory (M) area 5-13-5-15,|B-1
counters, 5-13-5-15, |B-1
data blocks (DBs), 5-13
memory bits| 5-13-5-15
memory reset, 4-11, 5-5
timers, 5-13-5-15, B-1
RUN mode, status indicator, 5-3
saving the user program, 4-25
scan cycle
configuration, 5-12-5-14
description| 4-12-/4-14
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instruction execution times, B-11-B-13 ~ Work memory, B-1
tuning, 4-14-4-16 WinLC, B-2--B-4
security levels| 4-21--4-25 See also Load memory
setting priority (Windows NT), 4-14--4-16 Writing consistent data, 6-10,|B-2
setting the system clock, 5-17
sleep time, 4-12
specifications, B-1-B-3 Y
spur lines, |6-7 Y N
P not allowed for some baud rates, 6-7 Year 2000 or "Y2K",[1-4
starting and shutting down the controller,
4-17-4-19
starting the software, 4-2-4-4
startup characteristics, configuration, 5-11
status indicators,|5-3
complete restart,|5-3
DP (PROFIBUS-DP),|6-12
STEP 7
accessing WinLC, 4-8
downloading a program, 4-8
STOP mode
status indicator, 5-3
using STEP 7 to reset memory, 4-11,
5-5
system clock, 5-17, B-1
system fault (SF) indicator, 5-3
system requirements, 1-3
system status list; A-1-A-5
timers,|B-1
memory reset, 4-11,|5-5
transferring the authorization, 2-8
uninstalling, 2-6
Work memory, B-1| B-2-B-4
Year 2000, 1-4
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SIEMENS ENERGY & AUTOMATION INC

ATTN: TECHNICAL COMMUNICATIONS M/S 519
3000 BILL GARLAND ROAD

PO BOX 1255

JOHNSON CITY TN USA 37605-1255

From

Name:

Job Title:

Company Name:
Street:
City and State:

Country:

Telephone:

Please check any industry that applies to you:

Automotive Pharmaceutical

Chemical Plastic
Electrical Machinery
Food

Instrument and Control

Pulp and Paper
Textiles
Transportation
Other

aaaaaan

Non-electrical Machinery

auoaooaoaaaq

Petrochemical
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Remarks Form

Your comments and recommendations will help us to improve the quality and usefulness of our
publications. Please take the first available opportunity to fill out this questionnaire and return it
to Siemens.

Please give each of the following questions your own personal mark within a range from 1 (very
good) to 5 (very poor).

Do the contents meet your requirements?
Is the information you need easy to find?
Is the text easy to understand?

Does the level of technical detail meet your requirements?

NN

ok~ w0 Dd PR

Please rate the quality of the graphics and tables.

Additional comments:
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